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PREFACE

WHAT’S IN THIS GUIDE?
The TalkSwitch User Guide contains all the information you need, whether 
you are installing a single TalkSwitch unit or multiple VoIP enabled units. It 
is intended to be a complete reference accompanying the TalkSwitch Start 
Guide that ships with every TalkSwitch unit.

This preface contains important information to help you maximize your 
installation effort and to get the most out of the features and the flexibility 
of your TalkSwitch system. We strive to make your experience with 
installation and configuration the most rewarding possible.

We would ask you to read important information concerning power 
interruptions and safety precautions contained in the appendices in order to 
ensure your TalkSwitch equipment is set up in the safest way possible while 
avoiding equipment damage.

What you should know
While TalkSwitch is customer installable, certain skills are required if you 
need to route cables or to configure a network. The following points will help 
you determine the required skills:

• Configuring the TalkSwitch system using the configuration software can 
be performed by anyone with basic computer skills once the system is 
physically installed with proper networking equipment configurations (if 
two or more units are networked on a LAN).

• While most buildings are wired to accommodate TalkSwitch system setup, 
the need to route telephone and/or network cabling can occur 
occasionally. If your organization does not have someone with this skill 
set, we recommend the use of an outside telephony system technician.

• Connecting TalkSwitch to network equipment such as routers, switches or 
hubs with a connection to the Internet, as well as configuring firewalls, 
computers and TalkSwitch for networked use internally and with 
Internet. If your organization does not have someone with this IT skill 
set, we recommend the use of an outside IT technician.
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If you are installing a single, non-VoIP, TalkSwitch unit, anyone with basic 
computer skills can use the TalkSwitch Start Guide and this user guide to 
perform a full installation and configuration. 

TalkSwitch system installations can be categorized into some general 
configurations, such as single unit installation, networked units installation, 
VoIP or non-VoIP installation, etc. This section helps you determine your 
best possible plan of action using this guide, according to your installation 
type. While not every possible installation scenario is detailed below, 
determine which one better fits your situation and use its guidelines as a 
starting point. Chapter 6: Troubleshooting and Support on page 181 provides 
solutions for common problems and the index at the back is a means to 
quickly navigate to specific areas.

Single unit installation
When installing a single, non-VoIP TalkSwitch unit, you can skip the sections 
marked with the Networked and VoIP icons.

Networked units installation
When installing networked TalkSwitch units, you require the sections marked 
with the Networked icon.

VoIP installation
When installing a VoIP enabled unit, you require the sections marked with 
the VoIP icon. Chapter 5: VoIP Information on page 155 provides an 
additional resource.

Connecting devices
When connecting phones and other devices to your TalkSwitch unit(s), 
1.7 Connect TalkSwitch to a network or a PC on page 9 provides the 
information you need.
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FINDING THE INFORMATION YOU NEED
The following user guide functionality helps you find the information you 
need quickly and enables you to skip the information you don’t need. This 
will make your experience with this user guide and your TalkSwitch system 
installation and configuration much more efficient.

Using the table of contents and the index
The table of contents at the front of this user guide contains all of the 
section headings and page numbers throughout the manual. The index at the 
back of the user guide contains a keyword reference with page numbers. If 
you are using this guide online in PDF format, the headings and keywords 
will contain hyperlinks, allowing you to quickly navigate to the sections you 
need.

Navigating with cross-references
Cross-references are contained throughout the user guide in order to help 
you access related information and illustrations quickly. As with the 
headings and keywords located in the table of contents and index, these 
cross-references contain hyperlinks, allowing you to quickly navigate to the 
sections you need.

Where to go for further information
The guides listed below and other guides can be found on the TalkSwitch 
software CD, in the TalkSwitch folder in the Windows Start menu once the 
software has been installed, and in the support section of our website at 
www.talkswitch.com/support.

• For basic installation and configuration instructions, refer to the 
TalkSwitch Start Guide that ships with every TalkSwitch unit.

• For information on setting up a TalkSwitch 48-CVA system to use VoIP, 
refer to the TalkSwitch VoIP Network Configuration Guide.
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GUIDE CONVENTIONS
The TalkSwitch User Guide uses the following text elements and icons as 
visual aids, making the manual more accessible.

Text elements

Italic Italicized text highlights configuration software fields 
located on the various software windows, as well as 
references to other sections of this guide or to other 
TalkSwitch documents.

Bold Bolded text highlights configuration software menu 
selections located on the software top menu drop-down 
lists and on the left navigation section. Non-numbered 
paragraph headings are also bolded.

“Italic” Italicized text in double quotes highlights TalkSwitch 
system voice prompts you hear from a telephone.

<Italic> Italicized text in brackets highlights text you are asked 
to type.

Icons

The Networked icon is used to mark sections with 
information pertaining to a setup where two or more 
TalkSwitch units are networked together on a LAN.

The VoIP icon is used to mark sections with information 
pertaining to a setup where VoIP is being used.

The IP extension icon is used to mark sections with 
information pertaining to the set-up and use of IP phones 
as local extensions.

The Alert icon is used to mark sections that are 
important. They may contain warnings or cautions 
alerting the user to pay special attention.
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C H A P T E R  1
Ch ap ter  1 :  Ta lkSw itch  Instal la t i on

TALKSWITCH INSTALLATION

1.1  TALKSWITCH PACKAGE CONTENTS

If any of these items are missing, please contact your TalkSwitch dealer.

CA/CVA unit packages contain the following items:

Item 24-CA 48-CA 48-CVA

TalkSwitch unit 1 1 1

AC power adapter 
Warning: never use any power adapter other 
than the one provided.

1 1 1

USB cable 1

6 foot Ethernet cable 1 1

6 foot telephone cables 2 4 4

Software and documentation CD 1 1 1

Quick Reference Cards 1 1 1

TalkSwitch Start Guide 1 1 1

TalkSwitch VoIP Network Configuration Guide 1

Warranty card 1 1 1

 Warning: If TalkSwitch has been exposed to low temperatures prior to 
 installation, wait until the system has reached room temperature before 
 connecting the power cord to avoid condensation.
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1.2  CONFIGURATION SOFTWARE SYSTEM REQUIREMENTS 

• PC running Windows XP/2000

• 160 MB free hard disk space

• 256 MB RAM

• USB port or Serial port (for 24 models)

• Ethernet port (for 48 models)

• Minimum 800 x 600 minimum video resolution

1.3  UNIT FRONT PANEL

The front panel consists of a power button and five lights indicating the usage 
of the lines with different states of illumination.

Figure 1: Front panel lights

Light State Description

Line 1/Line 2 on Line 1/Line 2 is currently in use.

flickering Line 1/Line 2 is ringing.

pulsing slowly Line 1/Line 2 caller is on hold.

quick pulse Line 1/Line 2 is engaged by a device that 
is sharing the line with TalkSwitch.

Power/Data on TalkSwitch is powered on.

flickering The PC connected (via Serial or USB) to 
TalkSwitch is either sending or retrieving 
information from TalkSwitch. 

pulsing slowly Global Message Waiting Indicator 
(configurable).
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1.4  UNIT BACK PANEL

Figure 2: TalkSwitch 24-CA

Figure 3: TalkSwitch 48-CA/CVA 

Line 3/Line 4 on Line 3/Line 4 is currently in use.

pulsing slowly Line 3/Line 4 caller is on hold.

flickering Line 3/Line 4 is ringing.

quick pulse Line 3/Line 4 is engaged by a device that 
is sharing the line with TalkSwitch.

Line 3 and Line 4 lights apply to TalkSwitch models with four incoming 
lines only. For more details on line light error codes, see 1.12 What the 
flashing lights mean on page 27.

The PF box between E4 and L1/L2 represents power failure support. In the 
event of a power failure or loss of power to TalkSwitch, extension 114 is 
able to receive and make calls on Line 1.
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Connectors Purpose
MUSIC The music connector is a 1/8" (3.5mm) phono jack used 

as an audio input for the music on hold feature. Mono 
cables are recommended. For more information, see 1.8.3 
Connecting devices to the music jack on page 21.

PA The PA (public address) connector is a 1/8" (3.5mm) 
phono jack used as an audio output for the external 
paging feature. Mono cables are recommended. For more 
information, see 1.8.4 Connecting to the PA (public 
address) jack on page 21.

LAN The LAN connector is an RJ-45 port used for unit 
configuration via the PC, unit LAN networking, and VoIP 
capability. For more information, see 1.7.1 Ethernet 
connection on page 9, 1.9 Networking TalkSwitch units on 
a LAN on page 21 and Chapter 5: VoIP Information 
starting on page 155.
There are 3 green LEDs on the right of the LAN port. The 
top LED indicates network synchronization (connection), 
the middle LED indicates data Rx (receiving data) and the 
bottom LED indicates data Tx (transmitting data).

E1-E4
E5-E8

The extension connectors are RJ-11 ports used for 
connecting phones and other analog devices. For more 
information, see 1.8.2 Connecting local extension 
telephones and other devices on page 16.

L1-L2
L3-L4

The line connectors are RJ-11 ports used for connecting 
incoming phone lines. For more information, see 
1.8.1 Connecting incoming telephone lines on page 16.

Plug in your RJ-11 telephone lines, beginning with L1. If 
you have two lines out of one phone jack, you will 
require a dual-to-two-single-line adapter or replace the 
two-line cord with two single-line cords. Note that L3 
and L4 do not exist on units with only two incoming line 
connectors.

Use a surge protector if you live in an area prone to 
lightning strikes.

USB The USB connector is a standard USB port used for 
connecting to a PC for unit configuration. For more 
information, see 1.7.2 USB Connection on page 10.

SERIAL The serial connector is a RS-232 port used for 
configuration via the PC. For more information, see 
1.7.3 Serial connection on page 11.
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1.5  INSTALLING THE CONFIGURATION SOFTWARE

1.5.1 Installing the software for the first time

1. Turn on your computer and insert the TalkSwitch CD into your CD drive. 
The install program starts automatically. 

2. Click NEXT and follow the instructions. 

If you prefer to use Windows Explorer or if the install process does not 
launch automatically:

1. Double-click the My Computer icon.

2. Double-click the CD-ROM/DVD drive.

3. Double-click the Startscreen.exe icon and follow the instructions. After 
you click the Finish button, you will see the TalkSwitch icon on your 
desktop. This means that you have successfully installed the 
configuration software. 

1.5.2 Upgrading the TalkSwitch software and firmware

We are continually looking for ways to enhance your communications 
capabilities. When new features are added, we provide our users with 
immediate access to an update directly from Window’s Start menu. 

1. Start -> Programs -> TalkSwitch 4.00 -> TalkSwitch Auto Update. 

2. If your configuration software is due for an update, a dialog box informs 
you of the status of your software version. See Figure 3. If you need an 
update, you have the option to download the update. The update file is 
stored in C:\Program Files\TalkSwitch\TalkSwitch Configuration 4.00.

MEMORY SLOT The memory card slot is a socket used with TalkSwitch 
memory cards. For more information, see 
1.10 Installing a memory card on page 26.

POWER The power connector is a receptacle rated at 16 VAC/1.5A 
for connecting the supplied AC adapter input line.

If your TalkSwitch is already connected with a USB cable, disconnect the 
unit before you install/upgrade the software. Reconnect the USB cable to 
TalkSwitch after the configuration software is installed. 

The latest version of the TalkSwitch software can also be downloaded from 
the TalkSwitch website www.talkswitch.com/support.
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3. After the update is downloaded, click Yes in the dialog box to install the 
update. See Figure 3. You can install the update later from the folder 
C:\Program Files\TalkSwitch\TalkSwitch Configuration 4.00.

Figure 4: Check for updates 

Alternatively, you can check the vesions you are running once the system is 
connected by following the three steps below.
Step 1 — Check current version
To identify the appropriate update file, you must determine your TalkSwitch 
software and firmware versions. To find your TalkSwitch software version 
number, click Help -> About TalkSwitch Configuration Utility... 

Figure 5: About TalkSwitch software version

The TalkSwitch configuration software must be closed in order to install 
the update.
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Write down the software number. Go to the TalkSwitch website at 
www.talkswitch.com/support. The instructions help you select and 
download the appropriate upgrade.

The TalkSwitch firmware version number of each unit is listed in the 
System Information window. 

1. Open the TalkSwitch configuration software if not already open. 
Click About TalkSwitch. 

2. Click View System Information.

Networked units have to run the same firmware version to operate properly 
on the same LAN. Use this window to confirm that all the units have 
matching firmware versions.

Figure 6: TalkSwitch firmware version

Step 2 — Download new software and firmware
When you double-click on the appropriate version for downloading, a 
dialogue box displays, asks you to enter a file name and select a folder for 
the download. We suggest leaving the file name as it is (e.g. TSC400050.exe) 
and saving it to your PC in C:\Program Files\TalkSwitch\TalkSwitch 
Configuration 4.00. Once the download is complete, begin your upgrade by 
double-clicking on the install file or using the Run option on your Windows 
Start menu. A series of windows will guide you through the installation 
process.

This process updates your configuration software to a newer version. You 
still need to update the firmware to take advantage of new features. The 
new firmware file is placed in the TalkSwitch directory after running the 
install program.

The instructions on our website take precedence over any instructions in 
this user guide.
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Step 3 — Updating the firmware
The last step is to update the firmware. Make sure your TalkSwitch is 
connected to your PC. 

1. Open the configuration software.

2. File -> Update Firmware. 

The update time varies depending on the connection type, how many files 
are needed and how many units are updated. On average the process takes 
between 1 and 5 minutes. The LED lights on the TalkSwitch front panel show 
diagnostic indicators for the update. See 1.12 What the flashing lights mean 
on page 27. When the update is completed, you are prompted to reboot 
TalkSwitch. In the dialog box, click the Proceed button.

Should the firmware update fail, please repeat the update process above. If 
the problem persists, contact your reseller or TalkSwitch.

Most firmware updates do not alter your system configuration. In certain 
circumstances, during a major system update, the configuration file may get 
reset to default values.

When you configure a unit for the first time and every time you modify the 
configuration, we recommend that you save your configuration file to your 
PC and preferably to removable media (3.5" Floppy, CD-ROM disc or Flash 
stick) as a back-up. This avoids having to reconfigure the entire system in 
case of a hardware failure. 

The LastSavedConfig4.00 in C:\Program Files\TalkSwitch\TalkSwitch 
Configuration\ is accessed when you save and retrieve the configuration 
software. For more information, see 2.1.1.1 File Menu on page 30.

1.6  INITIAL CONFIGURATION

Once your software is installed and your TalkSwitch is connected directly to 
a PC or via a switch/hub to the LAN, you can customize the TalkSwitch 
system with the TalkSwitch configuration software. 

If you have to replace your computer, please download the latest install 
file from our website and follow steps 2 and 3 above. Run the install 
program. In case of a major system update, copy the back-up of your 
configuration file to C:\Program Files\TalkSwitch\TalkSwitch 
Configuration.
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If you connect TalkSwitch to your phone system, it will do the following:

• An incoming call on any line will ring all analog local extensions.
• A receptionist can manually transfer calls to local extensions or 

voicemail.
• Every local extension will have a voice mailbox.
• Analog extension 114 (E4) will still operate during a power failure.

1.7  CONNECT TALKSWITCH TO A NETWORK OR A PC

Connect the AC adapter provided with TalkSwitch from an electrical outlet 
to the TalkSwitch unit. Never use a power adapter other than the one that 
came in the TalkSwitch package. 

To configure the TalkSwitch settings, connect the unit to the PC with the 
configuration software installed. 

There are five connection methods.

1.7.1 Ethernet connection

An Ethernet cable is supplied with specific unit 
models. This connection requires a LAN and a PC 
on the same switch. Any PC on the LAN can 
configure the unit.

Figure 7: LAN connection

Recommendation: To minimize the disruption time of your telephone 
lines during the system setup, we recommend that you configure the 
unit before you connect all your phones and lines to TalkSwitch. For 
more information, see Chapter 2: TalkSwitch Configuration starting on 
page 29.

Sharing computer data and TalkSwitch voice data, on the same hub can 
cause voice degradation during high traffic periods. For best results, 
place TalkSwitch units on a switch, or on their own hub.
T A L K S W I T C H  I N S T A L L A T I O N                                                 9



1. Connect TalkSwitch to your hub or switch using the supplied Ethernet 
cable and connect your PC to the hub or switch using another standard 
Ethernet (CAT 5) cable with RJ45 connectors.

2. If not already turned on, press the Power button on the front of your 
TalkSwitch and turn on your computer.

3. Double-click the TalkSwitch icon on your desktop to open the 
configuration software. If the software was unable to detect your 
TalkSwitch automatically, a dialog box opens requesting you to select the 
connection type. 

4. Select Ethernet and the adapter you wish to use from the drop-down list 
and click Connect...

Figure 8: Ethernet connection      

5. Once connection has been established, the TalkSwitch System 
Configuration window opens. See Figure 30 on page 29.

1.7.2 USB Connection

A USB cable is supplied with specific models. The
PC and TalkSwitch unit must be in close proximity. 

1. Connect the cable to a USB port on your PC and to the USB port on the 
back of TalkSwitch. 

2. If not already turned on, press the Power button on the front of your 
TalkSwitch and turn on your computer.

A PC can connect directly to the TalkSwitch LAN port using a ‘cross-over’ 
cable equipped with RJ-45 connectors.

If you encounter difficulties opening the TalkSwitch configuration 
software, check that all your wires and plugs are securely connected.
1 0 T A L K S W I T C H  US ER GU IDE  •  NOR TH AMERICA



3. Double-click the TalkSwitch icon on your desktop to open the 
configuration software. The dialog box in Figure 8 is displayed.

4. Select USB from the drop-down list and click Connect... A progress bar 
indicates that the configuration is being retrieved. When this process is 
completed, the TalkSwitch System Configuration window opens. 
See Figure 30 on page 29

Figure 9: USB connection   

1.7.3 Serial connection

Serial connectivity is an option if you do not have a 
free USB port. The TalkSwitch package does not 
include a Serial cable. The PC and TalkSwitch unit 
must be in close proximity. 

1. Connect the cable to the Serial port on your PC and to the Serial port on 
the back of TalkSwitch. 

2. Press the Power button on the front of your TalkSwitch and turn on your 
computer.

Make sure that no other communication programs are running at the 
same time as the configuration software.
Examples: Palm Pilot, Hot Sync, TalkWorks, Digital Camera, UPS Tracking 
software, etc. These programs tend to occupy the COM ports, preventing 
other programs from using them.

Look in your system tray for programs using your 
COM ports. Rolling your mouse cursor over each 
icon will also indicate the name of the associated 
program.

Hot Sync
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3. Double-click the TalkSwitch icon on your desktop to open the 
configuration software. The dialog box below is displayed.

Figure 10: Serial connection

4. From the drop-down list in the dialog box, select Serial as the connection 
type. 

5. Select a COM port (COM1 or COM2) from the Serial ports drop-down list 
and click Connect... A progress bar indicates that the configuration is 
being retrieved. When this process is completed, the TalkSwitch System 
Configuration window opens. See Figure 30 on page 29.

1.7.4 Internet connection

Select USB from the drop-down list and click Connect... A progress bar 
indicates that the configuration is being retrieved. When this process is 
completed, the TalkSwitch System Configuration window opens. 
See Figure 30 on page 29.

Ensure your unit is connected to a LAN with the supplied 
Ethernet (CAT 5) cable. The top LED on the the back panel 
beside the LAN port indicates that a connection has been 
established with a switch or hub. To support remote 
configuration over IP, map the TCP 9393 port from your firewall to 
TalkSwitch. Please refer to the manual for your router/firewall to 
activate port forwarding.

1. Double-click the TalkSwitch icon on your desktop to open the 
configuration software. The dialog box below is displayed.

2. From the drop-down list in the dialog box, select Internet as the 
connection type. 
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Figure 11: Internet connection

3. In the Address field of the Internet IP Connection Settings section, enter 
the public IP address or the FQDN of the TalkSwitch location and click 
Connect.... A progress bar indicates that the configuration is being 
retrieved. When this process is completed, the TalkSwitch system 
configuration window opens. See Figure 30 on page 29.

You have the option to store several locations in the address book.

Figure 12: Address book

1. Click the Address Book button.

a) To add a new address, click New. 

b) Type the name of the location into the Entry Name field.

c) Type the Internet address of the location into the Internet Address 
field and click OK.

d) To edit or delete an existing entry, highlight the item you wish to 
edit or delete and click Edit or Delete.



1.7.5 File connection

You can load the latest configuration file saved on a PC to make edits and 
save it again as a file or save it directly to TalkSwitch.

1. Double-click the TalkSwitch icon on your desktop to open the 
configuration software. The dialog box below displays. 

2. From the drop-down list next to Connection Type, select File. 

Figure 13: File connection

3. Click the Browse button and select the configuration file you wish to 
open and click Open.

Figure 14: Open TalkSwitch configuration file

4.  Click Connect....

5. The TalkSwitch System Configuration window opens. 
See Figure 30 on page 29.

When a unit is being configured, it is locked to prevent other computers 
or persons using a phone from configuring changes at the same time. If 
you leave the software open for longer than one hour, the unit unlocks 
itself to allow configuration changes.
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Restore Firmware (button)
This button is available as an alternate method to update firmware if an  
update attempt has failed. Click the Restore Firmware button, then select 
which firmware file to load onto the unit. The firmware update will then 
begin. Follow the instructions presented at each step. Progress will be 
displayed as the update proceeds.

If you are downgrading to an earlier firmware version, and have more than 
one networked TalkSwitch unit, you must perform the Restore Firmware one 
unit at a time, with the unit separated from the network during the restore.

For more information, see 1.5.2 Upgrading the TalkSwitch software and 
firmware on page 5.

1.8  CONNECTING DEVICES
Move the unit(s) to a location where it can be attached to incoming 
telephone lines and your telephone devices. 

Figure 15: An example of residential wiring

Things to consider when placing your TalkSwitch    

Wiring 
Make the most of your phone system with optimal home/office wiring. If 
you need help wiring your house or small office and are not sure where all 
the jacks are or what colors of wires to use, refer to Appendix H: Home/Office 
Wiring Guide on page 213.

Location
Check the location of electrical wall outlets and telephone jacks in the room. 
Place the unit(s) close enough to these items using your AC adapter and 
telephone cords.

The computer connection is only needed to change the configuration 
settings. It can remain disconnected at other times.

Recommendation: We recommend that you connect surge protectors 
between the TalkSwitch unit(s) and your telephone lines to protect 
against lightning damage.

TalkSwitch
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1.8.1 Connecting incoming telephone lines 

1. Choose a convenient wall jack to attach to your TalkSwitch and connect 
your telephone lines.

2. Connect the TalkSwitch unit to the telephone company’s line sockets 
using the dual-wire telephone cables provided. Take note of which 
telephone line is connected to each line port. This information will be 
used in the configuration section. 

•  Connect the first incoming phone line to L1.
•  Connect the second incoming line to L2.

If you have a unit with more than two incoming lines, connect your 
RJ-11 telephone lines, beginning with L1. If you have two lines out of 
one phone jack, you will require a dual-to-two-single-line adapter or 
replace the two-line cord with two single-line cords. Note that L3 and L4 
do not exist on units with only two incoming line connectors.   

1.8.2 Connecting local extension telephones and other devices

Connect your single-line analog device to one of the unit extension jacks the 
same way you would plug it into a standard telephone wall jack. 

You can connect any regular analog extension telephone set, cordless 
telephone or fax machine to the extension ports, E1-E4 (all unit models) and 
E5-E8 (for unit models with more than four extension jacks). 

1. Plug each internal telephone into extensions beginning with E1. 

2. If required, plug the fax line into E3 or E8.     

Advisory: In order to minimize disruption to your business, you may 
want to configure TalkSwitch before connecting it to your telephone 
lines and extension phones.

All incoming calls will be routed to the extension phones by TalkSwitch. 
Call handling includes call forwarding, transferring, voicemail, etc. 
Incoming lines are not directly connected to any of the local extensions. 
The software determines which incoming lines are routed to which local 
extensions. 

Connect a phone to E4 to ensure communication during a power failure.
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1.8.2.1 Connecting a regular single-line telephone

This is the basic, simple set-up. All functionality including transferring calls, 
forwarding calls and voicemail, is handled by the unit. Even the most basic 
of phones, once connected, will inherit these functions.

Figure 16: Single-line telephone

Each phone is connected to a single 
extension. A call transferred to 
extension 111 will ring the phone 
connected on jack E1. A call 
transferred to extension 112 will ring 
the phone on jack E2 and so on.

1.8.2.2 Connecting a regular dual-line telephone

Most dual-line phones have separate plug-ins for two incoming telephone 
lines (Line 1 and Line 2). If your dual-line telephone does not have separate 
plug-ins, you can use a Line 1/Line 2 splitter to separate the two lines as 
shown in Figures 17 and 18.

You can plug the dual-line phone into the TalkSwitch unit using one or two 
extension jacks. Figure 17 below shows a dual-line phone using one jack. 
Figure 18 on page 17 shows a dual-line telephone plugged into the unit 
using two jacks.

Figure 17: Dual-line telephone on one jack

TalkSwitch extension 111 is connected 
to a dual-line phone using one 
extension jack. Calls on extension 111 
show Line 1 as active.

Figure 18: Dual-line telephone on two jacks

TalkSwitch extensions 111 and 112 are 
connected to a dual-line phone using 
two extension jacks. Calls on extension 
111 show Line 1 as active. Calls on 
extension 112 show Line 2 as active.

E1 E2 E3 E4
TalkSwitch Jacks

Incoming Phone Lines

Extensions  111 112 113 114

E1 E2 E3 E4
TalkSwitch Jacks

Incoming Phone Lines

Line Splitter

Extension  111

E1 E2 E3 E4
TalkSwitch Jacks

Incoming Phone Lines

Extensions  111 and 112
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Figure 19: Dual-line telephone on splitter

TalkSwitch extensions 111 and 112 are 
connected to a dual-line phone using a 
line splitter. Calls on extension 111 
show Line 1 as active. Calls on 
extension 112 show Line 2 as active.

1.8.2.3 Connecting regular multi-line phones

Figure 20: Four-line telephone

Jacks 111, 112, 113 and 114 are all 
wired to the four-line phone. When a 
call is transferred to extension 111, 
Line 1 on the phone shows as active. 
Calls on extension 112 show Line 2 as 
active and so on. You may configure 
each incoming line to ring any given 
number of extensions. Configure 
incoming Line 1 to ring extension 111, 
Line 2 to ring extension 112, etc.

1.8.2.4  Connecting an IP phone

Plug the IP phone into your switch/hub using the supplied RJ-45 cable. 
Please refer to the IP Phone Configuration Guide in the TalkSwitch 
documentation folder. If you are using a third-party IP phone, refer to the 
user guide of the third-party IP phone for configuration instructions.

1.8.2.5 Attach an internal or an external modem

Plug the modem’s telephone cable into a unit extension jack. Your modem is 
now an extension that can access all lines and take advantage of call routing 
features.

If you don’t want to change your dial-up settings for the modem, enable 
Direct Line Access for the extension associated to the modem. For more 
information, see 2.2.7 Local extensions on page 54.

Modems connected to a unit operate at a maximum of 28 kbps. 

E1 E2 E3 E4
TalkSwitch Jacks

Incoming Phone Lines

Line Splitter

Extensions  111 and 112

E1 E2 E3 E4
TalkSwitch Jacks

Incoming Phone Lines

Line Splitter Line Splitter

4-Line Phone

Extensions  111, 112, 113 & 114
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1.8.2.6 Connecting fax machines  

TalkSwitch provides you with three options to configure your fax machine. 
Choose the best option for your office.

Option 1 — Dedicated Fax Line
You may already have an incoming dedicated fax line. You can leave this 
line directly connected to your fax machine. Connect the remaining 
incoming phone lines to your unit. Incoming phone lines will be handled by 
the unit and your fax will work the way it has always worked.

Figure 21: Dedicated fax line

Advantages: It’s easy to set up and you don’t need to change the way your 
fax handles calls.

Disadvantages: The dedicated fax line cannot be shared with the other 
phone devices (i.e. you cannot make an outbound voice call on your fax 
line). The dedicated fax line costs money, and may not be used as frequently 
as it could be.

Option 2 — Distinctive Ring
Distinctive ring is a service provided by your phone company. A second 
phone number is added to a phone line. A call to either phone number will 
ring the same line with different ring patterns. You can use one ring pattern 
to indicate a fax. 

If you are connecting a fax machine to a unit with two or four incoming 
lines, plug it into local extension E3 or E8.

After installing TalkSwitch, the fax machine remains on its own dedicated line.  
All incoming telephone lines are shared by the remaining office phones.
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Here’s how the TalkSwitch handles incoming calls:   

Figure 22: Distinctive ring

Advantages: This option does not require a second physical line for faxes. 
More telephone lines can be added as you grow. You can keep the same fax 
arrangement.

Disadvantages: Your phone company may charge a fee for the distinctive 
ring. If you choose this option, you will require the distinctive ring service 
from your telephone company.

Option 3 — Automatic fax detection via the auto attendant

The auto attendant can detect incoming fax calls and route them 
accordingly. To enable this, an auto attendant must answer all incoming 
calls with your pre-recorded message. It will listen for a fax tone to 
determine if the call is an incoming fax. If so, the call is routed to the fax 
machine, otherwise the call follows your Call Handling settings. You must 
create an auto attendant to use this method.

Figure 23: Automatic fax detection via auto attendant

Advantages: Calls are automatically handled for you. No distinctive ring 
service and no listening to ring patterns is required. Incoming phone lines 
are shared between all phones and faxes, making better use of your 
resources.

Disadvantages: Some older fax machines do not emit a fax (CNG) tone. 
Therefore, the auto attendant cannot detect incoming faxes from those 
devices. 

After installing TalkSwitch, it automatically detects the distinctive ring pattern. 
Faxes are automatically routed to the fax machine and calls to the phones.

Distinctive
RIng 1 Distinctive

RIng 2

All incoming calls are answered by the Auto Attendant. 
The Auto Attendant then directs the call to the fax or local phone extensions.

Distinctive
RIng 1 Distinctive

RIng 2
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Options 2 and 3 require settings to be programmed into the unit using the 
configuration software. For more information, see 2.2.6 Fax information on 
page 49 and 2.4.2.4 Automatic fax detection on page 85.

1.8.3 Connecting devices to the music jack

The music jack is designed to support audio sources like a CD player, audio, 
tape player or other sound devices for playing music or messages to callers 
while they are on hold. Connect the audio source via its headphone output 
to the music jack. 

The music jack requires a 1/8" (3.5 mm) mono phono connector. If you have 
more than one unit connected to a LAN, load a .wav file onto each unit to 
eliminate the need for a separate music source for 
each unit.

1.8.4 Connecting to the PA (public address) jack

The PA jack can be connected to a PA system for external paging or to an 
amplification system to screen voicemail or to use as a line simulator. The 
PA jack requires a 1/8" (3.5 mm) mono phono connector. If you have more 
than one unit connected to a LAN, you need to provide a connection onto 
the system to the PA system.

1.9  NETWORKING TALKSWITCH UNITS ON A LAN

Up to four 48-CA and/or 48-CVAunits can be networked together over a LAN 
to increase the number of lines and extensions in your phone system.

1.9.1 Connecting TalkSwitch units to a LAN

You can plug your unit(s) into your existing LAN or operate it on its own 
LAN with an Ethernet switch. Ensure that the firmware on all units is 
updated before adding them to the LAN. 
Check www.talkswitch.com/support/ for the latest updates.

If your auto attendant volume is set too high or if your telephone lines 
are noisy, the auto attendant may have difficulty detecting the incoming 
fax tone and therefore not route the call to the fax machine. You can 
solve this problem by adjusting the volume. For more information, see 
2.6.2 Audio Controls on page 107.
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1.9.1.1 Ethernet switch

A switch provides direct communication between units, thus keeping the 
voice-over-LAN data isolated from other data on the network. 

1. Connect up to four 48-CA and/or 48-CVA units to the LAN switch.

2. Connect a computer to the phone system using the LAN connection or 
directly to the unit through the USB or Serial port.

3. Power up and configure your units before adding any IP phones that will 
be part of the system. It is important that you place the IP phones on the 
same subnet as TalkSwitch. 

Example: If your TalkSwitch unit has the IP address 192.168.1.200, your IP 
phone should use IP addresses in the range 192.168.1.xxx that do not 
conflict with other IP addresses. 

Figure 24: Three units connected via a switch

1.9.2 Power up all the TalkSwitch units

Connect the provided AC adapters to each unit and plug the adapters into 
available power outlets. Turn the units on by pressing the Power button on 
the front of each unit. The lights on the front panels of the units will flash. 
This means that they are powered up and connected to the LAN, but their ID 
numbers are not set.

TalkSwitch unit enclosures are not designed for stacking. We recommend 
wall-mounting units to maximize airflow and keep the units from 
overheating.

LAN

MUSIC PA E1 E2 E3 E4

E5 E6 E7 E8

L2 USB SERIAL POWER

L4L3/L4

L1/L2

PF

LAN

MUSIC PA E1 E2 E3 E4

E5 E6 E7 E8

L2 USB SERIAL POWER

L4L3/L4

L1/L2

PF

LAN

MUSIC PA E1 E2 E3 E4

E5 E6 E7 E8

L2 USB SERIAL POWER

L4L3/L4

L1/L2

PF

1Internet 2 3 4 POWER

Reset
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1.9.3 Setting or changing the unit ID

Units are shipped from the manufacturer with unit ID 1. If two or more units 
are placed on the same LAN with the same unit ID number, it causes a 
conflict. All the line lights on the front panel of the units are flashing. You 
have to assign a different unit ID to each of the units. 

1. Pick up a telephone handset connected to one of the extension jacks on 
the unit and press  to enter command mode. 

2. Enter a password if prompted.

3. Now, you have the following options: 

The system indicates that the update was successful and the front panel 
lights stop flashing after a few seconds. When the front panel Data light is 
on solid, the units are ready for network use. 

1.9.4 How unit IDs affect system extension numbers

After successfully changing each unit ID to a unique number, it can be 
identified by the network. More importantly, each local extension, remote 
extension, and voice mailbox has a unique numbering system. The second 
digit in the three digit identifier is the unit ID number, up to unit 4. See the 
following diagram and table.

To change the unit ID, the configuration software must be closed!

Keys Result

00 Responds with the unit ID number of that particular unit.

01 Sets the unit ID to 1.

02 Sets the unit ID to 2.

03 Sets the unit ID to 3.

04 Sets the unit ID to 4.

No IP information is required to configure TalkSwitch since it does not 
use the TCP/IP protocol for voice traffic over the LAN. IP configuration is 
required for remote management, voicemail to e-mail notification or for 
VoIP.

#

#

#

#

#

#
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Figure 25: Examples of three-digit identifiers

1.9.5 Keep track of the lines and extensions

To keep track of the extensions and the lines connected to each unit, label 
each unit with its unit ID. It simplifies matters when you need to add or 
remove extensions and lines.

If the units are located in a room away from the extensions and you need to 
identify the units, the View System Information utility in the configuration 
software allows you to identify each unit as follows:

1. Open the TalkSwitch configuration software. 

2. Click the View System Information link below the TalkSwitch image. See 
Figure 26.

3. Select the Unit ID to verify. 

4. Click the Identify button and observe the flashing LEDs. The lights stop 
flashing when you click the Close button or when 5 minutes have 
elapsed.

Unit ID 1 Unit ID 2 Unit ID 3 Unit ID 4

Local analog 
or IP 
extensions      

111–118            121–128 131–138 141–148

Remote 
extensions                      

210-219 220-229 230-239 240-249

Local 
mailboxes                         

111-118 121-128 131-138 141-148

Remote 
mailboxes                      

210-219 220-229 230-239 240-249

General 
mailboxes                     

410-419 420-429 430-439 440-449
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Figure 26: System Information window

1.9.6 Optimizing the system for networked use

TalkSwitch units have been designed to operate optimally when in a 
networked state. Below are a few items that have been designed for better 
network use.

Configuration settings
All units are cloned with identical settings. If a unit has disappeared off the 
network (adapter unplugged, LAN disconnected, LAN failure, etc.), the 
system can still handle the calls since it retains the configuration settings of 
the missing unit. If an extension or a voice mailbox cannot be reached, the 
caller hears a system prompt: “The extension you are trying to reach is 
currently unavailable, please try again later.”

Outgoing line hunt groups
When two or more units are on a LAN, the system tries placing calls out on 
the same unit the call originates from. This avoids using a line across the 
LAN on another unit, which helps to minimize the LAN traffic and optimizes 
the opportunity for all inbound calls to connect across the LAN if required. 

Auto attendants
There are a total of nine auto attendants that are shared by all units on the 
LAN. When an auto attendant is recorded on any unit, it is automatically 
copied to all other units on the LAN. This design minimizes LAN traffic and 
provides functionality back-up in case a unit or units have disappeared off 
the network (adapter unplugged, LAN disconnected, LAN failure, etc.). In 
this event, all units can still answer inbound calls with the same auto 
attendant messages.

Voicemail
All local extension and remote extension voicemail data is stored on the 
unit where the extensions normally reside. For example, all greetings, 
directory names and voicemail messages for extensions 121-128, 220-229 
and mailboxes 420-429 are stored on the unit with unit ID 2. If a unit is 
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completely filled with voicemail messages, new messages will not be stored 
on other units. The system cannot accept anymore messages for mailboxes 
belonging to that unit. If you need more memory, TalkSwitch memory cards 
can be purchased from your reseller. To view the memory usage of each 
TalkSwitch unit and each mailbox, click Tools -> Memory Usage -> 
Voicemail or click Tools -> Voicemail Manager. 

1.10  INSTALLING A MEMORY CARD

TalkSwitch memory cards are specifically formatted for use with TalkSwitch 
units. They allow you to add additional voicemail message capacity to your 
unit. Voicemail memory is used to store messages left in voice mailboxes. It 
is also used to store auto attendant greetings and announcements. 
TalkSwitch comes with 30 minutes built-in memory.

Figure 27: Memory card

1. Insert the memory card into the memory slot with the gold contact face 
down and the This side up tab showing. You don’t have to turn the unit 
off or disconnect any of the telephones. 

Figure 28: Memory card slot

Memory can be increased 

2 hours, 4.5 hours and 9 hours. 

 

 

in increments of 1 hour, 
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1.11  UPGRADING TALKSWITCH UNITS

As your business grows, your TalkSwitch unit(s) may need upgrading. You 
have the option of upgrading your 24-CA unit to a 48-CA unit and your 
48-CA unit to a VoIP model (48-CVA).

Figure 29: Top board and VoIP module upgrades for 24-CA to 48-CA

For customers upgrading the 24-CA unit to a 
48-CA unit, we provide an upgrade kit. This 
kit consists of a top board that you add to 
your existing 24-CA unit, as well as a guide 
containing detailed, step-by-step 
instructions for the upgrade procedure.

For customers upgrading a 48-CA unit to a 
48-CVA unit we provide a VoIP module that 
they can add to their existing TalkSwitch 
48-CA. We supply detailed, step-by-step 
instructions on how to install the VoIP 
module.

Customers upgrading the TalkSwitch 24-CA to a TalkSwitch 48-CA and then 
upgrading to a TalkSwitch 48-CVA need a TalkSwitch top board and a VoIP 
module. You can purchase upgrade boards and VoIP modules at your reseller. 

1.12  WHAT THE FLASHING LIGHTS MEAN

Diagnostics for the lights flashing on the unit front panel
All line lights flashing simultaneously: 
The unit ID of this unit is in conflict with another unit on the same LAN. 
Make sure you assign a different unit ID to each unit. For more information, 
see 1.9.3 Setting or changing the unit ID on page 23.

Line 2 and 3 lights flashing simultaneously: 
This indicates a file system error. Terminate calls in progress. Reboot the 
unit. Tools -> Reboot TalkSwitch or, on the front panel, turn the power 
button off and back on. It will do a file system check and fix any problems.

Line 1 and 4 lights flashing simultaneously: 
This indicates a voice mailbox error. Terminate calls in progress. Reboot 
TalkSwitch. Tools -> Reboot TalkSwitch or, on the front panel, turn the 
power button off and back on. It will do a file system check and fix any 
problems. 
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Line 1, 2, 3 and 4 lights flashing simultaneously: 
The firmware needs to be updated or reloaded. Ensure that you update with 
the last version, do not use the version on the installation CD. There might 
be a newer version. Open the TalkSwitch configuration software.
File -> Update Firmware...

Line 1 and 4, then Line 2 and 3, lights flashing alternatively: 
The system prompts are not loaded or corrupted. Reload the firmware. Open 
the TalkSwitch configuration software.
File -> Update Firmware... 

Line 1 and 3 lights, then Line 2 and 4 lights flashing repeatedly: 
This is usually the case after a firmware update. Reboot TalkSwitch.
Tools -> Reboot TalkSwitch or, on the front panel, turn the power button 
off and back on.

1.13  VERIFYING THE CONNECTIONS

If you are having problems, they could be due to loose cables. Check the 
following:

1. Are your telephone cables connected to a wall jack at one end and the 
unit at the other? Ensure the devices you are using as extensions 
(phones, faxes, etc.) are plugged into the extension jacks located on the 
back panel of the unit. Do not plug your extensions directly into a wall 
jack unless that jack is wired to a unit extension jack.

2. Check the Serial, USB or LAN connection between TalkSwitch and 
your PC. 

3. Ensure that the unit AC adapter is plugged into a working power outlet 
and that the unit is turned on. Make sure that you are using the 
AC adapter supplied with your unit. This adapter cannot be substituted 
with any other adapter. If your adapter appears to be defective, please 
contact your TalkSwitch dealer to order the proper replacement.

4. If networked, ensure that you have the latest firmware loaded on all 
units. To check the firmware version, open the configuration software, 
and click the link View System Information. All units listed in the System 
Information dialog box should have the same firmware version.
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C H A P T E R  2
CH AP TE R 2:  TA LK SW ITCH CO NF IG URATION

TALKSWITCH CONFIGURATION

2.1  SYSTEM CONFIGURATION

This chapter contains detailed information about all the features in the 
TalkSwitch configuration software with step-by-step instructions on how to 
customize these features to best suit your needs.

2.1.1 The configuration screen

The configuration screen consists of the following parts:

Figure 30: Initial configuration screen



The numbers in Figure 30 are explained below.
    

2.1.1.1 File Menu    

2.1.1.2 View Menu
 

1. Menu items.

2. Configuration navigation controlling the display in the configuration 
window.

3. Configuration window displaying configuration information.

4. View System Information is a link to the MAC address, IP address, 
hardware and firmware version of the unit.

Context-sensitive help information is available for each option in the 
configuration software. Rest your mouse cursor over any of the controls 
and the information related to that control displays in a pop-up.

Open... Opens the existing configuration files from the PC. TalkSwitch 
backs up the configuration to a file called Configuration every 
time you save the settings.

Save to 
TalkSwitch

Saves the current configuration to the TalkSwitch unit.

Save to File... Saves the current configuration to a file on your PC.

Exit Closes the configuration software.

Retrieve 
Settings

Retrieves the settings from the unit connected to the PC.

Update 
Firmware....

Updates the firmware. For more information, 
see 1.5.2 Upgrading the TalkSwitch software and firmware on 
page 5.

Toolbar Toggles the toolbar on/off

Status Bar Toggles the status bar on/off
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2.1.1.3 Tools Menu

2.1.1.4 Help Menu 

Memory 
Usage  

Voicemail: Displays a dialog box showing internal memory 
usage for voicemail messages. 

Auto Attendant: Displays a dialog box showing internal 
memory usage for auto attendant messages.

Voicemail 
Manager

Displays a dialog box with options to check the voice mailbox 
data, delete a mailbox password and reset mailboxes to 
factory default.

Terminal 
Window

Displays a command line interface. This option is useful for 
troubleshooting in conjunction with technical support.

Call Logging 
Output 

Real-time to Serial Port: TalkSwitch can output call detail 
records to a PC connected to a Serial port. 

Store to file on TalkSwitch: TalkSwitch can store call detail 
records to a file stored on TalkSwitch. This file can be 
retrieved/viewed from a web browser.

Defaults... Resets the current page or the entire configuration to 
defaults.

Reboot 
TalkSwitch

Prompts you to save the configuration and provides options 
when to reboot.

View Keys 
Installed

Lists your registration key(s) with the expiry date(s).

Check for 
updates

Checks the web site for configuration software updates.

About 
TalkSwitch 
Configuration 
Utility...

Displays the TalkSwitch software version number, firmware 
version and copyright information.

User Guides... Opens the folder containing the TalkSwitch documentation.

Support on 
the Web...

Launches your browser and links you to our support site. 
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2.1.1.5 Configuration navigation

The configuration navigation organizes all the configuration topics within 
folders. The following is a brief description of each folder seen in the 
navigation section to the left of the window. See Figure 2.1.2 on page 33.

1. Open the TalkSwitch configuration software.

2. Click the  sign beside each folder to expand it and display configuation 
option sub-categories. When you configure TalkSwitch or when you wish 
to modify the setup, it is helpful to be familiar with this structure.  

About 
TalkSwitch

This link displays version information about the TalkSwitch 
software. It also displays new voicemail messages, the time 
and date and the current mode of operation.

System 
Information

Configure the system setup. From here you can activate lines 
and extensions.

Voicemail Configure voice mailboxes and global settings for the 
voicemail system.

Call Handling Configure how to handle incoming calls. It includes auto 
attendant and individual call handling setups for all phone 
numbers, extensions and modes of operation.

Call Back/
Call Bridge

Configure the TalkSwitch call back/call bridge features in this 
folder. Both of these features reduce your company’s 
long- distance expenses.

Options Configure audio controls, troubleshooting and various 
operation settings in this folder. 
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Figure 31: Configuration navigation

2.1.2  Special considerations when connecting multiple units to a LAN    

Multiple units on a LAN will function as a single phone system. Some 
features are expanded as you add units (e.g. number of voice mailboxes), 
others are global in nature and are not expanded when you add more units 
(e.g. park orbits).

To determine the number of local extensions and mailboxes your TalkSwitch 
system supports, add the extension jacks (E1–E8) on all the units. In 
addition, each unit supports ten remote extensions and mailboxes.
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Example: If you have two 48-CA units connected on the same LAN, the 
system can support 8 PSTN lines, 16 local extensions and 20 remote 
extensions.Each unit is identified with a tab at the top of the configuration 
window, System Information -> Telephone Lines to allow you to select 
the unit in the group. 

Figure 32: Unit tabs

The features described below are not affected by the number of units on 
the LAN.    

Feature Description
Auto Attendant
(See 2.4.2 Auto 
attendant on page 80)

There are 9 auto attendants shared by all units on 
the LAN. This means that all inbound calls can be 
answered by the same auto attendant on an 
incoming line. When a new auto attendant is 
recorded on a unit, it is automatically copied onto 
all the other units.

Music on Hold
(See 2.2.10 On-Hold/
Ringback on page 63)

There are two ways to add music on hold to your 
system:
• through an external audio source
• by loading an internal music file

Call Back
(See 2.5 Call Back/Call 
Bridge on page 98)

There are 4 auto call back accounts per unit. To use 
an announced message for a particular auto call 
back account, you need to record the announced 
message on the same unit as the account. This 
means calling in on a line that is physically 
connected to the unit with the account, or using an 
extension connected to the unit.

Ring Groups
(See 2.2.9 Extension ring 
groups on page 61)

There are 10 global ring groups (300-309) regardless 
of the number of units on a LAN. Each group is 
capable of ringing any extensions on the network. 
A combination of 32 analog and IP extensions can 
be part of a ring group.

Park Orbits There are 10 global park orbits (500-509). Any 
person can put a caller on hold in a temporary park 
orbit so that the call can be retrieved from any 
extension in the office.
3 4 T A L K S W I T C H  US ER  GU ID E •  NO R TH AM ER ICA



2.2  SYSTEM INFORMATION  

2.2.1 Administration  

For security reasons, we recommend that you use password protection at the 
administrator level. The password is entered at configuration start-up and 
when you access the configuration through an extension phone.

To activate the use of a system password: 

1. Click the  next to System Information -> Administration.

Figure 33: Username and password

2. If you have units in different locations, we recommend that you assign a 
system name to each unit for tracking purposes. Enter a name in the 
System Name field. The system name will also be required when you are 
logging in through the web interface of the unit for status or Call Detail 
Record (CDR) information. For more information, see 
Chapter 4: Call Detail Record (CDR) Logging on page 147.

 
Public Address (PA) Each unit has a PA output for connection to a 

public address system. The PA output for a 
TalkSwitch unit is only accessible from extensions 
connected to that unit. To connect all outputs to a 
single amplifier, you will require an adapter. 

Some of the configuration screens that follow may vary depending on 
whether the unit is networked or not. In most cases, the 48-CA/CVA 
screen is shown unless the caption indicates a 24-CA screen. The 24-CA 
models do not have IP Configuration and VoIP Configuration in the 
System Information folder. 
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3. Enter a system password in the System Password field. It has to be a 
4- to 8-character numeric password, so that you can also enter it on a 
touchtone phone. 

Figure 34: Username and password for a VoIP enabled unit    

  

To enter a new password:
1. Click in the System Password field.

2. Type a password and click OK.

To change the password:
1. Click in the System Password field.

2. Type a new password and click OK.

To delete a password: 
1. Click in the System Password field. 

2. Do not enter anything and click OK. 

Caution: If you leave the password field blank and you are connected to 
the Internet using TCP port 9393 mapped to the unit, the system will be 
vulnerable to configuration changes by anyone on the Internet! 
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Figure 35: Password dialog box

.
3. After entering, changing or deleting a password, 

click File -> Save settings to TalkSwitch or click the middle icon in the 
tool bar to save the settings. 

Figure 36: Save settings

New settings must be saved to the 
TalkSwitch phone system to take effect. 
A progress bar will show the data 
exchange to the TalkSwitch unit. 
It takes only a few seconds to 
complete.

2.2.2 IP Configuration

TalkSwitch 48-CVA requires an IP address to function properly. If you have a 
TalkSwitch 48-CA, an IP address is required if you want to configure the 
system remotely or if you want to network it with a CVA on a LAN. There are 
two methods of configuring the IP settings, automatic and manual. The 
automatic setting is the default. See Figure 37..System IP Settings section 
The Obtain IP and DNS information automatically radio option is selected by 
default. This selection refers to DHCP (Dynamic Host Configuration 
Protocol). If you are on a DHCP server, the IP and DNS information will be 
filled in automatically.

1. Click the  next to System Information -> IP Configuration.
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Figure 37: Automatic IP configuration

2. To configure the IP information manually, select Use the following IP and 
DNS information.     

Figure 38:  Manual IP configuration

If you do not have a DHCP server, the following fields need to be completed 
if you plan on using the VoIP capabilities of TalkSwitch 48-CVA.

Additional VoIP configuration information is contained throughout this 
guide. For more information, see 5.4 VoIP Configuration on page 162.
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Unit IP Address: 
Assign an available static IP address to each unit (1-4). If you use a DHCP 
server, you have to reserve an IP address for each unit. To reserve an IP 
address, you need the MAC address of each unit. To view the unit MAC 
address, click the View System Information link on the About TalkSwitch 
configuration page. For more information, see 2.1.1 The configuration 
screen on page 29.

Subnet Mask: 
Enter the subnet mask for the LAN. This address determines what subnet 
the specific addresses belong to.

Default Gateway: 
Enter the IP address of the gateway on your network. A gateway is a 
hardware device (i. e. router/NAT) that connects the office network to 
the Internet. The gateway allows you to share a DSL, cable modem or 
other Internet connections with all of the computers and IP devices in 
your office network.

Preferred DNS Server: 

Enter the IP address of the preferred/primary DNS server. DNS is a service 
that is used to resolve a domain name to an IP address. 

Example: A DNS server is used by your web browser to resolve 
www.talkswitch.com to an IP address such as 64.26.166.52. For more 
information, see Chapter 5: VoIP Information on page 155.

Alternate DNS Server: 
Enter the alternate/secondary DNS servers IP address if applicable.  

Public WAN IP Address 
 Type of public WAN IP address for Internet Connection: 

This field is set to dynamic by default. The unit checks the public IP address 
every 5 minutes. If it changes, it automatically updates to the correct 
information in order to manage VoIP calls properly.

The dynamic setting will not work in closed network environments. In a 
closed network environment, change the field to static and enter the 
appropriate IP address. If the unit is not behind a router, enter the IP address 
of the unit acting as the local proxy.

Current public WAN IP address: 
For the dynamic setting, this entry shows the current public IP address and 
is not editable. For the static setting, enter the IP address or the FQDN of 
your location.
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Public WAN IP address-checker server name:
For the public IP address type dynamic, this entry shows the current server 
name for the IP checker utility. If the public IP address type is static, no 
information is required. 

The default location is checkip.talkswitch.com. An IP checker application is 
running on the server that responds to requests from units for the public IP 
address at its location.

Fully Qualified Domain Name:
A Fully Qualified Domain Name (FQDN) is required if this location acts as the 
SIP server and does not have a static public IP address from your service 
provider. You can obtain FQDNs for free at www.dyndns.org. If your router 
supports DDNS, program the required information to update the DNS servers. 

If not, download one of the applications specified on the site. It needs to 
run on a PC connected to the same LAN to update the DNS servers. If the 
unit is enabled as a SIP server and no FQDN was entered, the prompt below 
displays.

Figure 39: Fully Qualified Domain Name (FQDN)

2.2.3 Telephone Lines

This section tells TalkSwitch about the telephone lines plugged into its back 
panel. Select a line and fill in the information. For each line there is a status 
message: Line Detected, indicating that TalkSwitch detected a line plugged 
into the associated line port. If a line is plugged into a line port and is not 
detected, check your telephone line connection. 
1. Open the configuration software, if not already open.

2. Click System Information -> Telephone Lines.     
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Figure 40: Telephone lines

In the Phone numbers section     
Enter the main telephone number for the line connected to TalkSwitch. 
Enable the Distinctive Ring 1 and/or Distinctive Ring 2 if you have this 
service on the current line and wish to have incoming calls handled 
differently on the basis of the distinctive ring. If you want distinctive ring 
numbers handled the same way as your Main number, do not place a 
checkmark in the box.

If you checked the box, enter the distinctive ring telephone number for 
each of the distinctive ring numbers associated with this line. 

• Distinctive Ring 1 corresponds to any double ring pattern. 
• Distinctive Ring 2 corresponds to any triple ring pattern.

3. Click the Activate line checkbox to enable the telephone line port. 

4. Enter the normal telephone number for the telephone line as the 
Main number.

In the Telephone Company Services section  
Check the boxes that correspond to telephone company services that are on 
this line. Descriptions of these services and how your unit deals with them 
are provided below. For more information, see  Appendix B: TalkSwitch and 
Telephone Company Calling Services on page 193.

3-Way Calling/Conference 
TalkSwitch can work with a service to forward calls to remote extensions or 
other external phone numbers while using same line connect. You can use 
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this service as an option for bridging calls to external numbers when you 
call into a unit from outside. If you are having difficulties with line volume 
levels when you forward calls to remote extensions or when you are using 
call bridge, forward calls using 3-way calling.

Transfer and Clear (Centrex/Plexar transfer)
TalkSwitch can clear the line after forwarding a call to a remote extension, if 
your telephone line supports this feature. If you enable this feature without 
having the service, callers are disconnected when a unit attempts to forward 
their call to the remote extension.

Call Waiting
Check this box if you have a call waiting service on the current line. Note 
that you should remove this service from your line, since there is no way for 
the unit to answer a second call on the same line while it is handling the 
first call. You may want to consider adding the hunt/rollover service to your 
lines instead. 

Caller ID
Check this box if the current line provides Caller ID information. The unit 
passes the Caller ID information along to the selected extension. Also, 
TalkSwitch can use the time information provided by Caller ID to update the 
TalkSwitch clock. 

Telephone Company Voicemail
Check this box if you are subscribed to a telephone company voicemail 
service.

Hunt/Rollover/Busy Forwarding
Check this box if the current line is associated with a line hunt or Line 
Rollover service from the telephone company. Any lines that belong to a 
hunt/rollover group should be configured to handle calls the same way.

Calibrate Lines (button):
Click this button whenever a line is added or changed. Calibrate Lines allows 
TalkSwitch to optimize lines for call bridge and call forwarding. Only lines 
that are detected get calibrated. 

  2.2.4 Line hunt groups 

There are a total of 9 line hunt groups that control outbound call line 
selections. These line hunt groups are used by local and remote extensions, 

For information about configuring the VoIP numbers, see 
5.4.3 VoIP Numbers on page 170.
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and by call bridge. Each hunt group can support several line choices and 
attempt to use an available line in the order that they are listed for that 
hunt group. These settings have no effect on incoming calls.

Default setup:    

1. Select System Information -> Line Hunt Groups.

2. Select a Line Hunt Group and enter a unique Line Hunt Group name to 
identify this group elsewhere in the configuration software.

3. Under Set Line Hunt Group, select the Line Type. If you wish to use this 
hunt group to access telephone lines, select Phone Lines. To use this hunt 
group to access VoIP numbers, select VoIP numbers.

4. Click the checkbox(es) next to the line(s) you wish to add to the hunt 
group.   

Figure 41: Hunt group configuration 

Hunt Group 9: selects any available telephone line.

Hunt Group 81: selects telephone Line 1.

Hunt Group 82: selects telephone Line 2.

Hunt Group 83: selects telephone Line 3 (only four-line models).

Hunt Group 84: selects telephone Line 4 (only four-line models).

Hunt Group 88: selects any available VoIP number (only applies 
when a VoIP unit is present on the LAN).

 If multiple units are connected to the LAN, outbound calls always hunt     
 the lines on the unit where the extension is connected. This minimizes
 network traffic between units. 
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Figure 42: Hunt lines on same unit first

2.2.5 Automatic Route Selection and Toll Restriction

What is Automatic Route Selection (ARS)?
ARS allows you to automatically direct outgoing calls to selected lines. With 
ARS, you can ensure that your outgoing long-distance calls use the line with 
the lowest-cost long-distance plan or that your inter-branch calls always use 
your VoIP trunks. 

What is Toll Restriction?
Toll restriction blocks calls to specific destinations. With toll restriction, you 
can prevent extensions in your system from placing unauthorized long-
distance calls.

Example: You have a low-cost long-distance plan. You assign one telephone 
line to handle all local calls and another line for long-distance calls within 
North America to go through your long-distance plan. At the same time, you 
can block unauthorized long-distance calls from going overseas. 

TalkSwitch uses the first several digits (referred to as ‘leading digits’) of a 
phone number to automatically select the specific phone line that you have 
chosen to make that type of call. ARS and toll restriction use line hunt 
groups, which have to be configured to provide access to telephone lines or 
VoIP trunks. 

Planning Automatic Route Selection and Toll Restriction 
• Identify the leading digits of the numbers for the calls to be routed or 

blocked.
• Identify the carrier codes.
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• Identify which telephone lines and VoIP trunks are connected to 
different networks and services. 

• Identify which extension’s calls you wish to route or block.   

Entering leading digits and assigning actions
What are leading digits?
• Leading digits are the first digit or first several digits of an international 

access code, country code, area code or phone number. 
• Leading digits can be anywhere from 1–11 characters. 
• Leading digits can include numeric characters 0–9 and .  

The leading digit for long-distance calls within North America is 1. As soon 
as you dial 1xxx xxx-xxxx, the system recognizes that you are making a 
long-distance call within North America.

To place an overseas call from North America, you would dial 011, followed 
by the country code, the area code and the phone number (i.e. 011 xx xx 
xxx-xxxx). Once you dial 011, the system recognizes that the caller is 
placing an overseas call (011 are the leading digits). 

ARS will route or block calls according to the leading digits you define and 
the actions you chose in the TalkSwitch Configuration under System 
Information -> Auto Route Selection.        

Figure 43: ARS — leading digits

Ensure that the line hunt groups are configured before using ARS. For 
more information, see 2.2.4 Line hunt groups on page 42.

*
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1. Enter the leading digits you wish to route or block in the Leading Digits 
field.

2. Select the desired Action (route to a specified line hunt group or block 
calls) from the corresponding drop-down list.  

Entering carrier codes and start times
What is a carrier code?
In addition to leading digits, you can access your long-distance plan. It may 
be different for North America and for overseas as well as during different 
times of the day (i.e. business hours or after hours). The Carrier Code 1 and 
Carrier Code 2 columns give you theses options. TalkSwitch automatically 
adds a 2-second pause after dialing the carrier code to pick up the dialtone 
of the long-distance provider. A carrier code can be up to 24 digits long, 
including ‘*’, comma ‘,’ and ’w’. The comma causes a 2-second pause; ‘w’ 
waits for the dial tone.

3. Enter the telephone number for your long-distance plan. Enter the 
number without spaces or dashes.

4. Select Start Time 1 for Carrier Code 1 from the drop-down list. If the 
access number is the same 24 hours a day, click the checkbox next to All 
Day. If you have a different plan for business and after hours, enter it in 
the Carrier Code 2 field and select a time for Start Time 2.     

Figure 44: Examples of leading digits

• If you dial 9 followed by a phone number that does not start with 1, 01 
or 01161, you access an outside line. The number is automatically routed 
according to the configuration of line hunt group 9.

The entries that you specify for ARS match the dialed digits with the 
longest leading digits entry. If the numbers dialed match the digits that 
you specified, the call is routed to a line hunt group or blocked according 
to the Action you selected.
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• If you dial 9 followed by 1, a 3-digit area code and a 7-digit number, you 
access a line for long-distance calls in North America, as defined in line 
hunt group 82.

• If you dial 9 followed by 01, the call is blocked. At the extension, you 
hear a prompt stating “You are not permitted to dial this number” and 
then a normal dial tone.

• If you dial 9 followed by 01161, an area code and a phone number, you 
access a line for calls to Australia, as defined in line hunt group 83.    

Figure 45: ARS and line hunt groups

Set local extension hunt group access 
By default, all line hunt groups for each local extension are enabled. If you 
wish to restrict access to some line hunt groups, you need to disable the line 
hunt groups at the local extension.

1. Open the TalkSwitch configuration software. 

2. Select System Information -> Local Extensions. 

3. Click the Hunt Group Access button. 

4. Remove the checkmark (by clicking it) next to the line hunt groups you 
do not want to allow for that local extension. 

Repeat these steps for all your local extensions. When you allow access to 
line hunt groups that have ARS activated, the calls are routed through ARS.

Direct Line Access
If you enable Direct Line Access on an extension, calls placed from that 
local extension are routed to the designated line hunt group. If ARS is 
enabled on that line hunt group, the calls are routed through ARS. 

 Line hunt group 80 
is used for Same 
Line Connect. If 
line hunt group 80 
is enabled, it will 
be subject to ARS 
blocking rules.
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Figure 46: Outgoing call options

Password Protection 
We recommend that the administrator password protection be enabled when 
you use automatic route selection and toll restriction. Enable the password 
protection in the TalkSwitch configuration software under System 
Information -> Administration. 
Enter a 4- to 8-digit numeric password.

Telephone Line 3-Way Calling Services 
Calls on telephone lines with the telephone company‘s 3-way calling service 
are not routed through ARS. They are either allowed or blocked.

Call Detail Record (CDR) Logging 
For information on CDR, please refer to Chapter 4: Call Detail Record (CDR) 
Logging on page 147.

Emergency Service Numbers section
The 911 emergency access number is always allowed through ARS, even if 
the line is blocked.
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Automatic Route Selection Examples        

2.2.6 Fax information   

TalkSwitch provides you with different options to configure your office for 
fax calls. The advantages and disadvantages of each option are described 
below, so that you can choose the best solution for your office.

Dedicated fax line 
You may already have an incoming dedicated fax line. For more information, 
see 2.2.6.1 Dedicated fax line on page 50.

Advantages: It is easy to set up and you don’t need to change the way your 
fax handles calls.

Disadvantages: The dedicated fax line cannot be shared with the other 
phone devices (i.e. You cannot make an outbound voice call on your fax 
line). The dedicated fax line costs money and may not often be used.

Distinctive Ring fax detection
Distinctive ring is a service provided by your phone company. A second 
phone number is added to the same physical telephone line. For more 
information, see 2.2.6.2 Distinctive ring fax detection on page 52.

Advantages: It does not require a second physical line for faxes. More 
telephone lines can be added as you grow and you can keep the same fax 
arrangement.

Blocking international calls, with exceptions

Leading Digits Action Objective

01
1
1212

10

Block Calls
Block Calls
Hunt Group 1

Block Calls

International calls are restricted.
Calls in North America are restricted.
Allow calls to New York area code 212 
using Line Hunt Group 1.
Using alternative long distance provider.

Restrict access to premium services

Leading Digits Action Objective

1900
1976
900
976

Block Calls
Block Calls
Block Calls
Block Calls

Restrict access to premium inbound calling 
services. 
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Disadvantages: You only have one line and can only handle one call at a 
time. The phone company may charge a fee for a distinctive ring.

Automatic fax detection with the auto attendant
An auto attendant can detect incoming fax calls and route them 
accordingly. For more information, see 2.2.6.3 Automatic fax detection on 
page 53.

Advantages: Calls are automatically handled for you, no distinctive ring 
service and no listening to ring patterns are required. Incoming phone lines 
are shared between all phones and faxes, making better use of your 
resources.

Disadvantages: Older fax machines do not emit a CNG tone and the auto 
attendant cannot detect them.

2.2.6.1 Dedicated fax line   

If you have a dedicated fax line or number, your fax machine should be 
connected to an extension jack on the same unit as the fax line. Leave this 
line directly connected to your fax machine. Connect the remaining 
incoming telephone lines to your unit. Incoming telephone lines will be 
handled by the unit and your fax will work the way it has always worked.   

Figure 47: Dedicated fax line

1. Open the TalkSwitch configuration software. 

2. Select System Information -> Fax Information. 

3. In the Dedicated fax line section, select the fax number from the 
drop-down list next to Fax number:. 

4. In the Fax extension section, select the extension number where your 
fax is connected. 

After installing TalkSwitch, the fax machine remains on its own dedicated line.  
All incoming telephone lines are shared by the remaining office phones.
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5. Save settings to TalkSwitch.

Example: If your fax machine is connected to E8 on the rear of unit 1, select 
extension number 118 for units with 8 extension jacks or 113 for units with 
4 extension jacks. If your fax machine is connected to E8 on a unit with Unit 
ID 2, the fax extension number is 128.  

Figure 48: Fax information

If you do not see your fax number in the list, make sure you have activated 
the line in the TalkSwitch configuration software under
System Information -> Telephone Lines.  

Figure 49: Telephone lines
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2.2.6.2 Distinctive ring fax detection  

A single telephone line can have two assigned numbers with a different ring 
pattern for each number. Based on the ring pattern, you pick up the phone 
or let the fax answer the call.   

Figure 50:  Distinctive ring without TalkSwitch

Figure 51: Distinctive ring with TalkSwitch

Here is how TalkSwitch handles incoming calls:

The unit automatically routes faxes to the fax machine and calls to the 
telephone.

One of the incoming lines will have a distinctive ring number assigned to it. 
The unit recognizes this number as an incoming fax line. Follow the steps 
below:

1. Open the TalkSwitch configuration software. 

2. Select System Information -> Telephone Lines. 

3. Choose the line number for the incoming fax and click in the box next to 
Activate line.

By default, when a dedicated line and a fax extension have been selected 
for the first time, the software automatically configures the incoming call 
handling properties for that line to ring only the fax extension that you 
have specified.

Distinctive
RIng 1

Distinctive
RIng 2

After installing TalkSwitch, it automatically detects the distinctive ring pattern. 
Faxes are automatically routed to the fax machine and calls to the phones.

Distinctive
RIng 1 Distinctive

RIng 2
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4. In the Phone numbers section beside Main number, enter the telephone 
number that people dial to call your office.

Figure 52: Telephone lines

5. Click the checkbox beside Distinctive Ring 1:

6. Enter the distinctive ring number in the text field. This is the number 
people will call to get your fax machine. 

7. Click Fax Information.

8. In the Dedicated fax line section, select the fax number from the 
drop-down list next to Fax number: 

9. In the Fax extension section, select the extension number where your fax 
is connected.

10. Save settings to the unit.

2.2.6.3 Automatic fax detection  

Provided all calls are answered by the auto attendant, it can detect 
incoming fax calls and will route calls to their destination.

If an auto attendant is already configured, do the following:

1. Open the TalkSwitch configuration software if not already open. 

2. Select Call Handling -> Auto Attendant. 

3. Select Auto Attendant 1. You can configure additional auto attendants 
later. 
T A L K S W I T C H  C O N F I G U R A T I O N                                                 5 3



4. In the drop-down menu next to If a fax call is detected:, select go to local 
extension and select 118 (113 for units with 4 extension jacks). 

Figure 53: Fax routing

5. Save settings to the unit.

Set up at least one auto attendant to answer all incoming calls, play a 
recorded message, allow callers to dial their party’s extension or dial 0 for a 
receptionist. For more information, see 2.4.2.1 Adding/configuring an auto 
attendant on page 80.

2.2.7 Local extensions

Local extensions can be analog phones connected to any of the extension 
jacks at the back of TalkSwitch or IP phones on the same subnet registered 
with your TalkSwitch system. For more details on connectivity, see 
1.8 Connecting devices on page 15. Local extensions are activated with the 
associated voice mailbox by default. Voice mailboxes for each local 
extension can be de-activated in the Voicemail folder.

Activating a local extension for use with an analog (regular) phone

By default, all analog extension ports are active. Plug phones into the 
extension ports and you are ready to make and receive calls. 

Figure 54: Analog extension
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Configuring a local extension for use with a IP phone 
1. Open the configuration software. 

2. Select System Information -> Local Extensions. 

3. Change the radio button from Regular Extension to IP Extension.

4.  The default Username and Password are <user ext#> and <pass ext#>. 
Change either as required. 

Figure 55: IP extension

Once the phone has been programmed with the extension number, 
username, password, registrar and proxy information you can confirm 
registration as follows: 

1. Connect the IP phone to the LAN with the Ethernet cable.
2. Connect the power to the IP phone.
3. Click the Refresh button when the phone indicates that it is registered. 
Additional fields
Caller ID Information section

Last name/First name:
Enter the last and first name of the person associated with the extension. If 
you want to include the person in the dial-by-name directory used by the 
auto attendant, you must enter the last name. The name entered displays on 
the Caller ID of other local extensions. The person using that extension is 
required to record her/his name for the directory.

Please refer to the configuration guide for your IP phone in the 
TalkSwitch documentation folder. If you are using a third-party IP phone, 
refer to the user guide for that phone.
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For VoIP calls, use: [this number]
Select the number you want to display at the remote location when VoIP 
calls are placed from this extension. If Default VoIP number is selected, the 
phone number associated with the outgoing VoIP port is used. This selection 
makes the most sense if your VoIP numbers have been configured to handle 
all inbound calls the same way.  

For <Service Provider> VoIP calls, use:

Figure 56: IP extension username and password

Phone Type
If you have a TalkSwitch phone connected to this extension, select the 
model of phone. TalkSwitch sets have some integrated features that will not 
work unless the proper phone is specified. Features include intercom paging, 
group paging over the speaker, and message waiting counter on the TS-80, 
TS-200, TS-400 and TS-600 phones.

For the IP extensions, TalkSwitch requires IP phones that have G.711 CODEC 
support. 

The IP phones officially supported by TalkSwitch are:

• Polycom Series — 301, 430,  501, 601 (minor support differences 
between models)

• Grandstream — GXP-2000 (Excellent low budget phone) 
• Counterpath — Eyebeam soft client. 

If a name was not recorded before you set up the associated voice 

mailbox, pick up the handset, press   + <mailbox number> 
and press 4.

* *
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Other phones may work with the system, but not all the features may be 
supported. We strongly recommend that you only use the IP phones 
supported by TalkSwitch.

Figure 57: Phone types

Direct Line Access... (button)
This feature allows users to access an outbound line without dialing extra 
digits. When the extension goes off-hook or a number is dialed on a IP 
phone without first dialing a hunt group, Direct Line Access allows you to 
configure the extension to access a specific hunt group automatically for 
outbound calls.  

Example: You may have a fax machine connected to this extension and 
don‘t want to reprogram the speed dial numbers. Click Direct Line Access 
and choose the hunt group. As soon as the fax goes off-hook, the unit finds 
an available line. 

When Polycom or Grandstream is selected, the username and password 
are fixed and not editable.

Warning: When using Direct Line Access with an analog phone, you hear 
the telephone company dial tone when you pick up the handset. The 
following features are only available from the TalkSwitch internal dial 
tone: 
• Intercom calling 
• Hold and retrieve 
• Line hunt groups
• Voicemail retrieval/access
• Call pick-up 
• P.A. access, 
• Parked call retrieval 
• Do Not Disturb functions
• Entering command mode 

To obtain an internal dial tone at an extension which has Direct Line 
Access enabled, dial Flash after going off-hook on an analog set. On a IP 

phone, dial  , then press Dial, Send or .* * #
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Hunt Group Access... (button) 
You can permit or restrict specific hunt group access to the extension. Click 
the checkbox next to the Line hunt groups that you want to allow for this 
extension.

2.2.8 Remote extensions

A remote extension allows you to connect an external telephone number. 
This could be a cell phone or a number to your office. You can have it 
operate similar to a local extension in your office. Any external telephone 
number can be configured as a remote extension (i.e. cell phone, PDA, home 
telephone or branch office).  

With remote extensions, you can have calls forwarded directly from your 
office to any phone number you choose. You can choose to screen callers. If 
the remote extension is busy or unanswered, calls can be transferred back to 
your office voicemail, another extension or forwarded to another out-of-
office telephone number (e.g. to a business partner’s cell phone).

To set up remote extensions, see Figure 58 and follow the steps below.

1. Open the TalkSwitch configuration software. 

2. Select System Information -> Remote Extensions.

3. Click on a remote extension number, starting with 210. Add more 
numbers as needed.  

4. Click in the checkbox next to Activate Extension <ext>. 

5. Enter a last and a first name into the Last name: and First name: fields to 
identify the extension. 

6. Enter the external phone number.  

7. In the drop-down list next to Connect using:, we recommend that you 
leave it at Hunt Group 9 unless you have pre-configured another group.

If a TalkSwitch has Unit ID 2, the remote extension numbers are 220–229. 
Unit ID 3 has remote extensions 230-239 and Unit ID 4 240-249. 

Enter the number the same way you are dialing it from a regular phone. 
You may use digits 0–9, space, comma, dash,  and . 
A comma creates a two-second pause in the dialing string.

# *
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8. If you have a 3-Way Calling or Transfer and Clear service from the phone 
company, click the checkbox next to Use Same Line Connect.

9. Save settings to the unit.

Figure 58: Remote extensions

Once your remote extensions are configured, calls can be forwarded by the 
auto attendant or transferred by someone in your office. There are 10 
remote extensions available per TalkSwitch unit.

Use Same Line Connect   
Check this box to allow incoming calls to use the same line when 
forwarding it to the remote extension. This feature allows only one line 
to be used when forwarding incoming calls to a remote extension. It can 
only be used when the line of the originating incoming call has 3-Way 
Calling/Conference or Transfer service (Centrex/Plexar). If the line does 
not have any of these services, the call will be forwarded using the hunt 
group chosen in the Connect using: drop-down list.

If you have a Transfer and Clear service on your line(s) and want to have 
TalkSwitch clear lines after forwarding calls to remote extensions, you 
need to enable Clear telephone line after call transferred (Options -> 
Transfer Options). If your service requires the remote extension to 
answer the call before the transfer can be made, use one of the screening 
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options in Call Handling -> Remote Extensions in the drop-down list 
under the Answered tab.         

Forwarding calls to a remote extension 
• Manually from a local extension: 

Analog phone: Press Flash and the remote extension number (e.g. 211).
IP phone: Press Transfer and the remote extension number followed by 
Dial, Send or . For more details, see Appendix I: Functions and 
commands for IP phones.

• From an auto attendant: 
The auto attendant can be configured to route the calls to your remote 
extension. The auto attendant might say: “To reach Mr. A’s cell phone, 
press 1, to reach his office, press 2 or press 0 to reach a receptionist.” You 
can also instruct callers to dial the extension directly at the auto 
attendant. You could use this auto attendant as a company greeting or 
within your call cascade sequence at your local extension. For details, 
refer to 2.4.2 Auto attendant on page 80.

• From a call cascade: 
A call cascade sequence can route a call to a remote extension. 
If there is no answer at your desk, the call is transferred to your cell 
phone. If you don‘t answer your cell phone, the call is forwarded to your 
office voicemail. The caller hears music on hold. For details, refer to 
2.4.5.1 Local extensions on page 90.

Transferring calls from a remote extension 

1. Press   and dial any local extension, remote extension, or ring 
group, or press  again and a mailbox number to transfer the call to 
voicemail.

Remote extensions do not have the ability to transfer calls manually 
when using Same Line Connect.

When using Same Line Connect, callers hear silence while they are on 
hold. The callers are on hold at the telephone company and not at 
TalkSwitch. If you want callers to hear music while they are on hold for 
calls forwarded to remote extensions, don’t use Same Line Connect. It is 
best to experiment with different settings in order to decide what works 
best for your configuration. 

#

* *
*
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Figure 59: Remote extensions

2.2.9 Extension ring groups

An extension ring group is a group of local extensions that ring in unison. 
TalkSwitch supports 10 ring groups with numbers 300 to 309. They are 
accessible from local extensions and through the auto attendant. By default, 
extension 300 is configured to ring all extensions. 

Ring groups features
• independent call cascade
• distinctive ring cadence 
• call screening capabilities 

Setting up extension ring groups 
1. Open the TalkSwitch configuration software. 

2. Select System Information -> Extension Ring Groups. 

3. Choose an Extension Ring Group number, starting with 300.

4. Click in the checkbox next to Activate Ring Group 300. 

5. Enter a name in the field next to Ring Group Name:. 

A phone system with 4 units can support a combination of 32 analog and 
IP extensions with a maximum of 20 IP extensions.
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6. In the Set Ring Group window, choose the local extensions you want to 
ring in unison.

7. Select a Ring pattern: from the drop-down list to identify the incoming 
call before you pick up the phone.

8. Save settings to TalkSwitch. 

Figure 60: Ring groups

Different uses for extension ring groups 
You can send calls to specific groups of employees. 

Example: If you have a company with several departments, you can 
configure extension ring group 300 for the sales department to ring 
extensions 111, 112, 113, and 114. Ring group 301 might be for technical 
support, ringing extensions 115 and 116.

Identify types of calls by different ring patterns 
Example: You are the president of a company and you don‘t want to handle 
calls from the general public, yet you want to be alerted when important 
colleagues try to contact you. Your regular local extension may be 111 for 
most people, but you can configure an extension ring group 305 to ring your 
extension with a different ring pattern. You tell your colleagues to choose 
extension 305 at the auto attendant or ask to be transferred to extension 
305 when speaking to someone in the office. You can tell by the ring 
pattern if the call is to 305 or 111. 
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Forwarding calls to a ring group  
• Manually from a local extension: 

• From an auto attendant: 
Auto attendants can be configured to send calls to ring groups just as 
they do to extensions. The auto attendant might say: “To reach the sales 
department, press 1, to reach Mrs. A‘s office, press 2, or press 0 to reach a 
receptionist.” You could use this auto attendant as a company greeting or 
within a call cascade sequence at a ring group. 

• From a call cascade: 
The call cascade sequence can route the call to ring group 300. 
Example: If there is no answer at your desk, the call is transferred to the 
sales department. If no one answers the phone in sales, the call is 
forwarded to your voicemail. If music on hold is enabled, the caller hears 
music throughout the entire process.

2.2.10 On-Hold/Ringback  

The Music on Hold feature lets you provide music or a recorded message for 
callers while they are waiting to be routed or transferred. 

Callers tend to react more positively to transfers or waits if they hear music. 
Companies can also play recorded advertisements or provide information 
about their business. 

There are two ways to add music on hold to your system:

• an external audio source
• an internal file

2.2.10.1 External audio source  

An external audio source could be a CD player, tape player or a PC media 
player that you connect to TalkSwitch.

Advantages: The variety and length of music are virtually unlimited.

Disadvantages: Requires extra, dedicated equipment to be connected and 
running constantly with separate sound sources for each unit

1. Connect your external audio source to the unit using an 1/8" mono cable.  

Analog phone: Press Flash and the ring group number

IP phone: Press Xfer or Transfer and enter the ring group 

number, then press Dial or .#
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Figure 61: Music port 

You can use separate audio sources for each unit.

2. Once the audio source(s) is (are) connected to TalkSwitch, 
turn it (them) on.

3. Connect the unit to your computer and open your configuration 
software. 

4. Select System Information -> On-Hold/Ringback.

5. In the On-Hold Settings, select Play music whose source is connected to the 
MUSIC jack. See Figure 62.

6. Save settings to the unit. 

Figure 62: Music on hold

 If you have more than one unit connected to the LAN and you are using an 
 external music source, you need to connect the source to all units. Use a 
 1/8" audio splitter, available at most electronics stores. If you are using a 
 .wav file loaded on the unit, the music file is copied to all units on the   
 LAN.
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On-Hold Settings
There are three options when callers are placed on hold: 

1. Play ‘double beep’ tones to callers when they are on hold. This is the 
default setting. No additional configuration is required.

2. Play music whose source is connected to the MUSIC jack, if you have a 
music source connected to the music jack. 

3. Play music from file loaded on TalkSwitch, if you have a sound file 
loaded. You can convert MP3 and other file formats using a utility 
like Audio Converter or Ripper. Download a converter at: 
www.audioi.com. Check the volume of music on hold with a test 
call. Adjust the levels as required. This setting is not real-time. Save 
the configuration to the unit and make another test call.

2.2.10.2 Internal audio file  

You can load a digital audio file into memory.

Advantages: No additional equipment is required. You can use the same file 
for all units in the system. This provides seamless music for calls transferred 
across the network. 

Disadvantage: The length of the recording is limited by your memory 
capacity.

1. Connect the unit to your computer and open your configuration 
software. 

2. Select System Information -> On-Hold/Ringback. 

3. In the On-Hold Settings section, select Play music from file loaded on 
TalkSwitch See Figure 68.

4. Click the Load wav file... button. An information box displays the 
required format for the digital audio file. This file must be 8 KHz, 8-bit, 
mono, µ-law and saved as .wav format.

If your desired digital audio file conforms to the required format, click Yes, 
or else click No to exit. 

Memory can be expanded by adding TalkSwitch memory cards.
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Figure 63: Music file format

5. If you clicked Yes, the Load Audio File window displays. Browse to the 
location of the desired digital audio file, select the file and click on 
Open. 

6. In Transfer Settings, seen in Figure 64 on page 66, select Music if you 
want the caller to hear music instead of a ringback tone.

7. Save settings to the unit.

Set the volume for Music on Hold  
TalkSwitch offers the ability to adjust the volume of music on hold 
playback. In On-Hold Settings, to increase or decrease the sound level, use 
the drop-down list for Playback volume for music file:

Figure 64: Volume adjustment

Transfer Settings 
Decide if you would like your callers to hear ringing, music or double beep 
tones while they are being transferred. 

 

If you connect a music source to the music jack but do not enable Music 
on Hold, the caller hears both music and beep sounds. When the callers 
make a selection at the auto attendant to go to extensions with call 
screening enabled, they will hear ringing and music.
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2.3  VOICEMAIL

This section deals with the internal voicemail system included in 
TalkSwitch. TalkSwitch provides three types of voicemail:

• Local 
The mailbox is associated with a local extension. By default, each local 
extension has its own voice mailbox.

• Remote 
The mailbox is associated with a remote extension, such as a mobile 
phone. These mailboxes must be assigned by the user at the extenion.

• General 
The general system mailboxes are for general use or group voicemail. 
They are not tied to any specific extension.

2.3.1 Mailbox options

Local, remote, and general voice mailboxes can be configured the same way. 

The following procedure describes the setup of local extension voicemail. 
You can use the same steps for setting up remote and general voicemail.

1. Open your TalkSwitch configuration software. 

2. Select Voicemail -> Local Ext. Voicemail.

3. Click Activate as mailbox <ext>. 

4. You can use this option to relay information. If you want to prevent 
callers from leaving messages, select Activate as announcement <ext> 
from the drop-down list. Callers hear an announcement. During the 
announcement, callers can dial 0 or  to get back to the auto 
attendant before getting disconnected. 

5. In the Mail Box Options section, select one of the actions to perform 
when a caller presses 0 during mode 1 or during mode 2. The action 
options are the same for the different modes. 

Under remote extensions, make sure that the remote extension has been 
enabled, otherwise you cannot activate its mailbox.

*
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Figure 65: Mailbox and mode configuration  Load Greeting (button)

You can load a pre-recorded voicemail greeting from your PC to TalkSwitch. 
The file must be an 8KHz, 8-bit, mono, µ-law .wav file.

2.3.2 Voicemail notification 

2.3.2.1 Dialed notification 

Voicemail Notification Settings section
Under the Dialed Notification tab, choose the process by which you want to 
be notified — Remote Phone or Pager, or both. 

Remote Phone

If you want to be notified at another location when new messages arrive, 
use remote phone notification. 

1. Click the checkbox next to Remote Phone.

If you require additional memory for voicemail and auto attendants, 
memory cards can be purchased from www.talkswitch.com or from your 
local reseller. For details on how to use voicemail, see 3.8 Using the 
voicemail system on page 138.
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2. Enter the remote phone number as it would normally be dialed from 
where the unit is located.

Example: If your remote phone number is 905-555-1111 and you dial 
905-555-1111 to call your phone locally, you would enter 905-555-1111 as 
the remote phone number.

Figure 66: Dialed Notification 

Notification Settings (button)
Click on the Notification Settings button and choose one of the two 
options to handle notification calls.

Figure 67: Notification settings

1. Perform the notification process once:
When the unit detects the call was answered, it will play the notification 
message once only, then discontinue any attempts to re-connect.

2. The unit continues to re-connect until the recipient presses  or  
and considers the notification attempt successful if the person at the 
remote phone presses  to skip listening to messages or  to accept 
the call and listen to messages. 

* #

* #
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This option is useful for cell phones where the cell phone company plays a 
“subscriber not available” message instead of a busy tone. Once the cell 
phone is answered, TalkSwitch prompts you to respond to the incoming 
voicemail with  or .

1. Click the checkbox next to Pager if you want to be notified by pager 
when new messages arrive. 

2. Enter the pager number as you would normally dial it from your 
TalkSwitch location.

3. Enter the numeric message to be displayed on the pager. 

Configure Notification Options (button)
Define how TalkSwitch dials out of your office when notifying you of a 
voicemail. If the first connection is not successful, determine the number of 
times TalkSwitch continues to attempt the connection.

When you choose to be notified by pager and remote phone, TalkSwitch 
ensures that both locations have been contacted before finishing the 
notification process.

Figure 68: Configure notification options

Dial notification phone number using:
Select the hunt group you want to use for the remote phone and pager 
notification calls. You can also adjust the number of rings before it aborts 
the attempt and follows the parameters listed in the next section.

If attempt unsuccessful, try again:
These parameters control how many times TalkSwitch tries to notify the 
remote phone or pager before it aborts the notification attempt. You can 
specify the time interval between attempts.

* #
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2.3.2.2 Message waiting light  

You can set a message waiting light to indicate when a message has been 
received by an extension. Select the local extensions in your system where 
you want the light to flash when a message arrives. 
You can configure this feature for each mailbox.

1. Click on the Message Waiting Light tab.

2. Click Edit to select the extensions to notify when new messages arrive in 
a mailbox. The Voicemail Extension Indicators window opens. By default, 
the message waiting light turns on at the extension associated with a 
local mailbox when a message is received.

3. Click the checkbox next to the extensions to notify when new messages 
arrive in a mailbox.

4. Click on OK when done.

Figure 69: Extension indicators

2.3.2.3 E-mail notification 

Voicemail notification and messages can also be forwarded to any e-mail 
account with or without an audio file of the message. If you configure the 
unit to send the voicemail message, you do not need to call to pick up 
voicemail. Notifications include caller ID data.

You can use up to 250 e-mail addresses. You can assign up to 4 e-mail 
addresses for notification to each mailbox.
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Example 1: 1 unit: 8 local extensions (can be a combination of analog 
and IP), 10 remote extensions and 10 general mailboxes with 4 e-mail 
notification addresses each (28 x 4 e-mails = 112).

Example 2: 4 units on a LAN: 32 local extensions, 40 remote extensions and 
10 general mailboxes.  
How many unique e-mail addresses can be assigned to each mailbox? 
TalkSwitch has a limit of 250 e-mail addresses. This provides an average of 
3 unique e-mail addresses per mailbox:
250/82 mailboxes = 3 e-mails/mailbox.

1. Click on the E-mail Notification tab.

Figure 70: E-mail notification tab

2. Click the checkbox next to Enable e-mail notification.

3. Click Edit to add or modify or remove e-mail addresses.

Figure 71: Add, remove or modify e-mail addresses

Certain e-mail addresses may apply to more than one mailbox (e.g. 
sales@abccompany.com).
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To add an e-mail address:
1. Click Add. 

2. Enter the name of the recipient of the e-mail notification.

3. Enter the e-mail address of the recipient of the e-mail notification.

4. Click one of the radio buttons next to Attachment.

a) Yes  — The entire voicemail message gets attached to the e-mail as a 
sound file in .wav format. 

b) No — The e-mail includes notification information, but there is no 
file attached.

5. Click OK.

Figure 72: Enter name and e-mail address

Example of an e-mail notification:
New message from Joe Smith (555-1234)

The body of the e-mail reads:
_______________________________________ 
Voice Mailbox 111 
     New message from Joe Smith (555-1234)
     Received: Monday, April 5 at 5:45pm
     Length: 23 seconds

Total un-reviewed messages: 13
Total saved messages: 2 
______________________________________

To modify an e-mail address:
1. Select the address you wish to modify.

2. Click Modify. Modify the entries as needed following steps 2–5 above.

To remove an e-mail address:
1. Select the address you wish to remove and click Remove.
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Make sure you configure the E-mail Server Settings under Voicemail -> 
Global Settings. For more information, see 2.3.3 Global Settings.

2.3.3 Global Settings

Figure 73: Global Settings

These settings allow you to fine-tune your voicemail system. Any changes 
made to Global Settings affect all system voice mailboxes.

1. Select Voicemail -> Global Settings.

E-mail Server Settings section 

Figure 74: E-mail server settings

In order to send e-mail notifications, the system must be programmed with 
e-mail account information from your Internet Service Provider (ISP) or 
administrator.
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2. Enter the name of your Outgoing e-mail server (SMTP). 
Example: mail.mymailserver.com

3. Enter an e-mail address in the From E-mail address field. When e-mail 
notifications arrive from the system, this e-mail address will show up in 
the From field.

4. Enter an e-mail address in the Reply E-mail address field if you want 
responses to be handled by someone like an administrator. 
Example: administrator@companyABC.com. If you leave the field empty, 
the system will use the e-mail address entered in the From field.

5. Click More Settings to enter the parameters for server authentication.

Figure 75: More e-mail settings

6. If you wish to verify your settings, click Test Account Settings.

Figure 76: Test account settings
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Global Message Waiting Indicator
Click the checkbox next to Global Message Waiting Indicator if you would 
like the Power/Data light on the TalkSwitch unit to flash when you have 
voicemail in any TalkSwitch voice mailbox.

Mailbox Settings section
Next to When listening to voicemail messages always start with, select 
newest message (default) or oldest message to play first.

Next to When pager/remote phone notification of new messages is 
activated, notify the pager/remote phone after receiving, select every new 
message or only 1st new message.

For the Maximum recording length option, select any duration between 1 
and 8 minutes. The default setting is 2 minutes.

Click the checkbox next to Remove blank and hang-up messages 
automatically, if you want to delete blank messages (callers hang up 
when they reach your voicemail). If you have the caller ID service from 
your telephone company and choose to keep the messages, you will be 
able to check the caller’s number when they leave a blank message. 

2.3.3.1 Voicemail manager

The two options, View Mailbox Data and Reset Mailboxes, in the Voicemail 
Management section of the Global Settings window are also available under 
the main menu bar: Tools -> Voicemail Manager...

Figure 77: Voicemail manager

View Mailbox Data (button) in the Global Settings window, or 
View Status (button) in the Voicemail Manager window:
View the details for each voice mailbox and announcement followed by a 
summary to manage the voicemail resources of the system.
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Figure 78: Mailbox data

Reset Mailboxes (button)
All greetings, messages and settings for the selected mailbox(es) 
can be reset.  

Figure 79: Reset Mailboxes

If you need to delete a password for a particular voice mailbox (i.e. a user 
has forgotten the password):
1.  Tools -> Voicemail Manager (main menu).

2. Click the Delete Password... button

3. Select the mailbox from the Delete password for mailbox: drop-down list.
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Figure 80: Delete the password of a voice mailbox

4. Click OK.

2.4  CALL HANDLING

2.4.1 Modes

You may want the unit to handle calls differently depending on the time of 
the day, the day of the week or on holidays. These configurations are called 
Modes. You can configure all aspects of call handling (i.e. call cascade and 
auto attendants) differently for each mode. Define when you would like the 
unit to switch modes and name the modes to suit your environment. 

1. Select Call Handling -> Modes.

2. Create a name for Mode 1 and Mode 2. Here, we have named them 
Business Hours and After Hours. See Figure 81 on page 79.

3. Click the checkbox next to Use Automatic Mode Switching if you want the 
modes to switch automatically.

4. Set the day and time when you would like the modes to change. You can 
click Monday through Sunday and create unique settings for each day.

5. To use manual mode switching, change the modes at any local extension.

Switch modes manually using telephone touchtone commands. 
1. Dial  or  55 on a IP phone to enter command mode. Enter your 

password if required. 

2. Dial any of the following commands and press  to confirm.
30   TalkSwitch tells you what mode it is currently using.
31   Change TalkSwitch to mode 1.
32   Change TalkSwitch to mode 2.
33   Change TalkSwitch to holiday mode.

Warning: The mode will not change if you are logged into the 
configuration software tool at the time of the scheduled mode switch.

# *

#

7 8 T A L K S W I T C H  US ER  GU ID E •  NO R TH AM ER ICA



Figure 81: Modes

To set holiday mode:
3. Click the checkbox next to Enable Holiday Mode.

4. Click Settings.

a) Select the country in the drop-down list next to Populate calendar 
with holidays observed in. See Figure 82 on page 79.

a) Select any date in the calendar.

a) Click Add >>.

a) Repeat b) and c) until all required holidays are listed.

a) Select the mode to Use for Call Cascade settings and click OK. 

Figure 82: Holiday mode
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You can choose how incoming calls to any TalkSwitch extension are routed 
during Holiday Mode. Use the menu to select whether a call on a holiday will 
follow an extension‘s Mode 1 or Mode 2 call cascade (routing) settings. For 
example, if Mode 2 is used when the office is closed, you could choose to use 
Mode 2 call cascade for all extensions during holidays. 

2.4.2 Auto attendant

TalkSwitch handles inbound calls with an auto attendant. Auto attendants 
answer all incoming calls, play a recorded message and route callers to their 
requested extensions. 

If the receptionist is away from the desk, or if you do not have a 
receptionist, an auto attendant responds and gives callers options. Calls 
cannot follow an extension‘s call cascade sequence until an auto attendant 
has answered or the caller has been manually transferred. 

TalkSwitch has nine auto attendants. They can be used together to create 
powerful call routing options.

Callers can dial local extensions, remote extensions, extension ring groups 
(300-309), voicemail to leave and retrieve messages, access call back/
call bridge and enter command mode to make changes to the system 
configuration from the handset.

400 series mailboxes can be dialed at the auto attendant without 
pressing  first. This is useful for providing virtual extensions associated 
with a mailbox for telecommuters or other part-time staff.

2.4.2.1 Adding/configuring an auto attendant  

Follow the steps below to set up an auto attendant to answer all incoming 
calls, play your recorded message and enable callers to dial their party‘s 
extension or dial 0 for a receptionist.

1. Open the TalkSwitch configuration software, if not already open. 

2. Select Call Handling -> Auto Attendant. 

3. Select Auto Attendant 1 and type a name into the Auto Attendant Name 
field. You can configure and name 2–9 later. 

4. Follow these settings as shown in Figure 85. Set up your receptionist at 
extension 114. If you have other settings, enter the appropriate values 
for your office.

#
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Figure 83: Configuring auto attendant 

5. Callers who don‘t have a touchtone phone can be routed to the 
receptionist at extension 114. 

6. Set the time from the drop-down list After the auto Attendant has 
finished playing and no selection has been made within (0–30 sec.).

7. Select go to local ext. and select 114 from the drop-down lists. 

You can record the other 8 auto attendants. The total combined recording 
time is 30 minutes. The 30 minutes are shared with voicemail. You can 
expand the built-in memory up to 9 hours using a TalkSwitch memory card.  

Extension 114 should be used as the receptionist because it is the 
extension that works during a power failure. 

 When two or more units are networked (48-CA/CVA models only), they 
 share the same 9 auto  attendants. When an auto attendant message is 
 recorded on any  TalkSwitch unit, it is automatically copied to all the 
 other units on the  same LAN. This feature helps reduce network traffic
 and allows the system  to continue functioning even if a unit loses power 
 or is disconnected from the LAN.
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2.4.2.2 Record, play or erase auto attendant messages

You can record an auto attendant from any local extension or remote phone 
using touchtone commands.

1. Pick up a local extension or dial into TalkSwitch from an external source. 
At the auto attendant: 

2. Press  to enter command mode. 

3. Enter the administrator password if required. 

4. Begin entering the touchtone commands listed below and follow the 
TalkSwitch instructions. 

5. Press  to confirm the entry before continuing with other commands 
or exiting command mode. 

6. Press  or hang up to exit.

Example: From the local extension, pick up the handset and press  to 
enter command mode. If you want to record Auto Attendant 1, dial 4 1  
and follow the prompt. Press 5 1  to listen to your recording. To record 
auto attendant 2, dial 4 2  and so on.

Record Instructions (button)  
Click this button to display a dialog box showing the instructions on how to 
record and play an auto attendant using a telephone. The unit adjusts the 
recording volume for optimal recordings.

Figure 84: Recording instructions

#

#

*
#

#
#

#

What should an auto attendant say?

“Welcome to the ABC company. If you know 
your party‘s 3-digit extension you may dial it 
now. To reach our receptionist, press 0 or 
stay on the line.“
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Load Auto Attendant (button)  
Click this button to display a dialog box with instructions on how to load an 
auto attendant using a pre-recorded .wav file. If you want to have auto 
attendants professionally recorded, make sure to specify that the files have 
to be 8KHz, 8bit, mono, and saved as a µ-law format .wav file.  

Figure 85: Audio file format   

Erase Instructions (button)  
Click this button to display a dialog box showing the instructions on how to 
erase an auto attendant using a telephone. It is a good idea to erase unused 
auto attendants. They share the memory with voicemail.

Figure 86: Erase auto attendant 

Failure to record an auto attendant will cause your office phone to answer 
with no message. The caller will hear silence and might assume that the 
call did not get connected.

With the use of a memory card you can 
extend the time for voicemail and auto 
attendant recordings to up to 9 hours.
T A L K S W I T C H  C O N F I G U R A T I O N                                                 8 3



Figure 87:  View auto attendant time usage

2.4.2.3 Select routing options for each auto attendant

The caller can select the single-digit options 0, 1, 2, 3, 4 or 5. 

If the caller selects 0 then: 
The 0 option is used to direct callers to a receptionist. You may want to 
configure this option to ring a local extension. For an After Hours auto 
attendant, use this option to forward calls to a remote extension for 
emergency purposes or direct callers to a voice mailbox. 

If the caller selects 1, 2, 3, 4 or 5 then:
TalkSwitch can perform one of several actions in the table below at the 
selected auto attendant.  
   

perform no action If you don’t want to use a particular option, 
set it to perform no action.

go to voice mailbox You can configure any single-digit option to 
send a caller immediately to voicemail. Select 
the appropriate mailbox. 

go to local extension You can provide a single-digit option to ring 
a particular extension.

go to remote ext. You can provide a single-digit option to ring 
a particular remote extension.

go to VoIP location Select a VoIP location in the 250-299 range and 
TalkSwitch will forward the call automatically 
to the specified VoIP location.

View Auto Attendant Time Usage

To view the amount of time used by all 
auto attendants, go to the main menu: 
Tools -> Memory Usage -> Auto 
Attendant. 
You may have unused auto attendant 
messages. If you delete them, you can free 
up memory.
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2.4.2.4 Automatic fax detection 

If a fax call is detected then:
TalkSwitch can automatically detect incoming faxes and route them to your 
fax machine. To do this, the auto attendant must answer all incoming calls 
and listen for the CNG tone emitted by the incoming fax call. If a CNG tone is 
detected within nine seconds, the call is identified as a fax. If no CNG tone is 
detected, the auto attendant will wait for the caller to dial the appropriate 
digits or hang up.  

go to ring group You can provide a single-digit option to ring 
an extension ring group. 

go to auto attendant TalkSwitch can direct callers to multiple levels 
of auto attendants. For example, you might 
want to use your main auto attendant to 
provide language options like “press 1 for 
English, 2 for Spanish.” In this example, you 
configure option 1 to go to auto attendant 2 
(English version) and option 2 to go to auto 
attendant 3 (Spanish version).

queue at ring group This directs calls to a group of extensions and 
keeps callers on hold until a member of the ring 
group is free to take the call.

play announcement You can set any unused voicemail to play 
announcement only. Announcements are useful 
for providing directions, business hours and/or 
other information. Inform callers that they can 
press  to return to the auto attendant or 
you can program a 0 option to route to any 
other extension or greeting.

go to directory If you want to enable callers to locate employee 
extension numbers by last name, select this 
option.

By default, TalkSwitch waits 1.5 seconds after your caller enters a digit 
before following with another digit. If no other digit is received, 
TalkSwitch follows the action set for the single digit. This allows caller to 
use 1 for the auto attendant option and 111 as an extension number.

Some older fax machines do not emit a CNG tone and the auto attendant 
cannot detect them as an incoming fax. Also, if your auto attendant 
volume is set too high, or if your telephone lines are noisy, the auto 
attendant may not be able to detect the incoming CNG tone.

*
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If you do not want to use fax detection, have the unit perform no action.

If you want automatic fax detection, configure your incoming fax line to 
route faxes to extension 118. The default configuration assumes that your 
fax machine is attached to extension 118 (113 for units with four extension 
jacks).

2.4.2.5 No selection was made at the auto attendant

After the auto attendant has finished playing and no selection was made 
within a specified number of seconds, the unit can route the call to any 
extension including a fax machine, play an auto attendant or 
announcement, go to a voice mailbox, go to the dial-by-name directory, 
queue to a ring group or simply hang up.

2.4.2.6 Additional features at the auto attendant 

The digits 6, 7, 8 and 9 are not available as programmable options. They are 
used for other system features.

If 6 is dialed
If you press 6 at the auto attendant, you are able to configure and use 
auto call back and prompted call back features. See 2.5 Call Back/Call 
Bridge on page 98 for more details about configuring call back and 3.11.2 
Using call back on page 145 for details on using call back.  

If 7 is dialed
TalkSwitch uses 7 to precede PBX extensions of another Centrex or PBX 
system. If TalkSwitch is not connected to another system, 7 is inactive.

If 80–88, or 9 is dialed
If you press 80–88 or 9 at the auto attendant, you can access Call Bridge 
if it has been enabled. See 2.5 Call Back/Call Bridge on page 98 for more 
details about configuring call bridge and 3.11.1 Using call bridge on 
page 144 for details on using call bridge.

If you dial 6 at the auto attendant and Call Back is not enabled, 
TalkSwitch answers with the prompt: “I am sorry, there is no matching 
entry for these digits”.
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2.4.3 Telephone Lines 

This section describes how TalkSwitch handles incoming calls based on the 
incoming line and distinctive ring numbers. 

Configure incoming calls during mode 1, 2 and holiday mode
Each incoming telephone line has to be set to answer incoming calls using 
one of the auto attendants. In this example, we will use Auto Attendant 1 
and Mode 1 to answer all lines. If you are not using Mode 2 or Holiday Mode, 
you don‘t need to configure the settings for those modes.

Figure 88: Call handling telephone lines

1. Open the TalkSwitch configuration software.

2. Select Call Handling -> Telephone Lines.

3. Choose Line 1. Each additional line can be configured in succession, 
following steps 5 and 6.

4. Select Business Hours. 

5. From the drop-down menus, select Play auto attendant Switchboard and 
immediately. This will pick up all incoming calls on Line 1 and play your 
recorded greeting.

6. Repeat the same setting for each of your incoming lines. Start at step 4 
and choose Line 2 and apply steps 5 and 6.

7. Save settings to the unit.
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The other configuration options are described below. 

Ring Extensions only (no auto attendant is played)
If you don‘t want the auto attendant to answer calls on this line, select 
this option. All the local extensions are set to ring immediately during 
an inbound call by default. No call cascade actions (i.e. voicemail) can be 
performed if you select this option. 

Select the local extensions you would like to ring. If you require certain 
extensions to ring in a sequence (i.e. one extension rings first, then 
another one on the second ring), click the Adjust Sequence button to 
configure. 

Go to voice mailbox
If you do not want to use an auto attendant but want the call to go to a 
voice mailbox, select the appropriate mailbox. The caller always hears 
one more ring than the number of rings you select. TalkSwitch uses the 
first ring to determine the ring type and to support Caller ID information. 

Adjust Sequence... (button)
This section controls how the extensions will ring before the auto attendant 
answers the call. 

• If you have chosen the auto attendant to answer calls immediately, this 
section does not require configuration and is grayed out. 

• If the auto attendant is set to answer after 1 or more rings, configure 
when specific extensions ring before the auto attendant answers.

• If no auto attendant is selected to answer on the specified line, specify 
when particular extensions will ring up to 9 times. Remember 
that no calls go to voicemail unless you first have an auto attendant 
answer.

If you call on any line, TalkSwitch answers after 15 rings with a generic 
auto attendant so that you can still access the system to make 
configuration changes, change modes, access voicemail or dial extensions.

Remember: Callers are only directed according to settings for an auto 
attendant. Calls do not follow the call cascade settings of any of the local 
extensions programmed to ring before the auto attendant answers.
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2.4.4 VoIP Numbers

This section deals with how VoIP-enabled units handle incoming VoIP calls. 
For information on VoIP-enabled numbers, please refer to Chapter 5: VoIP 
Information on page 155.

1. Select a VoIP number to configure. 

2. Select the mode for which you want TalkSwitch to use these settings. 
If you entered the phone number in System Information -> 
VoIP Numbers, the number will display on the corresponding button.  

Figure 89: VoIP numbers 

Descriptions for VoIP numbers and telephone lines on the features below are 
the same.

Ring extensions only (no auto attendant is played),

Play auto attendant or Go to voice mailbox and

Adjust Sequence... (button)

This section controls how the extensions will ring before the auto attendant 
answers the call.

• If you have chosen the auto attendant to answer calls immediately, this 
section does not require configuration and is grayed out.

• If the auto attendant is set to answer after 1 or more rings, configure 
when specific extensions ring before the auto attendant answers.

• If no auto attendant is selected to answer on the specified line, specify 
when particular extensions will ring up to 9 times. Remember that no 
calls go to voicemail unless you first have an auto attendant answer.



2.4.5 Call Cascade

2.4.5.1 Local extensions

The call cascade feature lets you control routing options for each call to 
local, remote or ring group extensions. 

This section shows how to configure the incoming call cascade options for 
the local extensions. The call cascade routing options are engaged if the 
extension is selected by the caller, or if a call is manually transferred to the 
extension. Once a call enters an extension‘s call cascade sequence, the 
extension directs the call. It does not follow any other extension‘s options, 
even if that extension is selected in the cascade sequence. What you see in 
an extension‘s cascade sequence is exactly what you’ll get. You can set up 
the call cascade sequences differently for each scheduling mode. 

You can customize each extension individually with a wide array of features. 
It is possible to configure up to three levels of call cascade for each 
extension.

Example: If a call reaches your desk and you are away, you can have the call 
sent to a partner at another local extension. If the partner’s extension does 
not pick up, the call could be routed to your cell phone. If your cell phone is 
turned off, the call can be returned to your office voicemail.

Start with the steps below. You can modify the call handling options any 
time. The examples in 2.4.5.4 Call cascade examples on page 97 provide a 
starting point.

1. Select Call Handling -> Local Extensions. 

2. Select the local extension for which you want to set up call cascade.

3. Select one of the two modes. Call handling can be set up differently 
during business hours and after hours.

4. Click on the tab to modify the call handling options for the given 
situation (e.g. when extension is Busy or No Answer, etc.) 
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Figure 90: Local extension call cascade

If a call is transferred manually to a local extension that is busy, TalkSwitch 
follows the call cascade options for that extension.

There are four different call cascade situations for local extensions. 

1. Busy  
2. No Answer 
3. Answered 
4. Do Not Disturb

For each of these situations, three cascade destinations are available to 
control how you want to handle the incoming call to the extension. 

1. Busy tab

Cascade options for forwarding calls: 
• go to voice mailbox 
• go to local ext. 
• go to remote ext. 
• go to ring group 
• play announcement 
• invoke Call Waiting 
• go to auto attendant 
• queue call 
• play busy tone 
• hang up
• go to VoIP location 
T A L K S W I T C H  C O N F I G U R A T I O N                                                 9 1



For more information on these features, see Using TalkSwitch on page 117. 

2. No Answer tab 

Select the number of rings and select one of the actions. The action drop-
down list is the same as for the Busy tab except that play busy tone is 
replaced by keep ringing and there is no invoke Call Waiting and queue 
call.

3. Answered tab 

Select play caller‘s name first to prompt callers to record their name at 
the auto attendant. When you answer the call at the extension, the 
caller’s name is announced.  At this point, you can accept the call by 

pressing  or reroute the call to the cascade options on this tab by 

pressing  or by hanging up. 

Routing/forwarding options for rejected calls: 

• go to voice mailbox 
• go to local ext. 
• go to remote ext. 
• go to ring group 
• play announcement 
• go to auto attendant 
• hang up
• go to VoIP location 

4. When Do Not Disturb is enabled, you will hear: “Do not disturb on” before 
the dial tone as a reminder that calls will not ring at your extension. 

#

*
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2.4.5.2 Remote extensions

Remote extension call cascade works principally the same way as the local 
extension call cascade. Please refer to 2.4.5.1 Local extensions on page 90. In 
step 1, select Call Handling -> Remote Extensions.   

Figure 91:  Remote extension call cascade

For remote extensions, there are three different call cascade options. For 
each of these options, you can control how you want to handle the 
incoming call to the extension. 

The remote extension call cascade does not have a Do Not Disturb option.

1. Busy tab 

Cascade options for forwarding calls: 
• go to voice mailbox 
• go to local ext. 
• go to remote ext. 
• go to ring group 
• play announcement 
• go to auto attendant 
• play busy tone  
• hang up
• go to VoIP location 

For more information on these features, see Using TalkSwitch on page 117. 

2. No Answer tab — routing options if this extension is not answered 
after a specified number of rings
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Select the number of rings and select one of the actions. 

The action drop-down list is the same as for the Busy tab except that the 
option play busy tone is replaced by keep ringing and there is no queue at 
ring group option.

3. Answered tab — routing options when this extension answers or rejects a 
screened call

Selecting play caller‘s name first prompts callers to record their name at 
the auto attendant. When you answer the call at the extension, the 
caller’s name is announced. At this point, you can accept the call by 

pressing  or reroute the call to the Cascade options on this tab by 

pressing . If you hang up or do not answer, the call will be routed to 
this cascade but it may take several seconds more for the system to 
redirect the call.

Routing/forwarding options for rejected calls: 

• go to voice mailbox
• go to local ext. 
• go to remote ext. 
• go to ring group 
• play announcement 
• go to auto attendant 
• hang up
• go to VoIP location

If you select stay connected, the call cascade options are grayed out. 
TalkSwitch can forwarded calls when prompting is enabled. If you use 
one of the prompted methods for this remote extension, enable Music on 
Hold and do not use 3-way calling to forward calls to this remote 
extension, the call cascade is seamless to the callers. They hear music 
throughout the entire process of trying to locate you. 

 

For remote extensions it is very important to allow enough time for the 
telephone network to connect to the phone. For example, a call to a cell 
phone or PDA may take 12 seconds (i.e. 2 rings) just to connect.

If a call is forwarded to a remote extension from a call cascade sequence 
and has play caller‘s name first or play accept/reject prompt enabled, the 
remote extension hears: “This is Call Cascade...” instead of “This is Call 
Forward...”. This indicates to you that the call is rejected and sends the 
caller to the next call cascade option of the extension that forwarded the 
call. It does not follow the remote extension‘s answer call cascade options.

#

*
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2.4.5.3 Extension ring groups call cascade      

Extension ring groups — call cascade is similar to local and remote call 
cascade. For more information, see 2.4.5.1 Local extensions on page 90 and 
2.4.5.2 Remote extensions on page 93.

The call cascade routing options are engaged if the ring group is selected 
from the auto attendant or if a call was transferred manually to the ring 
group. Once a call enters a ring group‘s call cascade sequence, the ring group 
directs the call. It does not follow any other extensions options, even if that 
extension is selected in the call cascade sequence. What you see in a ring 
group‘s call cascade sequence is exactly what you’ll get.    

Figure 92: Extension ring group call cascade

For ring groups, like for remote extensions, there are 3 different call cascade 
options. For each of these options, you can control how to handle the 
incoming call to the extension. 

1. Busy tab — routing options when this extension is busy 
Cascade options for forwarding calls: 
• go to voice mailbox 
• go to local ext. 
• go to remote ext. 
• go to ring group 
• play announcement  
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• go to auto attendant 
• queue at ring group
• play busy tone (example, if a fax machine is at the extension) 
• hang up
• go to VoIP location 

For more information on these features, see Using TalkSwitch on page 117. 

2. No Answer tab — routing options if this extension is not answered 
after a specified number of rings

Select the number of rings and select one of the actions. The action drop 
down list is the same as for the Busy tab except that the option play busy 
tone is replaced by keep ringing.

3. Answered tab — routing options when this extension answers or rejects a 
screened call

Select play caller‘s name first to prompt callers to record their name at 
the auto attendant.  When you answer the call at the extension, it 
announces the caller’s name. At this point, you can accept the call by 

pressing  or reroute the call to the Cascade options on this tab by 

hanging up or pressing . 

Routing/forwarding options for rejected calls: 

• go to voice mailbox 
• go to local ext. 
• go to remote ext. 
• go to ring group 
• play announcement 
• go to auto attendant 
• hang up
• go to VoIP number 

#

*
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2.4.5.4 Call cascade  examples

If my extension is busy

Figure 93: Example 1 — Extension busy

If I am away from my desk

Figure 94: Example 2 — Away from the desk

Screening calls from a remote extension

Figure 95: Example 3 — Screening calls
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If I don’t want to be disturbed (only local extensions)

Figure 96: Example 4 — Do not disturb

2.5   CALL BACK/CALL BRIDGE

Call Back and Call Bridge work together as your personal long-distance 
operator. Whether you are across town or around the world, you can place 
calls from your office telephone or VoIP number(s) and access your 
long-distance savings plan. 

You can make a direct call to TalkSwitch, activate call bridge and dial the 
telephone number you want. TalkSwitch dials the number from your office 
telephone or VoIP trunk and connects the call you made to TalkSwitch and 
the call TalkSwitch made from your office to the dialed party. 

Two call back methods
• Auto Call Back lets you program the number where you can be reached as 

the call back number when you travel. Once you are at your destination, 
you can call your TalkSwitch location, let it ring twice and hang up. 
TalkSwitch will call you back.

• Prompted Call Back lets you change the call back number and message 
each time you initiate the call back. If you are traveling to more than 
one destination, or you don't know the telephone number, you can 
change the call back number once you arrive at your destination.

How it works
1. From your out-of-office location, dial one of the call back telephone 

numbers that you have pre-configured on your TalkSwitch unit.

Figure 97: Dial your own number

TalkSwitch

in your office

Any phone

anywhere

Dial your own phone number
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2. Let the line ring at least once, but no more than three times and hang 
up. Make sure there is no auto attendant configured to answer after less 
than 3 rings on this line.

3. Within less than 10 seconds, TalkSwitch will dial your auto call back 
number. When you pick up, your recorded message will play.

Figure 98: TalkSwitch calling back

4. Accept the call by pressing . Enter your password. This confirms to 
TalkSwitch that you are an authorized user and enables call access 
through the TalkSwitch.

5. You will now hear a generic TalkSwitch auto attendant. You may access 
your phone system as if you were in the office. Dial 9 for an outside line 
and make a long-distance call using your office long-distance plan, listen 
to your voicemail or transfer to a local extension.

Figure 99: Multiple calls to anywhere

2.5.1 Auto call back

The TalkSwitch call back/call bridge feature gives you access to your office-
based long-distance savings plan from anywhere around the world. 

Before call back is activated, all the call back settings must be configured. 
To use auto call back, dial your office telephone number, let the call ring 
twice and hang up. 

You can configure four auto call back numbers.

1. Select Call Back/Call Bridge -> Auto Call Back. 

2. Select Call Back 1. You can add more as needed.

TalkSwitch

in your office

TalkSwitch calls you back
Any phone

anywhere

#

Dial any 
extension

or

or

Make multiple calls to 
anywhere in the world

Access any 
mailbox

Any phone

anywhere
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3. Click the checkbox next to Activate Auto Call Back 1. In the field Number 
to call back:, enter the call back number exactly as you would normally 
dial the number. Do not enter a line hunt group in the dialing string.

4. Click the checkbox next to Use dialing prefix:, if you have to dial the 
same prefix every time you use auto call back (i.e.  long-distance calling 
card number).  Enter the dialing prefix including any required pauses or 
feature keys like  or . Use a comma to insert a 2-second pause. 

Example: If you want to disable call waiting and want to dial a long-
distance prefix before dialing the long-distance number, enter the 
following: *70,1010555,,. This corresponds to  70 for disabling the 
call waiting feature, a 2-second pause to wait for the new dial tone, 
1010555 for the long distance prefix, and a 4-second pause to wait for 
the new dial tone before dialing the long-distance phone number. 

Use Announced Message: 
We recommend this option if the number TalkSwitch calls back is to a 
hotel or a location where a third party answers the call. The Announced 
Message option allows you to record a message that plays when the call is 
initially answered during a call back. 

Example: “Please transfer this call to Bob in room 307”. The announced 
message can be recorded locally using an extension handset, or remotely 
by accessing call back from the auto attendant. The Record Message 
button gives the following instructions:

5. Pick up a telephone handset connected to the unit and use the keypad 
commands to record the announced message.

a) Press  on an analog phone, or 55 on a IP set to enter 
command mode. Enter the password if required.

b) Enter the appropriate command as listed below. 

For auto call back Record message Play message back

1 61 71 

2 62 72 

3 63 73 

4 64 74 

There are four auto call back accounts per unit. If you need to record an 
announced message for a particular auto call back account, it must be on 
the same unit as the account.

* #

*

# *

# #

# #

# #

# #
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6. In the field next to Number used to trigger Auto Call Back:, enter the 
home/office number that you will call to trigger the auto call back. The 
drop-down list allows you to select any of the telephone lines connected 
to your unit.  

Figure 100: Configuring auto call back

7. To prevent unauthorized use of your call back feature, click the checkbox 
next to Use password on Call Back and enter a password.

8. Click the checkbox next to Allow Call Bridge, to allow call bridge after a 
call back has been accepted. You may restrict the call bridge line access 
by selecting the Hunt Group Access button. Call bridge is enabled when 
call back is activated with the same password you entered at the auto 
attendant.  

If you need to configure and/or record an announced message from a 
remote location and do not have the auto attendant set up to answer this 
call back line, you can call your call back number and let it ring 15 times. 
A generic auto attendant will answer. You can then configure call back by 
pressing 6.

For a 2-second pause, dial  0 and for a , dial  . When you 

have completed the entire dial string, press .
* # * #

#
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2.5.2 Prompted call back

Prompted call back works much the same way as auto call back, except that 
you can change the call back number remotely. The call back number is 
stored in TalkSwitch until you change it. This means that you can change 
your call back telephone number and message each time you activate call 
back. 

If you are travelling to a location where you do not yet know the phone 
number, you can use prompted call back to save on your long-distance 
charges. For details on using call back, see 3.11.2 Using call back on 
page 145.

Figure 101: Configuring prompted call back

1. Select Call Back/Call Bridge -> Prompted Call Back.

2. Click the checkbox next to Activate Prompted Call Back.

3. Enter the number TalkSwitch will call (e.g. your hotel telephone 
number). If you require a dialing prefix or long-distance discounts, check 
the Use dialing prefix box and enter the prefix.

4. If you expect the call back from TalkSwitch to be answered by a 
receptionist before it gets to you, you can have the unit play a recorded 
announcement when someone answers the call back. This is useful if you 
need the call transferred to a hotel room. The message could say: “This is 
a call for Bob in room 587. Please transfer the call”. 

You need to activate prompted call back before you can use this feature. 
The call back out of the system to the number programmed always uses 
the same line that was dialed.
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Accessing and using prompted call back from a telephone 

1. Dial your office telephone number. 

2. At the auto attendant, dial 6 to access the call back settings.

3. Follow the prompts.

a) Enter the telephone number where you would like TalkSwitch to call 
you. 

b) Record an announced message if required. Call back is activated right 
after you initiate prompted call back and hang up. A small initial 
long-distance charge is incurred at your current location when you 
activate prompted call back. 

Press  on an analog phone or  55 on a IP set to enter 
command mode. Enter the password if required.

Enter the command as listed below.      

2.5.3 Call bridge

Call bridge allows you to use the TalkSwitch phone lines to make outbound 
calls or transfers to local and remote office extensions. It gives you access to 
your office-based long-distance savings plan from anywhere around the 
world. You will first need to call into the unit from an outside phone 
number.

When you access prompted call back from out of the office, you may 
change this number before initiating the call back. The benefit of 
prompted call back is that you do not need to set the number before you 
leave the office.

To record a message: 65 

To play the message: 75 

The call back number shown is always the last number the unit dials in 
the last prompted call back session.

# *

#

#
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Figure 102: Activating call bridge

How to use call bridge: 

1. Call into the system from any out-of-office telephone.

2. At the auto attendant message, dial a hunt group you are authorized to 
use (9 is default). 

3. Enter the password and press  to access a TalkSwitch telephone line. 
Each TalkSwitch unit has four password activated call bridge accounts. 

4. At this point, you can dial a number the same way as from the office. 
Each account can be configured to allow access to certain hunt groups 
when using call bridge. 

Figure 103: Hunt group access

To activate an account, check the Activate Call 
Bridge box and enter a 4- to 8-digit password. 
Click the Hunt Group Access button and assign 
the hunt groups for this account. 

Line hunt group 80 is used for Same Line 
Connect. To enable line hunt group 80, click the 
checkbox next to Allow the use of Same Line 
Connect [by dialing 80].

#
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2.6  OPTIONS

2.6.1 Permissions

You can grant permissions to selected extensions to access outside lines.

To add permissions for users:
1. Select Options -> Permissions.

2. Click in the checkboxes next to the extensions that are permitted access.

3. Click Add User... See Figure 105 on page 106 and Figure 106 on 
page 106.

Figure 104: Permissions to access outside line
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Figure 105: Add user

4. Select a user fron the list or enter the name of the user in the 
Name: field.

5. Assign a unique 4- to 8-digit access code in the Access Code: field.

To remove a user from the permissions list: 
1. Select the user and click Remove.

To modfy a user’s name or access code:
1.  Select the user and click Modify.

Figure 106: Modify user access

2. Modify the Name: and/or Access Code: fields as needed.

3. Click OK.
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2.6.2 Audio Controls 

This section deals with the adjustment of volume and system gain controls. 
All the controls on this page update the unit in real time. This allows you to 
adjust levels during a conversation without having to first save the 
configuration to the unit.       

Figure 107: Adjusting audio controls

Line Controls

If you need to adjust the volume of conversations through the system, you 
can adjust each line individually. The default settings compensate for loss 
created by TalkSwitch and a portion of the loss created by your lines. We 
recommend that you adjust the level for each line separately, as the 
characteristics of each line may vary. These controls only affect the volume 
heard by the caller. 

Extension Controls

These controls allow you to increase or decrease the volume level of calls 
and system prompts heard at each extension.



2.6.3 Transfer Options 

This section describes the TalkSwitch actions when calls are transferred 
manually.    

Figure 108: Transfer options

Transferring a caller to a local or remote extension or a ring group
You can specify how transferred calls are handled if their target is a local 
extension, remote extension or ring group. If the extension is busy or 
doesn‘t answer, you have the choice to have the unit ring back the 
extension that transferred the call or perform the no answer or busy action 
of the extension that the call was intended for. Any changes made in this 
section affect the entire system.

Transferring from a home phone
You can transfer a call from a phone connected in parallel to one of the 
incoming TalkSwitch lines. 

Example: You can transfer a call from your home phone (for a home-based 
business) to a local or remote extension, ring group, an announcement or a 
voice mailbox. 

This section allows you to choose which transfer prefix you would like to use 
to perform the action. The transfer prefix wakes up TalkSwitch and is 
considered the equivalent of the Flash or Link action at a local extension. 
The default prefix is  . * *
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Example: You receive a call on a phone in your home that is not a 
TalkSwitch extension and you want to transfer the caller to remote 
extension 215. You dial  , wait for the double beep, dial 215 and 
hang up. TalkSwitch now handles the call.

Transfer and clear
TalkSwitch has the ability to clear lines after a call has been transferred. 
Ensure you have this service/feature activated on your line(s). Check under 
System Information -> Telephone Lines.

Remote transfer
Calls that are transferred to a remote or VoIP extension can be transferred 
back to another extension or voice mailbox. 

1. Dial   to place the caller on hold.

2. Enter the extension or mailbox number. If the extension is set to 
screening calls, dial   4 to complete the transfer. If you want to 
cancel the transfer, dial  5. If you have selected Perform a blind 
transfer, the call is automatically transferred and the line is released once 
the extension or mailbox number has been entered. 

When a call is transferred from one remote extension to another remote 
extension or VoIP extension, it is always a blind transfer so that the three 
lines are not tied up.  

This feature can only be used when forwarding a call to a remote 
extension or a VoIP location over two lines. It cannot be used with 
3-way calling or Centrex transfer services.

* *

* *

* *
* *
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2.6.4 Miscellaneous

All of the following options affect TalkSwitch as a system. Adjust them 
according to your needs.     

Figure 109: Miscellaneous

Caller in queue reminder 
When a caller is in queue at an extension that is already in use, a reminder 
tone plays at the extension to let them know they have a caller in their 
queue. You can turn this function off by clicking the Off radio button.

Call Back ring return
You can adjust the number of rings during a call back session before 
TalkSwitch disconnects from call back. Depending on the situation, you may 
want to give yourself more time to pick up and accept the call back by 
increasing the number of rings.

If being used with another PBX

PBX extension length
If TalkSwitch is used as an auto attendant with another PBX, you can set the 
number of digits the PBX uses for its extensions. This allows TalkSwitch to 
know what digits to pass on to the PBX to complete the transfer. 

This feature only works with PBXs that use hook flash as a transfer 
method. Please contact your PBX manufacturer for transfer details.
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Setting up TalkSwitch behind an existing PBX 

1. Connect the PBX extension to one of the TalkSwitch line jacks. You may 
do this with all your TalkSwitch lines (1 PBX extension per line) 
depending upon how many auto attendant ports you would like on 
the PBX.

2. Configure incoming calls on your PBX to ring the extensions you have 
allocated to the TalkSwitch lines.

3. Configure the TalkSwitch auto attendants to answer after a specified 
number of rings.

4. Record your auto attendants. They should list the extensions with the 
digit 7 in front of them.

Example: If you have chosen the PBX extension length to be 3 digits and 
John Smith’s extension is 111 on the PBX, the auto attendant should say: 
“To speak with John Smith, press 7111…”. When 7111 is dialed, TalkSwitch 
puts the caller on hold and transfers the caller to extension 111.

Intercom Calls
This setting is enabled by default. Any internal call follows the cascade 
settings of the extension dialed. If it is disabled, no fall-through actions 
take place.

Fax Over IP

TalkSwitch 48-CVA supports fax detection and switching to G.711 for 
transparent fax over IP.

Internal clock setting
TalkSwitch can obtain time information from Caller ID for its internal clock. 
If you have indicated that you do have Caller ID on any of the lines, this 
option defaults to the active position. If it is de-activated, TalkSwitch 
obtains the time information from the time and date set in the Mode tab 
under Automatic Mode Switching. The TalkSwitch clock information is used 
for automatic mode scheduling and for internal Caller ID information when 
intercom calls are placed in the office.

Internal Caller ID options
TalkSwitch can display name and number Caller ID to each extension during 
intercom calls. If your Caller ID unit/telephone does not support the name 
option, you can have TalkSwitch send the number only.

Audio Output Options
TalkSwitch can output different audio to the PA jack. The default setting is 
to play only PA announcements through the PA jack by dialing  0 from 
any extension.

*
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Other options include:
• Voicemail Screening (used in a home environment) 
• Demo with a router (used for demonstrating the product) 
• Static VoIP Demo (used strictly for demonstrating two TalkSwitch CVA 

units connected to a hub or a switch and acting as two separate 
locations.

Auto Attendant Transfer Prompts
TalkSwitch can disable playing of transfer prompts to callers when 
redirecting calls from the auto attendant.

SIP Server Registration
Select the Re-registration Interval between 2 and 60 minutes from the drop-
down list. The re-registration interval on your IP phones may differ, but 
TalkSwitch will use the time specified here. See Figure 109 on page 110.

2.6.5 Troubleshooting 

Do not change the following controls unless you are familiar with the effect 
they have on the TalkSwitch operation. If your system does not appear to be 
functioning properly, please contact your dealer for assistance.

Figure 110: Troubleshooting

Flash lengths
Accepted Flash length:
These options control the flash length allowed from a local extension 
that TalkSwitch considers to be an intentional flash. The range can be 
adjusted to accept anything from 300 ms to 1 second. The default range 
for accepting a flash signal at a local extension is between 400 ms and 
800 ms. Most phones emit a 600 ms flash signal when the Flash or Link 
button is pressed.
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Transmitted Flash length: 
This option controls the transmitted flash length from TalkSwitch to the 
telephone company lines. TalkSwitch emits a Flash when forwarding or 
bridging calls using the 3-Way Calling/Conference or Centrex transfer 
service or when transferring calls through an existing PBX system. The 
value can be adjusted from 250 ms to 1 second. The default setting is 
400 ms. If you notice that you are having problems with any of the 
TalkSwitch features that use 3-way calling, experiment with this value.

Double Flash time
When two flashes are detected, TalkSwitch needs to calculate the time 
between the flashes to establish if they were intended to propagate a flash 
at the central office (CO) or to place a call on hold and then quickly retrieve 
it. The Double Flash time values signify the maximum time between two 
flashes that TalkSwitch recognizes as an intended flash to the CO. When two 
flashes are detected with a time gap larger than the value displayed, no 
flash is propagated at the CO. The value can be adjusted from 200 ms to 2000 
ms with the default set at 1200 ms.

3-Way Calling wait time
This option adjusts the time required between hook flash and a dial string. 
Some telephone company 3-way calling/conference services require 
different time allowances after the flash signal to re-establish a dial tone. 
The default time is two seconds, so TalkSwitch can let the lines settle after 
going off-hook before sending the DTMF digits.

Ring Patterns
Click the Check Ring Pattern... button and call any extension. After three 
rings the sequence of the ring pattern displays in a new window. The time is 
displayed in milliseconds. 

Non-detection of disconnect-clear
This option controls the length of time after which TalkSwitch drops a line 
when silence is heard. This safeguard is useful when a telephone line does 
not send out the disconnect-clear signal that tells TalkSwitch the call is 
completed. 

Auto Attendant Adjustments
Since TalkSwitch allows callers to dial 100, 200, 300 series extensions, 400 
series mailboxes and allows fall-through options for the single digits 1, 2, 3, 
4 and 5 at the auto attendant, there needs to be a time limit on how long 
TalkSwitch waits for another digit before following the single-digit option 
after the first digit is pressed. There are three ways to make use of this 
control. Be careful not to isolate your callers from having both choices as 
listed in (1). 
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1. With the current setting, callers can dial any local extension or remote 
extension or ring group, as long as the second digit is pressed within 1.5 
seconds of pressing the first digit. Callers can press 1, 2, 3, 4 or 5. When 
TalkSwitch detects no second digit after 1.5 seconds, it follows the 
programmed option for that auto attendant.

2. If you don’t want to use options 1, 2, and 3 for any of the auto 
attendants, you can set the option to 4 seconds. This gives callers 
enough time to dial all three digits of any extension without accidentally 
falling through to one of the auto attendant options.

3. If you don’t want to give callers the ability to dial any of the extensions 
and only permit them to access single-digit options, set this value to 
immediately. As soon as TalkSwitch detects the first digit, it will follow 
the specified option for that auto attendant.

Auto Route Selection
The Inter-Digit time-out can be set anywhere between 3 and 18 seconds. The 
default is 5 seconds.

2.6.5.1 Troubleshooting — Advanced

DTMF Detection
Should callers complain about being misdirected when they select options at 
the auto attendant, the following values need to be adjusted:

Minimum required time to detect a DTMF digit: 
The default setting of 45 ms is adequate for most environments. It may be 
necessary to lower this value if TalkSwitch appears to have trouble hearing 
digits when dialed at the auto attendant. Increase the time if the system is 
accidentally misdirecting callers.

Minimum required time between DTMF digits: 
The default setting of 65 ms is adequate for most environments. If there is a 
problem, increase the value slightly to help the system deal with echoed 
digits from cell phones. 

Example: Calls keep being misdirected to extension 111. This usually 
indicates that, even though the caller may have dialed 113, TalkSwitch sees 
1113 because the 1 was echoed by the cell phone network. Once TalkSwitch 
captures 3 digits, it ignores the rest, hence the digits 111 are accepted and 
the 3 is ignored.    
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Figure 111: Troubleshooting advanced

Line CPC/Disconnect Clear 
If calls are accidentally disconnected in mid conversation, it usually 
indicates a problem with the telephone line. TalkSwitch is always looking 
for a hang-up signal, called a CPC or Disconnect Clear signal, from the phone 
company. If the line has power fluctuations or if the line card at the central 
office is defective, CPC signals in the 250 ms range might come down the 
line and cause TalkSwitch to hang up. Try increasing this value to correct 
the problem.

Ringback Control
If an extension seems to ring back as if a caller was on hold, but when 
answered, no one is there, it could indicate a debounce problem with the 
phone hook switch. When someone at the extension hangs up, the handset 
bounces slightly to cause a flash signal that can be seen by TalkSwitch 
before the hang-up. As a result, TalkSwitch puts the line on hold. To help 
with this problem, increase this value until it stops ringing back. 

Fax Detection
If fax calls are not directed to the fax machine, you may need to set this 
option to Detect 1 tone. If it is set to Detect 1 tone and people complain they 
have accidentally been routed to the fax machine, set this value to 
Detect 2 tones.
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VoIP Ports 

IP Signalling Port:
The default IP signalling port is 5060. If you need to choose another 
port, enter a value between 1024 and 16556.

Starting RTP Port:
The starting RTP port for TalkSwitch is 6000. From this starting point, 
TalkSwitch needs 4 ports for each TalkSwitch unit. RTP ports are evenly 
numbered from the start port. 6000, 6002, 6004 and 6006 are needed for 
the first TalkSwitch unit on a LAN and 6030, 6032, 6034 and 6036 are 
used for the fourth unit.

These are the ports that this TalkSwitch system listens on as opposed to the 
port it needs to communicate with at the other end. 

Example: If your IP server at another location uses port 5061 instead of 
5060 for signalling, you do not set this port to 5061, you need to include 
the port number in the address specified in the VoIP Configuration section 
of the software.

Example: Proxy Server Name: 222.234.432.234:5061
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C H A P T E R  3
CH AP TE R 3:  USING TA LKSW ITCH

USING TALKSWITCH

3.1  IN THE OFFICE — RECEIVING CALLS WITH OR 
WITHOUT THE AUTO ATTENDANT

3.1.1 Receiving calls using the auto attendant

If you don’t have a receptionist, the auto attendant helps you handle all 
your inbound calls. Once an auto attendant has been configured and 
recorded, it will follow the instructions given in the configuration. For 
details on adding and configuring auto attendants, see 2.4.2 Auto attendant 
on page 80 and its subsections. 

When calls are answered by an auto attendant, callers can: 

• Dial any local or remote extension
• Dial any VoIP number (250–299)
• Dial any ring group (300–309)
• Dial voicemail directly
• Use a dial-by-name directory
• Choose options 0, 1, 2, 3, 4, 5 (if configured to perform specific actions)
• Transmit a fax
• Go to a different auto attendant
• Remain on the line to follow an action programmed for that auto 

attendant

TalkSwitch owners and employees can access other options at the auto 
attendant:

• Call back or call bridge 
• Retrieve voicemail 
• Enter command mode to make system changes 
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All these features can be password-protected to avoid unauthorized access.

TalkSwitch also provides the option of ringing specific extensions or ring 
groups prior to the engagement of an auto attendant. For details about 
configuring auto attendants, see 2.4.2 Auto attendant on page 80.

3.1.2 Receiving calls without the auto attendant

If you do not use the auto attendant to answer calls, please note that the 
call cascade options for the local extensions are not engaged. For calls to go 
to an extension’s mailbox, the call must be transferred manually by someone 
in the office. Once calls have been answered at a local extension, they can 
be transferred to any extension or voice mailbox. 

3.2  IN THE OFFICE — MAKING AND RECEIVING CALLS 
USING AN ANALOG PHONE

3.2.1 Making calls from a local extension without direct line access

Place intercom calls from one local extension to another local 
extension, remote extension or extension ring group
You can place intercom calls from one local extension to another local, 
remote or VoIP extension or to a ring group.

1. Pick up your extension’s handset.

2. Dial the number of the extension you want to intercom to. An intercom 
call is identified by two short rings. 

If you are using an IP phone, see 3.3 In the Office — Making and receiving 
calls using an IP phone on page 126 and following pages. The difference 
between a regular and an IP phone is the size of the jack. Regular phones 
use regular, RJ-11 phone cables. IP phones take RJ-45 (Cat 5) cables for 
networking. 
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Place out-of-office calls from a local extension 
1. Press 9 or 81–88 to choose a hunt group at the internal dial tone. This 

hunt group gives you access to an available line to dial out.

2. If your system requires permissions for outgoing calls, enter your 
access code.

3. Dial the phone number. 

Restrictions
You can set restrictions to specific hunt groups for each extension. Your 
extension can also be configured to access a line directly. When you pick up 
a handset, you hear the telephone company dial tone and can dial an 
outside number as usual. 

3.2.2 Receiving calls at a local extension 

The steps below apply when a regular extension is ringing. If an auto 
attendant engages before you are able to pick up, the caller can select an 
option at the auto attendant. 

1. Pick up the extension’s handset. 

2. If the call went through the auto attendant and call screening is enabled 
in Call Handling -> Local extension and Extension Ring Groups:

a) Press  to accept the call.

b) Press  to re-route the call to its extension‘s call cascade options. 

c) Hang up.

Exceptions: For a remote extension intercom call, the phone rings as 
usual. If a ring group has a different ring pattern, intercom calls follow 
the cascade settings of the extension dialed. You can enable this feature 
in the configuration software under Options -> Miscellaneous.

You can perform intercom paging and activate the speakerphone at other 
local extensions that have TS-80, TS-200, TS-400 or TS-600 phones. To 
place an intercom call to one of these phones, dial  84 and the local 
extension at the TalkSwitch dial tone. 

If you have Direct Line Access enabled for a local extension, you need to 
dial Flash before dialing local extensions or voice mailboxes.

If you dial your own extension you will be directed to your voicemail. If 
your voicemail is not set up, you will get a busy signal.

*

#

*
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You can intercept a call that is ringing at any other local extension. 

1. Pick up your handset.

2. At the TalkSwitch internal dial tone, dial  9. This routes the call to 
your local extension. 

You can answer a call ringing at a specific extension. 

1. If you know the extension that is ringing, dial  7 and the extension 
number (i.e.  7112 to pick up a call ringing at extension 112). 

2. If you are in the middle of a call and want to connect to another 
incoming caller, press Flash to place the first caller on hold.

3. Dial  9 or  7 and the extension number to connect to the second 
caller. 

4. Once you are finished with the second call or would like to return to the 
first caller, press Flash 5. 

3.2.3 Placing calls on hold at a local extension

Place calls on hold
1. Press Flash (on the TalkSwitch TS-80, TS-200, TS-400 or TS-600 phones). 

2. Press Flash again to take callers off immediate hold.
If you have multiple callers on hold or in queue at your extension, press 
Flash 7 to retrieve callers on a first in/first out basis.

3.2.4 Transferring calls from an extension 

3.2.4.1 Unscreened transfer

You can initiate an unscreened transfer from a local extension to another 
local extension, remote extension or extension ring group.

1. Press Flash to put the caller on hold. 

2. Dial the extension you want to transfer to and hang up. The caller is 
taken off hold when the receiving extension answers. If the transferred 
call is busy or not answered after the number of rings specified in the No 

If you press Hold on a regular, analog phone, you won’t be able to access 
any of the TalkSwitch features while the caller is on hold. If you have 
music on hold enabled, the caller does not hear music while on hold.

*

*
*

* *
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Answer setting, or if the extension is busy, one of the following will 
happen:

3.2.4.2 Screened transfer 

You can initiate a screened transfer from a local extension to another local 
extension, remote extension or extension ring group.

1. Press Flash to put the caller on hold and dial the appropriate extension 
number. 

a) If the person at the receiving extension wishes to take the call, hang 
up or dial Flash 4 to complete the transfer. The caller is immediately 
taken off hold and connected to the receiving extension. You hear an 
internal dial tone. 

b) If the person at the receiving extension does not wish to take the 
call, press Flash 5 to return to the caller. 

c) If you dial an extension that is busy or not answered, you can 
complete the transfer so that the call is routed according to that 
extension’s call cascade settings. 

3.2.5 Transferring calls from a local extension to an external phone

Unscreened Transfer
1. Press Flash to put the caller on hold.

2. Select a hunt group (dial 80 for Same Line Connect). 

3. Dial the outside telephone number.

Default: The transferred call is handled according to the destination 
extension’s No Answer or Busy settings. 

Option: The call is transferred back to the transferring extension. 

The option can be altered under Options -> Transfer Options in the 
configuration software.

If you handle many calls, you may want to complete or cancel a transfer 
without hanging up. Flash 4 will complete the transfer and provide an 
internal dial tone. Flash 5 cancels the transfer and connects you back to 
the caller.
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4. Press Flash 4 to complete the transfer. Do not hang up to complete the 
transfer because this disconnects the call. 

Screened Transfer
Instead of completing the transfer once you have dialed the outside 
number, wait until the call is answered and ask the recipient at the 
extension if he or she wishes to take the call. If the recipient accepts the 
call, press Flash 4 to complete the transfer, if not, press Flash 5 to return to 
the caller.

3.2.6 Parking and retrieving calls at a local extension

Call park is a feature for placing a call on hold and then retrieving it from 
another local extension. TalkSwitch has 10 park orbits (500–509).

3.2.6.1 Parking a call 

1. Press Flash and  510. TalkSwitch selects the first available park orbit 
(500–509). If you use a TS-80, TS-200, TS-400 or TS-600 phone, press the 
Park button or softkey.

2. You hear a confirmation indicating that the caller has been parked 
successfully and into which park orbit.

3.2.6.2 Retrieving a parked call at another local extension

The person who parked the call notifies the person at the extension for 
whom the call is parked (e.g. “Mary, there is a call parked for you in 500”). 

1. Press   and the appropriate park orbit. If you use TS-80, TS-200, 
TS-400 or TS-600 phone, press the Un-park button or softkey and enter 
the park orbit. If Direct Line Access is enabled at the extension, you must 
press Flash first.

If you have the 3-way calling/conference or a Centrex transfer feature 
enabled on the current line, select the Same Line Connect (80) to make 
use of these features. Everything proceeds as above on the same line the 
call came in. 

If Direct Line Access is enabled at your extension, press Flash before 
retrieving the parked call.

*

* *
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3.2.6.3 Using call park with the paging option

If the external paging option is enabled on TalkSwitch, you may choose to 
announce a parked call over the PA system by pressing  0. (e.g. “Mary, 
please pick up 501.”). This tells Mary that she can retrieve the parked call 
from any extension by pressing   501 at the dial tone. 

If you have a combination of TS-80, TS-200, TS-400 and TS-600 phones in 
the office, you can page an individual extension or a ring group (i.e press 

 85, the Page button or softkey and the extension or ring group 
number).

3.2.7 Queuing and retrieving callers 

The following sections describe Uniform Call Distribution (UCD). This 
includes features like call queuing, call waiting, conference calling, etc. 

Call queue is a useful feature for placing multiple callers on hold at your 
extension while you are on an existing call. For details on configuring call 
queue, please refer to Call Handling in section 2.4.5 Call Cascade on page 90.

3.2.7.1 Queuing calls to a single extension 

If an extension is busy and has queue call set for the Busy call cascade, 
incoming callers hear one of the prompts below, followed by music (if 
enabled) while they are on hold:

If the call came from the auto attendant and the extension has a 
voice mailbox:
“The extension you have reached is currently busy. If you wish to continue 
holding, please remain on the line. To leave a voicemail message, press 1, and 
to return to the main menu, press star.”

If the call came from the auto attendant and the extension has no 
voice mailbox:
“The extension you have reached is currently busy. If you wish to continue 
holding, please remain on the line. To return to the main menu, press star.”

If the call was transferred from another extension and the extension 
has a voice mailbox, but there is no auto attendant on this line with a 
main menu to return to:

If Direct Line Access is enabled at your extension, press Flash before 
retrieving the parked call.

*

* *

*
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“The extension you have reached is currently busy. If you wish to continue 
holding, please remain on the line. To leave a voicemail message, press one.”

If the call was transferred from another extension and the extension 
has no voice mailbox and there is no auto attendant on this line with a 
main menu to return to:
“The extension you have reached is currently busy. If you wish to continue 
holding, please remain on the line.”

While the caller is on hold at your extension, you hear a call waiting beep 
every 75 seconds. If you want to rotate through queued callers, dial Flash 7. 
The caller you are speaking to is placed on hold, and the first caller in the 
queue is retrieved. If you have multiple callers queued, press Flash 7 to 
retrieve callers on a first in/first out basis.

If call waiting is enabled for the Busy action of a local extension, callers 
hear ringing (or music if enabled) while the local extension hears a call 
waiting beep and receives the caller ID for the new call. To connect to the 
new caller, press Flash 7. To let the caller fall through to the next level of 
the cascade, ignore the beep.

3.2.7.2 Queuing callers to an extension ring group

If you want to queue callers to a ring group, configure this action using an 
auto attendant. This feature is also referred to as automatic call 
distribution. 

Example: Configure auto attendant 1 to queue callers to ring group 301 for 
technical support if they have pressed 5. When a caller presses 5 for 
technical support, they enter the queue immediately. Every 60 seconds the 
caller hears the following prompt: “Your call is important to us. Please 
remain on the line. To return to the previous menu, press .” Extensions 
that are part of the ring group and are available will start ringing within 10 
seconds of hanging up the phone from a previous call. The delay allows time 
to make a new call or activate Do not Disturb as a log out option. After 5 
extension rings, it will ring once every 16 seconds. When you pick up, you 
hear a prompt that provides the option to accept the queued call by pressing 

 or leave the caller in the queue by pressing  and returning to the 
dial tone to make a new call.

3.2.8 Using call waiting

The call waiting feature is activated under Call Handling -> Local 
extensions in call cascade section of the Busy tab list (invoke Call Waiting). 

*
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When the dialed local extension is busy, the caller hears ringing or music 
depending on the settings. 

If the phone supports call waiting caller ID (type II signaling), you hear a 
beep followed by a short blip. Depending on your phone, you may hear 
something similar to a modem noise. This is normal. During this 
notification, the caller ID information is displayed on the phone. The caller 
does not hear the beep. The phone mutes the other side.

If the phone does not support call waiting and caller ID, you hear a beep. 
When the call waiting notification beep is heard, the person at the 
extension can dial Flash 7 to put the current caller on hold and answer the 
new caller. He or she has the option to dial Flash 5. This terminates the 
current call and connects to the new call. If the person at the extension 
does not want to take the new call, they can ignore the call waiting beeps 
and TalkSwitch directs the caller to the next level of the call cascade for 
that extension (i.e. send the caller to the associated voice mailbox).

3.2.9 Conference calling 

You can set up conference calling between 3 local TalkSwitch extensions, 
two local extensions and one outside caller or two outside callers and one 
local extension.

3.2.9.1 Two local TalkSwitch extensions and one outside caller

You do not require access to the telephone company’s 3-way calling/
conference service to use the TalkSwitch conference calling capabilities.

1. Establish a call with an outside party.

2. Press Flash to place the outside caller on hold. Dial the number of the 
local extension you wish to conference with.

3. When the extension is picked up, press Flash 6 to establish the 
3-way call.

3.2.9.2 Two outside callers and one local extension

There are two different methods for this type of conference call. The first 
method is similar to the one above, using only TalkSwitch for the conference 
function.

1. Establish a call with an outside party.
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2. Place the outside caller on hold and dial the number of the other outside 
party. Dial 9 or another hunt group before dialing the second phone 
number unless you have Direct Line Access enabled.

3. When the call is answered, press Flash 6 to establish the 3-way call. 

The second method uses the telephone company’s 3-way calling/conference 
service.

1. Establish a call with an outside party.

2. Press Flash 80 to place the outside caller on hold and dial the number of 
the other outside party.

3. When the call is answered, press Flash 6 to establish the 3-way call.

3.3  IN THE OFFICE — MAKING AND RECEIVING CALLS 
USING AN IP PHONE

3.3.1 Making calls from a local IP extension (IP phone)

Place intercom calls from one local extension to another local or remote 
extension or to a ring group
An intercom call is usually identified by 2 short rings. The IP phones that we 
recommend support this distinctive ring feature. You can place intercom 
calls from one local extension to another local, remote, VoIP extension or 
ring group.

1. Pick up your extension’s handset and dial the number of the extension 
you want to intercom.  

The conference initiator can disengage the second conferenced party at 
any time by pressing Flash 5.

Exceptions: For a remote extension intercom call, the phone rings as 
usual. If a ring group has a different ring pattern, intercom calls follow 
the cascade settings of the extension dialed. You can enable this feature 
in the configuration software under Options -> Miscellaneous.

You can perform intercom paging and activate the speakerphone at other 
local extensions that have TS-80, TS-200, TS-400 or TS-600 phones. To 
place an intercom call to one of these phones, dial  84 and the local 
extension, then press Dial, Send or  to place the call.

*
#
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Place out-of-office calls from a local extension

1. Dial 9 or 81–88 to choose a hunt group and dial the phone number. 

2. Depending on your IP phone, press Dial, Send or . 

You can set restrictions to specific hunt groups or block certain types of 
outbound calls. Your extension can also be configured to access a specific 
line directly.

3.3.2 Receiving calls at a local IP extension

If an auto attendant engages before you are able to pick up, the caller can 
select an option at the auto attendant. The steps below apply when you pick 
up an extension that is ringing.

1. Pick up the extension’s handset. 

2. If the call went through the auto attendant and call screening is enabled 
in Call Handling -> Local Extension and Extension Ring Groups:

a) Press  to accept the call.

b) Press  or hang up to re-route the call to its extension call cascade 
options.

c) press Dial, Send or . 

You can intercept a call that is ringing on any other local extension. 

1. Pick up your handset.

2. Dial  9 and press Dial, Send or  depending on your phone. This 
routes the call to your local extension. 

You can answer a call that is ringing at another extension.

1. If you know which extension is ringing, dial  7 and the extension 
(i.e.  7112 to pick up a call ringing at extension 112). 

2. Press Dial, Send or  depending on your phone.

3. If you are in the middle of a call and want to connect to another 
incoming caller, press Hold to place the first caller on hold.

4. Dial  9 or  7 and the extension.

If Direct Line Access is enabled for a local IP extension, you need to 
press   before dialing any extensions or voice mailbox. 

#

* *

#

*

#

* #

*
*

#
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5. To connect to the second caller, press Dial, Send or  depending on 
your phone. 

6. Once you are finished with the second call or would like to return to the 
first caller, press Cancel (softkey). 

3.3.3 Hold and transfer

3.3.3.1 Hold

1. Press Hold. 

2. Press the flashing line key that corresponds to the caller on hold to take 
the caller off hold. If you have multiple callers on hold or in queue at 
your extension, you can retrieve them on a first in/first out basis.

3. Press Hold and 7, then press Dial, Send or  depending on your 
phone.

3.3.3.2 Unscreened transfer 

1. Press the Transfer or xfer key. 

2. Dial the appropriate extension number and then press the Transfer or 
xfer key. Some IP phones may support hang-up transfer. Please check the 
documentation of the IP phone to see if it supports this feature. 

The caller is taken off hold when the receiving extension answers. If the 
transferred call is busy or not answered after the number of rings specified 
in the No Answer setting, or if the extension is busy, one of the following 
applies:

3.3.3.3 Screened transfer

To initiate a screened transfer from an IP extension to another local 
extension, remote extension or extension ring group:

#

Default: The transferred call is handled according to the destination 
extension’s No Answer or Busy settings. 

Option: The call is transferred back to the transferring extension. 

The option can be altered under Options -> Transfer Options in the 
configuration software.

#
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1. Press Transfer or xfer to put the caller on hold. 

2. Dial the appropriate extension number. 

a) If the person at the receiving extension wishes to take the call, press 
Transfer or xfer to complete the transfer. Some IP phones may 
support hang-up transfer. Please check the documentation of the IP 
phone to see if it supports this feature. The caller is immediately 
taken off hold and connected to the receiving extension.

b) If the person at the receiving extension does not wish to take the 
call, press Cancel. If this softkey is unavailable, press the flashing 
line button that corresponds to the caller on hold to return to the 
caller. 

c) If you dial an extension that is busy or not answered, you can 
complete the transfer and the caller is directed according to that 
extension’s call cascade settings. 

3.3.3.4 Transfer from a IP extension to any outside number

Unscreened Transfer
1. Press Transfer or xfer to put the caller on hold.

2. Dial a hunt group (or 80 for Same Line Connect) and the outside 
telephone number. If Direct Line Access is enabled, dial the phone 
number without a prefix.

3. Press Transfer or xfer to complete the transfer. Do not hang up to 
complete the transfer because this disconnects the call. Some IP phones 
may support hang-up transfer. Please check the documentation for the IP 
phone to see if it supports this feature. 

Screened Transfer
If the person at the receiving extension does not wish to take the call:

4. Press Cancel or the flashing line button that corresponds to the call 
on hold to return to the caller.

If you have the 3-way calling/conference or the Centrex transfer feature 
enabled on the current line, select the Same Line Connect (80) to make 
use of these features. Everything proceeds as above on the same line the 
call came in. 
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3.3.4 Call park — Parking and retrieving callers 

Call park is a feature for placing a call on hold and then retrieving it from 
any other local extension. TalkSwitch has 10 park orbits, 500–509.

3.3.4.1 Parking a caller

1. Press Transfer or xfer,  510 and press Dial or  to place a caller 
in the next available park orbit. 

2. You will hear a confirmation indicating that the caller has been parked 
successfully and into which park orbit.

3.3.4.2 Retrieving a parked call

1. Press   and the park orbit.

2. Press Dial or . If Direct Line Access is enabled at the extension, dial 
  then   and the park orbit, then press Dial, Send or 
. 

3.3.4.3 Using call park with the paging option

If the external paging option is enabled on TalkSwitch, you can announce 
the call over the PA system by pressing  0. If Direct Line Access is 
enabled, dial    0 and announce that there is a call parked in a 
specific park orbit for a co-worker. 

Example: “Bob, please pick up 501.” This tells Bob that he can retrieve the 
parked call from any extension by pressing   501 at the dial tone. 
The caller is now connected to Bob at that extension. If Direct Line Access 
is enabled at your extension, press Flash before retrieving the parked call.

If you have a combination of TS-80, TS-200, TS-400 and TS-600 phones in 
the office, you can page an individual extension or a ring group (i.e press 

 85, the Page button or softkey and the extension or ring group 
number).

3.3.5 Queuing and retrieving callers

For details on queuing and retrieving callers from a IP extension, please 
refer to sections 3.2.7, 3.2.7.1 and 3.2.7.2. This feature is used the same way 

* #

* *
#

* * * *
#

*
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* *
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on analog and IP phones except for the slight differences outlined in the 
next paragraph.

Some IP phones display a notification on the screen while the caller is on 
hold at your extension. If you want to rotate through queued callers while 
you are on the phone, dial 7 and press Dial, Send or . The caller you are 
speaking to is placed on hold, and the first caller in the queue is retrieved. 
If several callers are queued, dial 7 and press Dial, Send or  to retrieve 
them on a first in/first out basis.

3.3.6 Using the TalkSwitch call waiting feature

If the call waiting feature is activated as a Busy option in the call cascade 
routing for a local extension and the dialed extension is in use, the caller 
hears ringing or music depending on the music on hold settings. The person 
at the extension hears the following:

• If the phone supports call waiting caller ID (type II signaling), you hear a 
beep followed by a short blip. Depending on your phone, you may hear 
something similar to a modem noise. This is normal. During this 
notification, the caller ID information is displayed on the phone. The 
caller does not hear the beep. The phone mutes the other side.

• If the phone does not support call waiting caller ID, you hear a beep. 
When the call waiting notification beep is heard, the person at the 
extension can pick up another line and dial 7 and press Dial, Send or 

 to put the current caller on hold and answer the new caller. To 
return to the previous call, press the flashing line key that corresponds 
to the previous call. On most IP phones, this will put the current call on 
hold and connect to the other caller.

• To terminate the current call and go back to the other caller on hold, 
hang up, then go off-hook and press the button that corresponds to the 
flashing line of the caller on hold. If the person at the extension does 
not want to take the new call, she or he can ignore the call waiting beeps 
and TalkSwitch directs the caller to the next level of the call cascade for 
that extension (i.e. send the caller to the associated voice mailbox).

3.3.7 Conference calling with TalkSwitch 

3.3.7.1 Two TalkSwitch local extensions and one outside caller

You do not require access to the telephone company’s 3-way calling/
conference service to use the TalkSwitch conference calling capabilities.

1. Establish a call with an outside party.

#

#

#
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2. Press Conf or Hold to place the outside caller on hold. Dial the local 
extension you wish to conference with.

3. When the extension answers, press Conf to establish the 3-way call.

3.3.7.2 Two outside callers and one local extension

There are two different methods for this type of conference call. The first 
method is similar to the one above, using only TalkSwitch for the conference 
function. 

1. Establish a call with an outside party.

2. Press Conf or Hold to place the outside caller on hold. 

3. Pick up another line and dial the number of the other outside party. 
Dial 9 or another hunt group before dialing the second phone number.

4. When the call is answered, press Conf to establish the 3-way call.

The second method uses the telephone company’s 3-way calling/conference 
service.

1. Establish a call with an outside party.

2. Press Conf to place the outside caller on hold. 

3. At the dial tone, enter 80, dial the number of the other outside party 
and press Dial, Send or .

4. When the call is answered, press Conf to establish the 3-way call.

 
3.4  MAKING AND RECEIVING CALLS USING VOIP

TalkSwitch 48-CVA supports inter-branch connectivity via PSTN and VoIP. 
Once the system is properly configured, calls made between locations are 
using VoIP with broadband connections. TalkSwitch has 50 VoIP location 
codes (250-299) that can be assigned to any VoIP number. These location 
codes are dialed from an extension or from an auto attendant. TalkSwitch 
automatically finds the VoIP ports for placing these calls.

Other calls are made over VoIP by dialing hunt group 88. Activate VoIP 
numbers in this hunt group first. Dialing 88 at the internal dial tone tells 
TalkSwitch to hunt all VoIP numbers for an available line. In order to reach a 
remote location, a VoIP phone number has to be assigned to the VoIP 
number you want to call. 

#
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Example: You have 3 branch locations (New York, Miami, San Jose), all with 
TalkSwitch 48-CVA units.

Location 1: New York
Phone numbers assigned to 4 VoIP lines: 250-261 (12 phone numbers)

Location 2: Miami
Phone numbers assigned to 4 VoIP lines: 270-273 (4 phone numbers)

Location 3: San Jose
Phone numbers assigned to 4 VoIP lines: 280-283 (4 phone numbers)

If someone in the New York office wants to reach someone in the Miami 
office, they can dial one of the phone numbers associated to Miami 
(270-273). TalkSwitch automatically finds an available VoIP number and 
connects to the Miami location. The TalkSwitch at the Miami location 
handles the call according to the configuration in the Call Handling 
section for the VoIP numbers.

3.5  USING REGULAR OR IP PHONES CONNECTED 
IN PARALLEL TO TALKSWITCH 

Phones connected in parallel (not connected to TalkSwitch but connected to 
the same line) with TalkSwitch always ring at least once before TalkSwitch 
starts ringing its extensions or the auto attendant answers the call. 
TalkSwitch uses the first ring to identify the incoming ring pattern before 
passing it on to the extensions or the auto attendant (TalkSwitch 
determines if the call is a distinctive ring and detects any caller ID 
information). A parallel phone can interrupt a telephone call on any of the 
TalkSwitch lines.

Making and receiving calls on phones connected in parallel 
to TalkSwitch
Make calls on parallel-connected phones as if TalkSwitch were not sharing 
the telephone line with them.

If you answer on a parallel-connected phone before the auto attendant 
engages, TalkSwitch takes no further action. If a call is answered on a 
parallel-connected phone after the auto attendant engages, you can turn off 
the auto attendant message by pressing   0 at one of the TalkSwitch 
extensions, or let it time-out on its own, in which case you will hear: 
”Good-bye”.

Transferring calls on parallel-connected phones
Calls answered on a parallel-connected phone can be transferred to any 
TalkSwitch extension or voice mailbox. To transfer the caller, press 

* *
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 . After you hear 2 beeps, dial the extension and hang up. You 
cannot announce a caller to the transferred extension but if you stay on the 
line, you are in a conference call state. You can hang up at any time. 

If you transfer a call from a parallel-connected phone and then hang up, the 
extension rings the number of times specified for that extension. If it is not 
answered within that number of rings, the call is handled according to that 
extension’s call cascade actions. 

When a phone in parallel with TalkSwitch is off-hook, you notice that the 
corresponding line light flickers to indicate the line is busy. TalkSwitch does 
not allow extensions to interfere on a call that has the line in use.

3.6  MODEMS AND TELEPHONE LINE ACCESS

If your modem is attached to TalkSwitch as an extension, you can configure 
it to access your telephone lines in one of two ways. 

1. Enable Direct Line Access to one of your telephone lines. You don’t have 
to dial 9 or any other hunt group to access an outside line at the 
extension where your modem is conneted. Your modem will work the 
same way it always has. You don’t have to change your dial-up settings 
for the modem. See 2.2.5 Automatic Route Selection and Toll Restriction 
on page 44 for more details on configuring Direct Line Access.

2. If you use a telephone and modem on the same extension, do not enable 
Direct Line Access. A TalkSwitch extension with Direct Line Access 
immediately connects to one of your lines when you pick up the 
telephone’s handset, preventing you from accessing other system 
features without first pressing Flash on an analog phone or  on 
a IP phone. 

You can have your modem access a specific line using a hunt group. 

Change your modem’s dial properties to include the intended hunt group 
(9 or 81–88) followed by the letter w, before the dial-up networking 
telephone number (e.g. 9w789-1234). The letter w after your dial-out 
access number tells your modem to dial the access number 9, wait until it 
detects a dial tone, and then dial your dial-up networking number. 

You can change the transfer prefix to   instead of   if the 
default prefix conflicts with another device or service. To change the 
transfer prefix, open the configuration software and change the setting 
in the Options -> Transfer Options window.

* *

* # * *
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If your modem has problems dialing out, use a comma (,) to create a 2 
second pause instead of the w (wait for dial tone).

3.7  OUT OF THE OFFICE — RECEIVING CALLS WITH CALL 
FORWARDING (ANALOG AND IP)

3.7.1 Three ways to forward calls

1. Automatic call forwarding
The auto attendant can forward office calls to your call forwarding 
telephone number (i.e. remote extensions). Use the auto attendant 
message to prompt callers to select your remote extension number(s). 
(e.g. “To speak to John Smith, press 211.”)

2. Manual call forwarding
If someone in your office has answered a call at a local extension, the 
call can be transferred to one of the call forwarding (remote extension) 
numbers. 

a) Put the call on hold at the local extension.

b) Dial the remote extension number (e.g. 211) to which you want the 
call forwarded.

c) Hang up an analog phone and press Transfer or xfer on a IP phone. 

The call is handled according to the call cascade options of that remote 
extension.

3. Conditional call forwarding
If the auto attendant answers a call and the caller selects an extension or 
ring group number that is busy or is not answered, the auto attendant 
can forward the call to a remote (out of office) extension number. 
Conditional call forwarding is configured in the TalkSwitch software 
using the call cascade’s No answer or Busy settings for each local 
extension, remote extension and ring group (see 2.2.7 Local extensions 
on page 54 through to 2.2.9 Extension ring groups on page 61).

Because TalkSwitch CA and CVA units are digital systems, modem calls will 
only operate at a maximum speed of approximately 28 Kbps.
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3.7.2 Transferring calls from a remote extension

You can forward calls to a remote extension without using Centrex or 3-way 
calling services. Calls can be transferred to any local or remote extension, 
ring group or voice mailbox. This feature also applies to VoIP numbers.

1. Press   to place a call on hold at a remote extension anytime 
during a conversation. You hear the same dial tone as at a local extension 
and have the following three possibilities:

a) Press   to retrieve the call placed on hold.

b) Dial any local extension, remote extension or ring group. 

c) Press  on an analog phone or Transfer/xfer on a IP phone and 
the mailbox number to transfer a caller to a voice mailbox. 

If the system is configured in the TalkSwitch configuration software under 
Options -> Transfer Options in the Remote Transfer section to Perform a 
blind transfer, the system plays the prompt “Call Transferred — Goodbye.” 
and hangs up after the extension or mailbox is dialed.

If the system is configured in the Transfer Options section to allow call 
screening, dial   4 to complete the transfer or   5 to cancel 
the transfer and return to the caller.

3.7.3 Screening options for forwarded calls 

The screening options for call forwarding are configured in the TalkSwitch 
software using the call cascade Answered options in the remote extension 
window. 

Forwarding calls with screening
When play accept/reject prompt is configured in the Answered call cascade 
option under Call Handling -> Remote Extension, TalkSwitch plays a pre-
recorded prompt to callers asking them to hold and then dials your call 
forwarding number. When you answer the forwarded call, you hear a prompt 
saying: “You have a forwarded call. To accept the call, press . To reject the 
call, press  .” If you reject the call, it is routed according to the call 
cascade option specified next to If a call is rejected from this ext.: 

When play caller’s name first is configured in the Answered call cascade 
option, TalkSwitch plays a pre-recorded prompt to callers asking them to 
record their name at the sound of the tone. TalkSwitch asks the caller to 
hold and dials the call forwarding telephone number. When you answer the 
forwarded call, TalkSwitch plays a pre-recorded prompt saying: “This is call 

* *
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forward, you have a call from...” and plays the recording of the caller’s 
name. To accept the forwarded call, press  on your telephone keypad, 
re-route the call to its call screening call cascade options by pressing .

When either screening option is used, music on hold is enabled and you are 
not using the 3-way calling feature (Same Line Connect) to forward calls, the 
caller hears music while TalkSwitch is waiting for the remote extension to 
accept the call. 

If a forwarded call is not answered or the line is busy, TalkSwitch performs 
the following, based on how the call was originally forwarded:

• If the call was automatically forwarded, it follows the remote extension’s 
No Answer or Busy call cascade action.

• If the call was manually forwarded, it follows the remote extension’s No 
Answer or Busy call cascade action. This action can be changed to ring 
the extension back to the person who performed the transfer.

• If the call was conditionally forwarded, it follows the call cascade action 
in the No Answer or Busy for the original extension selected.

3.7.4 Calls over VoIP with IP phones and Gateways

If teleworkers are connected to the system via a certified compatible IP 
device (i.e. gateway or IP phone), there are several ways for them to interact 
with TalkSwitch.

Making calls
Once the phone or gateway is registered with the TalkSwitch IP server, calls 
can be made as follows:

1. At dial tone, dial a phone number associated to any of the other 
locations.

2. At dial tone, dial a phone number associated to one of the VoIP numbers 
on TalkSwitch. Ensure that an auto attendant is programmed to answer 
this line. Once the auto attendant has answered, dial an extension, VoIP 
location or voice mailbox. To place calls through the regular phone lines, 
you must activate and configure a call bridge account (see 2.5 Call Back/
Call Bridge on page 98). To access regular phone lines dial 9 and enter 
the password for call bridge.

#

*

Currently, TalkSwitch does not place calls on hold or transfer calls when 
you call other locations, since the call does not actually go through 
TalkSwitch.
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Receiving calls

Once the phone or gateway is registered with the TalkSwitch IP server, calls 
are received directly from other registered gateways or through the system.

1. If the call is routed via TalkSwitch, you can transfer the caller dialing 
  and any extension or voice mailbox.

2. If the call came directly from a IP gateway or phone, you can transfer the 
call if your phone or service provider supports this feature. 

3.8  USING THE VOICEMAIL SYSTEM

Each TalkSwitch unit comes with 30 minutes of voicemail recording 
capacity. This time is shared with auto attendant greetings. The capacity 
can be increased by adding TalkSwitch memory cards. You can add 1, 2, 4.5, 
or 9 hours of storage to each unit. When you insert the memory card, the 
system configures it automatically. Contact your TalkSwitch dealer to 
purchase memory cards. 

3.8.1 Activating voicemail boxes

There are three types of voice mailboxes in the Voicemail folder of the 
configuration software.

Local Ext. Voicemail
The local mailboxes are associated with local extensions. All local extensions 
are activated with a respective mailbox by default. You can also activate the 
extension as an announcement or you can de-activate it.

Remote Ext. Voicemail 
The remote mailboxes are associated with the remote extensions. If you 
activate a remote extension, it is activated as mailbox by default. You can 
also activate the extension as announcement or you can de-activate it.

General Voicemail 
Activate these mailboxes in the General Voicemail window. They are not 
associated with particular extensions. You can also activate the extension as 
announcement or you can de-activate it.

If you want incoming calls to go straight to a voice mailbox after a 
specified number of rings, program an auto attendant to answer and 
provide a fall through to voicemail.

* *
1 3 8 T A L K S W I T C H  US ER GU IDE  •  NOR TH AMERICA



Callers can reach voice mailboxes, call cascade, be transferred from a local 
extension or have announcements played through the auto attendant. 

To leave a message from a regular local extension:

1. Dial  and the mailbox number. 

To leave a message from a local IP extension:

1. Dial  and the mailbox number and press Dial, Send or .

To transfer a caller directly to voicemail from a regular phone:

1. Press Flash , the mailbox number and hang up.

To transfer a call to a voice mailbox from an IP phone: 

1. Press Transfer or xfer  .

2. Enter the mailbox number.

3. Press Dial, Send or .

4. Press Transfer or xfer to complete.

When a caller presses  after leaving a message or after 2 minutes have 
elapsed, TalkSwitch plays a prompt asking callers if they wish to keep the 
message, listen to the message or re-record the message. Callers can press 0 
and the system directs the call according to the settings of that mailbox.

3.8.2 Retrieving messages and accessing a voice mailbox

The first time you access your voice mailbox, you are prompted to assign a 
password, record a greeting and record your name for the dial-by-name 
directory. 

For the general mailboxes, there are no directory listings and you are not 
prompted to record a name. If you wish to have your name in the company 
directory, use the mailbox associated with its extension as the directory is 
related to the extension’s mailbox. When your mailbox has been set up, you 
access it through the prompt instructions.

*

* #

Transferring a call to a voice mailbox does not apply to all IP phones. 

*

* *

#

#
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When a new message is left in a local extension mailbox, TalkSwitch plays a 
stutter dial tone when the handset is picked up. If the phone supports a 
frequency-shift keying (FSK) message waiting indicator, the light flashes. The  
TS-80, TS-200, TS-400 and TS-600 phones support a message waiting counter. 
The display on the phone shows the number of new messages stored in the 
mailbox(es) associated with that extension. 

1. Dial    from a local extension or   and the mailbox 
number at the auto attendant if you are dialing from an outside location.

2. Local extensions can transfer employees to access voicemail by pressing 
Flash   and entering the mailbox number. 
If Direct Line Access is enabled, be sure to press Flash before trying to 
access your mailbox. 

a) Press 1 to listen to messages. 
TalkSwitch always starts with newest message before it plays the 
older ones. While the message is playing or after the message has 
finished, you can dial the following: 

b) Press 2 to change greeting options.
This allows you to record a new personal voicemail greeting. The 

If you have a line configured to go straight to voicemail, dial 8 during the 
greeting to access messages from outside phones.

1 to rewind 10 seconds

11 to rewind to beginning of the message 

3 to skip ahead 10 seconds

33 to skip to the end of the message

5 to listen to the time and date stamp

6 to forward the message

7 to delete a message

9 to save  a message

to back up one level

to skip to next message, leaving new messages as new.

* * # * *

* *

*
#
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default greeting is: “The extension you have reached is unavailable at 
this time. Please leave a message after the tone”.

c) Press 3 to change personal options. 

• change your current password 
• turn the auto date and time stamp on/off 
• turn the phone number on/off 
• set up or change pager and remote phone notification 

By default, the auto date and time stamp is on. This information is 
played at the end of each message. If you have caller ID service, the 
phone number is displayed with the time and date.

d) Press 4 to record your name for the dial-by-name directory. 
If you haven’t recorded your name for the directory or if you wish to 
change the recording, press 4. The dial-by-name directory is accessed 
at the auto attendant according to your configuration. Callers are 
directed to enter the first 3 letters of the employee’s last name. The 
system finds the exact or closest match and plays the recorded name 
with the extension number, giving callers the option to connect to 
that extension. 

3.8.3 Recording an announcement on a regular or an IP phone

An announcement is a recorded message providing information to callers. It 
can be recorded using your phone as a voicemail message or loaded as an 
audio file. The system hangs up after playing an annoucement. Callers have 
the option of pressing  during an annoucement to return to the auto 
attendant. Callers can also press 0 to perform other actions if this is 
configured in the voicemail options.

You might include in the announcement a mention of the selections a caller 
may press and leave a section of silence at the end to give the caller time to 
make a selection.

Remember: While recording your greeting or announcement, callers can 
press  to return to the auto attendant, if the call came from the auto 
attendant. When they are done recording, they can press  for more 
options. You may want to give your callers these options for their 
convenience.

You must record your name in order for the extension to be included in 
the dial-by-name directory.

*
#

*
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To record an announcement, access a voice mailbox and select option 2 to 
change greeting options as described in 3.8.2 Retrieving messages and 
accessing a voice mailbox on page 139. To load a pre-recorded announcement 
or to configure 0 as an option to be selected, see 2.3.1 Mailbox options on 
page 67. To configure call handling options for announcements, see 2.4 Call 
Handling on page 78.

3.8.4 Pager and cell phone notification

When a new message is left in a voice mailbox, it can notify a pager, cell 
phone or a remote number. 

You can configure the system to notify you for every new message or for 
only the first new message received since the last time you accessed new 
messages For more information, see 2.3.2 Voicemail notification on page 68. 

If you use remote phone notification, you can accept or reject the 
notification call when you answer. 

• Press  to listen to messages.   
• Press  to postpone listening to messages.

For details on configuring pager and remote phone notification, see 2.3.2.1 
Dialed notification on page 68.

3.9  MUSIC ON HOLD

TalkSwitch can play music to callers when they are on hold, parked or 
queued. The music played is provided by the source you have connected to 
the music jack or from a sound file (8 KHz, 8 bit, mono, u-law, .wav format) 
stored on the unit(s). When a sound file is loaded on one of the TalkSwitch 
units, it is duplicated to all units on the LAN. 

Music on hold and call forwarding to remote extensions 
If you are using the telephone company’s 3-way calling/conference service 
(Same Line Connect) to activate the TalkSwitch call forwarding feature, 
callers do not hear your music while they are forwarded to a remote 
extension. When calls are forwarded, the caller is put on hold by the 
telephone company’s central office switch rather than by TalkSwitch and the 
caller hears silence while being transferred.

A system prompt indicates that callers hear silence while the system is 
locating their party. This prompt explains to callers why there is silence for 
an extended period of time before connecting to the remote extension. This 
prompt cannot be disabled. 

#

*
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3.10  MODE SWITCHING OPTIONS

Manual mode switching
Use telephone keypad commands at a local extension or at the auto 
attendant to switch modes. 

1. Dial  at the local extension dial tone or at the auto attendant to 
enter command mode.

2. Enter a password if required.

a) Dial 30  to check the current mode. 

b) Dial 31  to activate mode 1.

c) Dial 32  to activate mode 2.

Automatic mode switching using the time scheduler

Use the configuration software to activate the TalkSwitch time scheduler 
feature. You can configure TalkSwitch to switch between modes 
automatically (see 2.4.1 Modes on page 78). 

If you switch modes manually, TalkSwitch switches to the proper mode 
during the next scheduled mode change.

 If you have two or more units on a LAN, we recommend that you load a  
 .wav file to the system of units. If you use an external music source, 
 supply a music source to each TalkSwitch unit. 1/8" audio splitters are 
 available at most electronics stores.

Ensure that the TalkSwitch configuration software tool is closed at the 
time of the scheduled mode switch. The mode cannot change if the 
configuration software is open. 

#

#

#

#

U S I N G  T A L K S W I T C H                                                  1 4 3



3.11  OUT OF THE OFFICE — MAKING CALLS 
WITH CALL BACK AND CALL BRIDGE

Working together, call back and call bridge act as your personal 
long-distance operator. Whether you are across town or around the world, 
these two features allow you to place calls from your office telephone 
line(s).

You can make a call to TalkSwitch, access a telephone line connected to 
TalkSwitch and enter the number you want to dial. This is especially useful 
when you are out of the office with your cell phone and need to make a 
long-distance call. You can avoid the long-distance cell rates by making a 
local call to TalkSwitch and access your office savings plan through 
call bridge.

3.11.1 Using call bridge

1. Dial into a TalkSwitch line. 

2. When the auto attendant answers, select a hunt group (9, 81–88 or Same 
Line Connect 80). 

3. Enter your account password. If you are using Same Line Connect and 
your line supports the 3-way calling/conference service, you are 
prompted to enter the phone number. 

4. When you have completed your call, do one of the following:

a) Make another call by pressing  . 
TalkSwitch disconnects you from the call in progress. You can dial 
another number or redial the same number. 

b) Activate the auto attendant by pressing  . 
TalkSwitch ends the call bridge session and activates the auto 
attendant. When the auto attendant message begins to play, you 
have the following options:

• Press  or  55 to enter command mode
• Dial 6 to change/enter call back settings
• Dial a local or remote extension or a ring group. This option 

allows you to contact someone in your office, check your 
voicemail, etc.

c) End the call bridge session by hanging up. This disconnects you from 
TalkSwitch. To ensure that TalkSwitch disconnects at the end of a call 
bridge session, press   before hanging up.

# #

# *

# *

# #
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The call bridge telephone number you dial can be local, long-distance, toll 
free (800 and 888) or international. Enter the telephone number as you 
would in your office. For long-distance calls, include the 1, country code 
and area code.

3.11.2 Using call back

The call back feature allows you to initiate TalkSwitch to call you at a 
specified telephone number. This gives you access to the following:

• Call bridge
• Local extensions, remote extensions and ring groups
• Voicemail 
• Configuration settings

Using call back involves 3 steps:

1. Call your TalkSwitch telephone number to activate call back.

2. Answer and accept call back. TalkSwitch calls you back within 
30 seconds.

3. At the auto attendant you can choose to perform call bridge, dial an 
extension, access and retrieve voicemail or configure TalkSwitch.

Activate call back
There are two ways to activate call back. 

1. Using prompted call back activation from your out-of-office location:

a) Dial a TalkSwitch telephone number. 

b) Let the line ring until the auto attendant answers.

c) Dial 6 on the telephone keypad. 

d) If you have password protection on the account, enter your password. 

e) TalkSwitch offers a series of prompts: 
You can enter 1 and hang up to initiate the call back.
If you need to enter a new prompted call back number, enter 2 and 
follow the prompts.

For prompted call back, TalkSwitch always dials the last prompted call 
back number entered. If you do not have the auto attendant answer a 
line, a generic TalkSwitch auto attendant will answer after 15 rings. You 
can then dial 6 to access the call back settings.
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2. Using auto call back activation from your out-of-office location: 

a) Dial one of the call back telephone numbers that has been configured 
for auto call back activation. 

b) Let the line ring at least once but no more than three times and hang 
up before the call is answered. 

c) Within 20 seconds, TalkSwitch calls your auto call back number. 

Accepting the call back
There are two ways to accept a call back from TalkSwitch. 

1. Answer the call and press . 
If required, enter your password. This option is used when you have a 
direct line to your call back telephone number.

The Use Announced message option allows the call back from TalkSwitch to 
reach you when you are in a hotel or an office where calls are intercepted by
a receptionist or switchboard operator. When the call back is answered, 
TalkSwitch begins playing your pre-recorded message (e.g. “Please forward 
this call to Bob Smith in room 312”). The message is repeated for 2 minutes. 
When the call is forwarded to you, press  and enter your password on 
the telephone keypad to accept the call back. If the call back is not accepted 
within the initial 2-minute period, TalkSwitch disconnects the call back. 
When you accept the call, you hear the auto attendant. You can select to 
check your voicemail, ring an extension, use call bridge or enter command 
mode.

It is important to remember that all call back settings must be 
configured to use auto call back. Please ensure that the auto 
attendant for the line using call back does not answer before 4 rings. 

#

#

1 4 6 T A L K S W I T C H  US ER GU IDE  •  NOR TH AMERICA



C H A P T E R  4
CH A P TE R  4 :  CA LL  DE TA IL  R E CORD (C DR )  LOG G ING

CALL  DETAIL  RECORD (CDR)  
LOGGING

This chapter covers the setup and retrieval of records generated by calls 
through the phone system.

The Store to File on TalkSwitch option is recommended for all units with LAN 
ports. The Real-time to Serial option is only available with units that have a 
serial port.

4.1  ENABLING CALL DETAIL RECORD (CDR) LOGGING

Units can report the CDRs in real-time to a computer connected to the Serial 
port, or log the CDRs in a file on the unit itself. 

1. Connect TalkSwitch to your computer and open the TalkSwitch 
configuration software.

2. Click Tools -> Call Logging Output.

3. Select Real-time to Serial Port or Store to File on TalkSwitch.

Figure 112: Call log output options  

If multiple units are networked on a LAN, the CDR data is stored on unit 1.
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4. File -> Save to TalkSwitch

Figure 113: Save settings

When storing the CDR to a file on TalkSwitch, approximately 6000 records 
are stored in a circular buffer. This means that after about 6000 records, the 
oldest ones will be deleted and new ones are created. On a very busy system,  
6000 records may only cover a couple of days, but on a system with less 
traffic, 6000 records may cover more than a month.When the CDR data is 
streaming real-time from the Serial port, there is no buffer limit and no file 
is generated on TalkSwitch. When a call event is completed, the record is 
sent through Serial port.

4.2  RETRIEVING DATA

There are 2 different methods for retrieving the data from TalkSwitch:

• Web Interface — Store to File on TalkSwitch.  (48-CA and 48-CVA models) 
• Serial Interface — Real-time to Serial Port

While the TalkSwitch configuration software displays two options for Call 
Logging Output, only the available option can be selected.

4.2.1 Web interface — Store to File on TalkSwitch

You can access the CDR information through a web interface as follows:

1. Enter the unit IP address in the Address field of a web browser.     

2. Enter the system name in the User Name field and the administrator 
password in the Password field. 

Select System Information -> IP Configuration in the configuration 
software to find the unit’s IP address.
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Figure 114: Log in window

3. Click on the link Call Detail Record (CDR) Management.

Figure 115: Initial CDR web interface

4. You may either right click on Download CDR to save the information to 
your PC or left click on the link to view the current information. Browser 
specific information is available on the website when you scroll down.

Figure 116: Dowload CDR

Once the CDR file has been downloaded, you can clear the buffer/file by 
selecting the link under Clear CDR. The link will take you to a confirmation 
page. Select Yes to proceed or No to cancel.

Select System Information -> Administration in the TalkSwitch 
configuration software to find the username.
C A L L  D E T A I L  R E C O R D  ( C D R )  L O G G I N G 1 4 9



1 5 0 T A L K S W I T C H  USER GU IDE  •  NORTH AMERICA

Figure 117: CDR web interface

4.2.2 Serial interface — Real-time to Serial Port  

In order to capture the data in a real-time environment your PC has to be 
connected to TalkSwitch unit ID 1 with a serial cable.

1. Launch Hyper Terminal by clicking Start -> Programs -> 
Accessories -> Communications -> HyperTerminal.

2. A window pops up prompting for a connection name. Enter TalkSwitch, 
then click OK. 

Figure 118: Launching HyperTerminal 

3. In the Connect using: drop-down menu, select the PC COM port where the 
serial cable is connected and click OK. 

If you have not used HyperTerminal before you will be prompted to set 
this program as a default telnet application and enter your area code.



Figure 119: Connecting...

4. Set the bits per second to 57600 and click OK. All other values can be 
left at their defaults.  

Figure 120: COM1 properties

5. Click on Transfer -> Capture Text...

Figure 121: Save your data

6. Select the directory and filename where you wish to save the data. 

7. Click Start.  
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4.3  ANALYZING THE DATA

The data can be viewed either through the web interface or downloaded into 
a spreadsheet (e.g. Excel) as a delimited text file. The log is divided into 13 
columns identified by numbers:

Each column contains specific information related to the current state of the 
call. The following is a list of the columns with a description:

1. Type — This column can contain the following characters:

a) I — Inbound call

b) T — Transfer state

c) O — Outbound call

d) B — Bridged call. For example, a call in on one line that is forwarded 
over another line. This can include calls forwarded to remote 
extensions.

e) X — Blocked call

f) A — Account number assigned to the call with the same log #.

2. Log # — This column indicates log number for the call. For the duration 
of the call, the log number remains the same. The event number will 
increment with each change of state. The first digit of the log number 
indicates on which unit the event originated.

3. Event — This column tracks various state changes of the call. For 
example, when an auto attendant answers, the counter might be 1. When 
the caller selects an extension, the counter increments to 2, etc.

4. Date — This column shows the date of the call (MM/DD/YYYY).

5. Time — This column contains the time that the call entered a specific 
state. The time is displayed in 24-hour format.

We recommend that you clear the text file immediately after it is 
downloaded. Restart saving data to a new file. This allows easier viewing 
and analyzing of the captured information.

1. Call Type
2. Log Number
3. Event Counter
4. Date
5. Time

6. Event Duration
7. Connection
8. Phone Number
9. Name from 

Caller ID

10. Line
11. Account Number
12. Carrier Code
13. PIN Number
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6. Duration — This column indicates the total time the call was in this 
state/event.

7. Connection — This column indicates where the call was for each event. 
This includes auto attendants, voicemail, extension ringing or queuing. 
RCO indicates that multiple extensions are ringing.

Exxx = Connected to extension xxx 
(xxx = 111-118, 121- 128, 131-138, 141-148)

Axxx = Connected to auto attendant 00x (x= 1 to 9)
Rxxx = Ringing at extension xxx 

(xxx = 111-118, 121-128, 131-138, 141-148)
Qxxx = Queued at extension xxx 

(xxx = 111-118, 121-128, 131-138, 141-148, 300-309)
Mxxx = Connected to voice mailbox xxx 

(xxx = 111-148, 211-248, 410-449)
COxx = Forwarded out on line xx. (See 10. Line below for more details).

8. Phone Number — This column displays the phone number of the 
inbound or the outbound caller if available.

9. Name — This column displays the name of the caller if available. 

10. Line — This column indicates on which unit and line the call came in or 
out. The format of this information is unit and line number. Lines 1–4 
are PSTN lines and 5–8 are VoIP lines. 
Example: 11 — unit 1, line 1

23 — unit 2, line 3
16 — unit 1, VoIP 2

11. Account Number — This column contains an account number that the 
user can assign after a call. This allows you to group calls together that 
may have been placed over time to calculate the total amount of time 
spent with a particular customer. The account number can be a numerical 
code up to 15 digits long. To assign an account number after a call has 
been completed, dial  88 + <Account Number> + . 

If Direct Line Access is enabled on an extension: 

a) Analog phone — press Flash, then dial 88 + <Account Number> 
+ .

b) IP phone — press  , then dial 88 + <Account Number> 
+ .

12. Carrier Code/Access Code — This column shows the phone number of 
the preferred long-distance provider.

* #

*
#

* * *
#
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13. PIN or User Code — This column shows the user’s access code to dial out 
using a specific carrier.

The data can be imported into any call management software or an Excel 
spreadsheet as a delimited text file. After the import, the data can be 
grouped and tallied based on the criteria set forth. 

Example:

1. Total line usage for a day 4. Average call times

2. Number of inbound calls 5. Number of calls per line

3. Wait times
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C H A P T E R  5
CH A P TE R  5 :  VO I P  I N FO R M A TI O N

VOIP  INFORMATION

5.1  INTRODUCTION TO VOIP

TalkSwitch  units can be hybrid PSTN/VoIP phone systems. The addition of 
VoIP to the TalkSwitch product line adds the ability to use a broadband IP 
connection for voice calls. 

VoIP also enables the use of IP phones as extensions on your TalkSwitch 
system. Connect an IP phone to your LAN and TalkSwitch can configure it to 
have the same powerful features as regular (analog) phones, plus exciting 
new features that break the boundaries of possibility for the office phone.

TalkSwitch 48-CVA units can be used in many different applications. The 
most popular VoIP configurations are multi-branch, teleworker and service 
provider integration. 

TalkSwitch uses the industry-standard Session Initiation Protocol (SIP) to 
make and manage VoIP calls. The term SIP is often used in place of VoIP.

To connect to a VoIP network or VoIP service to make and receive SIP calls, 
each location must be able to establish a high-speed connection to the 
Internet or private network. The following steps should ensure success for 
typical network connection methods.
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5.2  OPTIMIZING YOUR IP NETWORK FOR VOIP

5.2.1 The broadband connection

Figure 122: Broadband

For optimal quality of VoIP calls on your system, we recommend that you 
subscribe to a high-speed broadband connection from your service provider. 
‘Lite’ broadband is not suitable for simultaneous voice and data traffic. 
‘Lite’ broadband typically runs 128 Kbps downstream and 64 Kbps upstream. 
The limiting factor for a broadband connection is the upstream bandwidth to 
the Internet Service Provider (ISP). 

Example: If you have a 1 Mbps ADSL connection from your service provider, 
it likely means you have an upstream bandwidth of approximately 
380 Kbps. Keep in mind that not the full 380 Kbps are available at all times. 
You can estimate about half of the upstream bandwidth as being available. 
In this case, you could safely support two simultaneous G.711 calls 
(100 Kbps/calls) or four simultaneous G.726 calls (50 Kbps/calls) or 10 
simultaneous G.729 calls without factoring in other data traffic on the 
network at the same time. With additional traffic on the Internet or private 
IP network, the number of simultaneous calls supported is reduced. 

5.2.2 The router/NAT/firewall

Figure 123: Router

G.711, G.726 and G.729 are VoIP codecs. For more information on codecs, 
see Codec Options (button) on page 167.
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In a typical small office environment, there are several computers connected 
to an Ethernet switch, sometimes integrated into a router. A router handles 
the connection between two or more IP networks. Routers look at the 
destination IP addresses of the packets passing through and rout them 
accordingly. In a network that shares data and voice, it is critical that the 
voice traffic has priority over the data packets. Some routers support Quality 
of Service (QoS) functionality for this purpose. These routers are identified 
as devices that support QoS, VoIP or prioritization. 

5.2.3 Connecting to a LAN and IP network  

Ensure the TalkSwitch or gateway is connected to a Local Area Network 
(LAN), equipped with an Ethernet switch and router or to a router with an 
integrated switch. A PC and the router/switch should be connected to the 
LAN for configuring the TalkSwitch unit.   

Figure 124: LAN

To share voice and data properly, your network requires an Ethernet switch. 
A switch isolates the Ethernet ports from each other and only allows traffic 
intended for the device connected to that port. This ensures that data 
traffic doesn’t compete with voice traffic. The most successful way to 
separate voice and data traffic is to install a router using different subnets 
for voice and data.

5.2.3.1 Confirm sufficient network capacity for VoIP

Ensure that the LAN in each location has a reliable high-speed broadband 
connection to the Internet. The quality of VoIP calls, especially on mixed 
voice and data networks, depends on high data-transfer rates across the 
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network. ‘Lite’ broadband connections are not suitable for simultaneous 
voice and data traffic.

To test the VoIP call capacity based on your Internet connection speed, 
perform the test available on our website at:www.talkswitch.com/voip/
voip_capacity.php.

5.2.3.2 Confirm  router/firewall path for voice data

In order to pass through a router’s firewall, voice data received by your 
network must be mapped to the appropriate TalkSwitch unit. TalkSwitch 
uses UPnP (Universal Plug and Play) to automatically map firewall ports to 
forward VoIP data. If your router supports UPnP, ensure that it is enabled 
(see your router documentation for configuration details).

If a router does not support UPnP, you will need to configure the router to 
map specific ports to TalkSwitch. The following describes which ports to map 
toTalkSwitch:

• To allow SIP Signaling data to be forwarded to TalkSwitch, firewall port 
5060 must be mapped to the TalkSwitch unit known as the local proxy. 
By default, this is the lowest numbered TalkSwitch on a LAN. The IP 
configuration window of the TalkSwitch software indicates with an 
asterix which TalkSwitch unit is the local proxy. SIP Signaling uses UDP.

Example: in a 4-unit network, firewall port 5060 (UDP) would need to be 
mapped to the IP Address of the TalkSwitch unit ID #1.

• To allow voice traffic to be forwarded to TalkSwitch, corresponding ports 
must be mapped to each TalkSwitch unit. The following table shows the 
firewall ports to map to each TalkSwitch unit on a LAN.

Firewall ports* required open for VoIP communication with TalkSwitch 

*Default port numbers. For instructions on re-assigning these numbers, contact TalkSwitch Technical 
Support.

• If you plan on configuring TalkSwitch remotely, you will need to map 
port 9393 (Type: TCP) to the TalkSwitch unit that is being configured. 
Configuration is done using TCP.

Description Type Unit 1 Unit 2 Unit 3 Unit 4

Voice traffic UDP 6000–6006 6010–6016 6020–6026 6030–6036

TIP: For information on configuring a router for port forwarding, visit 
http://www.portforward.com/routers.htm.
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Prioritize your voice traffic
If your Internet connection is shared between computers and TalkSwitch 
(i.e. data and voice), it is critical that the voice traffic has priority over the 
data traffic. Many routers support Quality of Service (QoS) routing for this 
purpose. If your router supports QoS, ensure that it is enabled (see your 
router documentation for configuration details).

DDNS Support
If you are using Dynamic Domain Name Service (DDNS) to manage the IP 
address of the SIP server, ensure that your router(s) support the specific 
DDNS service that you are using.

5.3  SETTING UP A VOIP NETWORK

A TalkSwitch VoIP network can be set up in 4 steps:

1. Connect a TalkSwitch or SIP-compatible gateway at each location.

2. Select a TalkSwitch to use as the SIP network server.

3. Assign phone numbers to each VoIP location.

4. Configure TalkSwitch to make and manage VoIP calls.

5.3.1 Connect TalkSwitch or SIP-compatible gateways

In order to create a VoIP network, a VoIP-equipped TalkSwitch or a VoIP 
compatible gateway, such as a Mediatrix® 2102, is required at each location. 
Each location in a multi-location network can support up to 4 TalkSwitch 
units, with a maximum of 32 local extensions (analog and/or IP phones) and 
16 VoIP lines per location.

Example: Figure 125 on page 160 shows a multi-location network where two 
locations are equipped with TalkSwitch systems and a teleworker is equipped 
with a Mediatrix 2102 device. TalkSwitch and the Mediatrix 2102 route VoIP 
calls over the Internet, while local calls are routed over the regular 
(traditional) telephone network.
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Figure 125: Multi-location network with VoIP calling

5.3.2 Select which TalkSwitch to use as the SIP network server

A multi-location SIP network requires a SIP server to manage calls across the 
network. The SIP server contains registration information for all SIP devices 
in the network. When making or receiving a VoIP call, a device will register 
with the SIP server, which will then route the call to the appropriate 
destination. 

TalkSwitch units have a built-in SIP server to manage a VoIP network. 
Though every networked TalkSwitch unit has the capability, you must 
designate only one TalkSwitch unit in a network as the SIP server.

5.3.2.1 Which location and unit should be the SIP server?

Any TalkSwitch unit on the network can be designed to be the SIP server. 

To simplify network operation and reliability, we recommend that you 
choose a location that has a static, rather than a dynamic public IP address. 
A static public IP address does not change, providing a consistent 
connection address for each location to communicate with the SIP server. 

For VoIP calls made through a VoIP service provider, the service provider 
will act as the SIP Server.
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If you do not have a static IP address, you can obtain a Fully Qualified 
Domain Name (FQDN) from a Dynamic Domain Name Service (DDNS) provider. 
A DDNS matches your dynamic IP addresses to your FQDN, so that your 
TalkSwitch VoIP network operation is not affected by IP address changes.

One DDNS provider is DynDNS. 
Visit http://www.dyndns.org/services/dyndns for more information.

Configuring TalkSwitch to act as the SIP server is described in 5.4.2.1 
TalkSwitch Profile on page 164.

Example: Building on the previous example, the TalkSwitch system in the 
San Francisco office is designated as the SIP server. When a location initiates 
a call, the TalkSwitch in San Francisco will resolve the destination address 
for the call and coordinate a connection to route the call to its destination.

5.3.3 Assign phone numbers to each VoIP location

You can now assign phone numbers to locations in your VoIP network. 

Each TalkSwitch unit with VoIP lines can support up to 12 VoIP phone 
numbers. Unique call handling scenarios can be configured for each VoIP 
number. VoIP phone numbers can be 3 or more digits in length.

TalkSwitch supports 50 VoIP location numbers (250 to 299) that permit 
direct dialing from any extension or auto attendant in the network. If 
needed, numbers outside of this range can also be added. See 5.4.3 VoIP 
Numbers on page 170 for details. Each VoIP phone number assigned in a 
multi-location network must be unique (i.e. only used for one location).

For VoIP calls made through a VoIP service provider, the service provider will 
assign the VoIP numbers to be used for their service.

To assist in assigning VoIP numbers for your network, use the 5.6 VoIP 
network administration form on page 180.

Assigning VoIP phone numbers in your TalkSwitch configuration is described 
in 5.4.3.1 Assign VoIP phone numbers on page 171.

Example: Continuing with the previous example, five VoIP location numbers 
are assigned to VoIP lines in San Francisco (251 to 255), nine are assigned to 
VoIP lines in New York (261 to 269), and one is assigned to the teleworker 
office in Miami (271). These phone numbers can be dialed directly from an 
extension or from an auto attendant from any location within the network.



Figure 126: TalkSwitch network configuration

5.4  VOIP CONFIGURATION

5.4.1 Configure TalkSwitch IP addresses

Each TalkSwitch system in a multi-location network must be configured with 
both local IP and public IP address information. These addresses are used to 
direct VoIP calls to the appropriate location. Each TalkSwitch unit in a 
system will have a different local IP address, and share a common public 
IP address.

5.4.1.1 Set the TalkSwitch local IP address

The following steps describe how to set the local IP address(es) of a 
TalkSwitch system:

1. Open the TalkSwitch configuration software by double-clicking the 
TalkSwitch icon on your Desktop or, from the Windows Start menu, 
select Programs, the TalkSwitch folder, and click TalkSwitch.

2. In the TalkSwitch System Configuration window, select 
System Information -> IP Configuration from the menu at the left.

3. TalkSwitch is factory configured to use DHCP (Dynamic Host 
Configuration Protocol) to automatically obtain its system IP settings. If 
the location has a DHCP server, which is typically a function of the 
router, the fields on the screen will automatically be filled in with the 
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correct IP information. Click Use the following IP and DNS information to 
‘lock in’ these settings and ensure they are saved as the system IP 
settings.

4. If the location does not have a DHCP server, the System IP Settings fields 
will not be filled in. Click Use the following IP and DNS information and 
enter the IP address(es), Subnet mask, Default Gateway, Preferred DNS 
Server, and Alternate DNS Server information in the appropriate fields. For 
details on these settings, refer to 2.2.2 IP Configuration on page 37.

5. If there are multiple units in a system, enter the IP addresses of all units 
in the system (Unit 2 IP Address, Unit 3 IP Address, Unit 4 IP Address). 

Figure 127: Local IP configuration

5.4.1.2 Set the TalkSwitch public IP address

The public IP address of a TalkSwitch system is assigned by your Internet 
Service Provider. Depending on the type of service, you will either have a 
dynamic or static IP address. If you are unsure which type you have, contact 
your Internet Service Provider.

The following steps describe how to set the public IP address of a TalkSwitch 
system:

1. Specify the Type of Public WAN IP for Internet Connection by selecting 
either dynamic or static from the drop-down list. For private networks, 
please ensure the WAN IP address is the same as the Local IP address.

If this TalkSwitch system will act as the SIP server for a network, we 
recommend having a static Public IP address. 
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2. If this TalkSwitch system will act as the SIP server for a network and has 
a dynamic Public IP address, enter the Fully Qualified Domain Name 
(FQDN) associated with the Public IP address. If the address is static, 
leave this field blank.

You can obtain a FQDN from a Dynamic Domain Name Service (DDNS) 
provider such as DynDNS (visit http://www.dyndns.org/services/
dyndns). Check your router documentation to confirm which DDNS your 
router can support.

Figure 128: IP Configuration

5.4.2 Configure TalkSwitch Profile

5.4.2.1 TalkSwitch Profile

Select System Information -> VoIP Configuration

Figure 129: TalkSwitch profile
1 6 4                                           T A L K S W I T C H  US E R  GU ID E •  NOR TH AM ER ICA



TalkSwitch Profile tab
Use this tab to configure a TalkSwitch VoIP network.

TalkSwitch has a built-in IP server proxy/registrar/redirect. This facilitates 
the configuration and maintenance for multi-branch and telework 
applications.

A multi-location TalkSwitch system requires that one (and only one) unit be 
configured to act as the SIP server (Redirect Proxy/Registrar). For 
information on the SIP server, see 5.3.2 Select which TalkSwitch to use as the 
SIP network server on page 160.

This TalkSwitch location is the Proxy/Registrar:

If this location is designated to be the proxy/registrar server, click this 
checkbox. When it is enabled and other IP devices are registered with 
this system, any calls made within the group contact this device to 
resolve the destination location. Once the destination is resolved, the 
call is made directly from the source to the destination location. 

The TalkSwitch registrar supports digest authentication. The digest 
mechanism is a challenge/response protocol in which the client presents 
its credentials in response to a challenge from the server. This method of 
authentication is very secure. To enable authentication, select yes 
(digest) from the drop-down list under registrar authentication. Using 
authentication will allow only authorized devices to access the network.

Proxy Server Name:
If this location is acting as the proxy server, it is filled in automatically. 

If this location is not the proxy server, enter the IP address or domain 
name associated to the proxy server. If the server is using a different port 
number than the default, specify the port number after a colon at the 
end of the domain or IP address. 
Example: 222.234.432.234:5061

Registrar Server Name:
If this location is acting as the registrar server, it is filled in 
automatically. 

If this location is not the registrar server, enter the IP address or domain 
name associated to the registrar server. If a TalkSwitch 48-CVA is acting 
as the server, both the proxy server location and the registrar server 
location fields should have the same information. If the server is using a 
different port number than the default, specify the port number after a 
colon at the end of the domain or IP address. 
Example: VoIP.domain.com:5061
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Outbound Proxy:
If TalkSwitch is being provisioned with a VoIP service provider, enter the 
outbound proxy associated with the service provider.

Realm/Domain:
If this location is the proxy/registrar, you can assign a realm/domain 
name for your network. (e.g. abccompany.com). The Realm/Domain field 
may be required when TalkSwitch is being provisioned with a VoIP service 
provider. In this case, enter the realm/domain associated with the 
service provider. If this unit is not the proxy/registrar, it must have the 
same realm as the registrar server. 

User Name and Password section

User/Account: 
If this location is the proxy/registrar and you have enabled 
authentication, assign a user/account name to this unit. This account 
will be required by all other locations for registration purposes. 

If this unit is not the proxy/registrar and if authentication is required, it 
must have the same user/account name as the registrar server.

Password:
If this location is the proxy/registrar and you have enabled 
authentication, assign a password to this unit. This password is required 
by all other locations for registration purposes. 

If this unit is not the proxy/registrar and authentication is required, it 
must have the same password as the registrar server.

VoIP Lines
TalkSwitch offers the flexibility to share VoIP numbers with the TalkSwitch 
network and a service provider. You can reserve lines for use with one or the 
other depending on your requirements. 

VoIP lines available for use with the TalkSwitch network: 
By default, there are no restrictions on VoIP number use between the 
TalkSwitch and service provider profiles. If you need to give priority of 
availability to calls being placed in/out of this location on the TalkSwitch 
VoIP network, select an upper limit for the number of lines to use for 
each profile.  

Maximum number of VoIP lines for incoming calls:
The maximum number of VoIP numbers available is determined by how 
many lines are available (shared) with the TalkSwitch VoIP network. For 
business reasons, you might want to make all lines available for incoming 
calls and restrict the number of lines used for outgoing calls. It is 
recommended that at least one line be allocated for incoming calls.
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Maximum number of VoIP lines for outgoing calls:
The maximum number of VoIP numbers available is determined by how 
many lines are available (shared) with the TalkSwitch VoIP network. For 
business reasons, you might want make all lines available for incoming 
calls and restrict outgoing calls so that no incoming calls are getting 
missed. It is recommended that at least one line be allocated for outgoing 
calls.

Codec Options (button)
A codec is a method of compressing and decompressing audio signals for 
communication across digital networks. TalkSwitch supports 3 standardized 
VoIP codecs: 

• G.729 (default — low bandwidth) 
• G.726 (better voice quality — medium bandwidth) 
• G.711 (best voice quality — high bandwidth)

One of these codecs must be selected as the Preferred Codec. By default 
G.729 is used to accommodate the maximum number of concurrent calls.

Voice Activity Detection (VAD) analyzes an audio stream to detect the 
presence or absence of speech and distinguishes speech from background 
noise. VAD can be used to reduce voice bandwidth when no speech is 
detected and reduce unwanted noise transmission.

Figure 130: Codec

View Registrar Entries (button)
If this location is the designated SIP server (proxy/registrar), click this 
button to view which systems are registered with the SIP server. A window 
opens listing all TalkSwitch systems and gateways registered with this 
system. Client is the phone number assigned to a VoIP line. Contact is the 
information used by the SIP server to contact the client. It is comprised of 
the phone number, public IP address and part number. Expires is the amount 
of time, in seconds, that the client is registered with the SIP server before 
having to re-register.
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Figure 131: Registrar entries

View Registration Status (button)
Click this button to see if this system is registered with the designated 
SIP server. A window opens listing all registered system VoIP phone numbers. 
Client is the phone number assigned to a VoIP line. Status is the registration 
status (registered or not registered).

Figure 132: Registration status

5.4.2.2 Service Provider profile

Service Provider Profile tab
TalkSwitch CVA can register with VoIP service providers to make and receive 
calls using their service. Visit www.talkswitch.com/support to access a list of 
service providers that have been certified interoperable with TalkSwitch. 
Service Configuration Guides are also available for download. They contain all 
the specific necessary information to complete your configuration. 
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Information in those documents should be used instead of this guide. If 
there is no configuration guide for your service provider, follow the 
instructions below.

Figure 133: Service Provider profile

Service Provider Name:
Enter the name for your VoIP service provider. The name will be displayed 
elsewhere in the configuration software in areas related to VoIP service.

Proxy Server Name:
Enter the IP address or domain name associated with the proxy server, 
exactly as specified by your service provider. If the server is using a 
different port than 5060, specify the port number after a colon at the 
end of the domain or IP address. 
Example: 222.234.432.234:5061

Registrar Server Name:
Enter the IP address or domain name associated with the registrar server, 
exactly as specified by your service provider. If the server is using a 
different port number than 5060, specify the port number after a colon 
at the end of the domain or IP address. 
Example: VoIP.domain.com:5061

Outbound Proxy:
Enter the outbound proxy (if required) associated with the service 
provider.
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Realm/Domain:
Enter the realm/domain (if required) associated with the service 
provider.

VoIP Lines
The descriptions for the VoIP lines under the TalkSwitch Provider Profile tab 
below are the same as described in VoIP Lines on page 166.

• VoIP lines available for use with this Service Provider 
• Maximum number of VoIP lines for incoming calls 
• Maximum number of VoIP lines for outgoing calls 

Codec Options (button)
See Codec Options (button) on page 167 for a description.

View Registration Status (button)
See View Registration Status (button) on page 168 for a description.

5.4.3 VoIP Numbers

Each VoIP-capable TalkSwitch unit supports up to 12 VoIP phone numbers. 
You can configure unique call handling scenarios for each VoIP number. 

You must associate each VoIP number with either the TalkSwitch profile or 
the service provider profile. Any VoIP number may use any VoIP line (i.e. 
trunk) to make or receive a call.

Example: You might assign a general number for customers to reach the 
main auto attendant greeting and configure up to 11 other numbers so that 
the inbound calls will ring straight through to specific extensions in the 
office. A VoIP-capable TalkSwitch unit can support up to four simultaneous 
VoIP calls. VoIP numbers can be three or more digits long.

Each VoIP phone number assigned in a multi-location network must be 
unique (i.e. only used for one location). For convenience, TalkSwitch 
supports 50 VoIP location numbers (250 to 299) that permit direct dialing 
from any extension or auto attendant in the network.

If needed, you can also add numbers outside of that range and access them 
using hunt groups. You can assign these numbers when the 3-digit VoIP 
numbers have already been assigned or reserved. To do this:

1. Under System Information -> VoIP Numbers, select an available VoIP 
number and assign it to a unique number (i. e. 4004).

2. Select System Information -> Line Hunt Groups.
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3. Ensure that you have at least one line hunt group configured (i.e. 88) to 
Line Type: TalkSwitch VoIP Numbers.

4. Callers can now dial 88 from any extension to get a VoIP dial tone and 
then enter 4004 to reach the VoIP location.

Figure 134: TalkSwitch profile in System Information

For VoIP calls made through a service provider, the service provider will 
assign the VoIP numbers to be used for their service. To assist in assigning 
VoIP numbers for your network, use the 5.6 VoIP network administration 
form on page 180.

5.4.3.1 Assign VoIP phone numbers

TalkSwitch Profile section
All VoIP numbers are inactive when the system is first configured.

1. In the TalkSwitch System Configuration window, select 
System Information -> VoIP Numbers.

2. Select VoIP 1 and check the Activate VoIP Number box, the default profile 
for entering a phone number is the TalkSwitch Profile.

3. Phone numbers 250-299 have special functionality with TalkSwitch. 
They can be dialed directly from any extension or auto attendant and 
are routed automatically via VoIP to the destination with the number 
assigned to one of its ports. Part of the role of an administrator is to 
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keep track of all phone numbers assigned to each location to prevent 
duplicate numbers in multiple locations. We recommend that you use 
the numbers 250–299. It will facilitate calling from extensions and auto 
attendants.

For each TalkSwitch unit with VoIP lines on the network, you can assign 
up to 12 VoIP phone numbers, increasing the number of inbound VoIP call 
handling options available.

4. Repeat the above steps for VoIP numbers 2-12. 

5. For systems with multiple units, repeat the process for each TalkSwitch 
unit (click on the tabs labeled TalkSwitch 1, TalkSwitch 2, TalkSwitch 3, 
and TalkSwitch 4).

5.4.3.2 Configure call handling for VoIP numbers

Configuring call handling for VoIP numbers customizes TalkSwitch to fit the 
unique needs of your business. These call handling options are similar to the 
options available for your regular phone lines. Perform the following steps 
to configure VoIP call handling options for each networked TalkSwitch unit 
with VoIP lines.

1. In the TalkSwitch System Configuration window, select 
Call Handling -> VoIP Numbers.

2. Select your first VoIP number (It will be labeled with the number you 
assigned in Assign VoIP Phone Numbers above).

3. From the drop-down list next to On an incoming call during mode:, select 
the mode to configure (for example, Mode 1).

4. From the drop-down lists, select Ring extensions only, Play auto 
attendant, or Go to voice mailbox. 

• For Ring extensions only, select the extensions from the list (by default 
they are all selected).

Ensure that each number assigned is unique in the network.

If you are upgrading from release 3.21 or earlier software, numbers 
previously assigned to VoIP lines will be mapped to the 12 available VoIP 
numbers. The numbers may not appear on consecutive VoIP number tabs. 
Check each tab after the upgrade is complete.
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• For Play auto attendant, select which auto attendant to play (for 
example, 1), the number of rings to take place before the auto attendant 
answers (for example, after 2 rings), and the extensions to ring before 
the auto attendant answers. If you want the auto attendant to answer all 
calls immediately without ringing extensions, select immediately rather 
than the number of rings.

• For Go to voice mailbox, select the mailbox number (for example, 111) 
and the number of rings to occur before the call goes to the voice 
mailbox.

5. Repeat Steps 3 and 4 for each mode.

Figure 135: Call handling

6. Repeat this process to configure the VoIP numbers 2-12.

7. For systems with multiple units, repeat the process for each TalkSwitch 
unit (click on the tabs labeled TalkSwitch 1, TalkSwitch 2, TalkSwitch 3, 
and TalkSwitch 4).

5.4.3.3 Assign service provider phone numbers

1. In the TalkSwitch System Configuration window, select 
System Information ->VoIP Numbers.

2. Select 1 and check the Activate VoIP Number box, the default profile for 
entering a phone number is the TalkSwitch Profile. Select Service Provider 
Profile.

3. Enter one of the phone numbers, exactly as provided by your VoIP service 
provider. If your service provider requires a country code, enter it, 
otherwise leave it blank.
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4. Enter the User/Account information and Password for this particular 
phone number.

5. Repeat the above steps for VoIP numbers 2-12 as is required.

For systems with multiple units, repeat the process for each TalkSwitch unit 
(click on the tabs labeled TalkSwitch 1, TalkSwitch 2, TalkSwitch 3, and 
TalkSwitch 4).

Figure 136: Service provider profile in System Information

5.5  FAQ

How does VoIP work?
Voice over IP (VoIP), sends calls over the Internet or any Internet Protocol 
(IP) network by converting voice traffic into data packets. These packets are 
routed over the IP network the same way as other data, then reassembled at 
the point of arrival and converted back to voice. 

Does a VoIP call sound like a regular phone call?
Under the right conditions, VoIP calls sound as good or better than regular 
phone calls. Voice quality is affected by numerous factors, including how it 
is compressed and decompressed for delivery over the Internet and how 
packets are processed. A few steps can help ensure call quality. 

• High-speed connections on both ends of the call
Good quality VoIP requires a broadband connection to support more 
simultaneous VoIP calls. Please visit our site at www.talkswitch.com/
voip/voip_capacity.php to determine what your Internet connection 
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can support. Good quality VoIP is not possible over a dial-up modem 
connection.

• Choose the right codec for your location

1. The default codec is G.729 (8 Kbps), using approximately 25 Kbps 
bandwidth upstream and 25 Kbps bandwidth downstream for each 
call. G.729 provides very good call quality while minimizing 
bandwidth usage. 

2. The G.726 (32 Kbps) codec is a better quality solution compared to 
the G.729 codec. However, it requires more bandwidth per call. A 
G.726 call typically requires 50 Kbps bandwidth upstream and 
50 Kbps bandwidth downstream for each call. 

3. The G.711 (64 Kbps) codec provides the best voice quality. The trade-
off is the bandwidth requirement. G.711 calls typically require up to 
100 Kbps bandwidth upstream and 100 Kbps bandwidth downstream. 

What happens if the power goes out or if the IP network to VoIP fails?
To ensure a reliable network connection, all elements of the VoIP network 
should be connected to back-up power supplies (UPS). These elements might 
include LAN switches, routers, firewalls, broadband connection devices (i.e. 
cable modems, DSL modems), and VoIP devices. If the power goes out at the 
Internet Service Provider, then no VoIP calls can be made. Calls can still be 
placed over the regular phone lines.

Can a firewall prevent VoIP calls from passing through?
The purpose of a firewall is to control what kind of traffic enters and leaves 
your network. TalkSwitch 48-CVA is designed with embedded applications to 
help traverse firewalls properly. To allow VoIP calls to pass through your 
firewall, you may need to use the port forwarding feature on your firewall.

TalkSwitch 48-CVA uses the following ports for VoIP:

What is SIP?
The Session Initiation Protocol (SIP) is a signalling protocol used for 
establishing sessions in an IP network. A session could be a simple 2-way 
telephone call or it could be a collaborative multi-media conference session. 

Over the last couple of years, the Voice over IP community has adopted IP as 
its protocol of choice for signalling. IP is an RFC standard (RFC 3261) from 
the Internet Engineering Task Force (IETF), the body responsible for 
administering and developing the mechanisms that comprise the Internet. 

Format Type Unit 1 Unit 2 Unit 3 Unit 4

RTP (voice): UDP 6000-6006 6010-6016 6020-6026 6030-6036

SIP 
(signaling):

UDP 5060 
This port is mapped to only the SIP server unit.
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The IETF’s philosophy is simplicity: specify only what you need to specify. IP 
just initiates, terminates and modifies sessions. In this guide, the term IP is 
often used in place of VoIP.

TalkSwitch phone systems use the Appello® SIP Stack for VoIP 
communications. The Appello® SIP Stack was developed by TalkSwitch, 
a division of Centrepoint Technologies Inc.

What is a VPN? 
VPN stands for Virtual Private Network. It is a means of having the 
advantages of a private network on a shared public infrastructure like the 
Internet. 

Can a VPN help to carry data securely over the Internet?
A VPN provides security by using encryption/decryption. Using a process 
called tunneling, private data is encrypted and encapsulated before being 
sent across the network. The packets of information are sent to their 
destination. Only the ones with the correct protocol information can enter a 
company’s network.

A VPN is most useful for providing employees with remote access to the 
company network without compromising security. Encryption can have a 
negative impact on the call quality because of the increased overhead on the 
network connection. IPSec adds approximately 10% overhead to VPN traffic.

What’s the difference between a public IP address and a private
IP address?
A public IP address is a globally unique number that identifies a device on 
the Internet. If you want someone on the Internet to connect to you, they 
must know your public address. Also known as your real or external address. 

Private IP addresses are typically assigned to devices on a Local Area 
Network (LAN) and are not routable outside the LAN. Private IP addresses 
are usually in the range 192.168.x.x, 172.16.x.x or 10.x.x.x. These IP 
addresses are used where you have multiple computers all sharing the same 
Internet connection. 

To access the Internet, a computer or VoIP device must have an IP address. 
So what do you do if your ISP (Internet Service Provider) has provided you 
with only one IP address but you have more than one device that requires 
Internet access? The solution is to give each of the devices on the LAN a 
private IP address. A router makes them work by performing Network 
Address Translation (NAT — See the next topic for details). 

Addresses of the form 192.168.x.x, 172.16.x.x or 10.x.x.x are not recognized 
on the Internet and can only be used for private networks. For example, if 
you tell someone on the Internet to connect to you using a 192.168.x.x 
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address, it will not work. Instead, you must provide your real/public IP 
address.

What is NAT and how does it affect VoIP?
Network Address Translation (NAT) allows multiple devices to share the 
same external IP address to access resources on the Internet. NAT is 
typically used to allow all the devices in a subscriber’s local area network to 
access the Internet through a router with a single public IP address assigned 
by the Internet Service Provider. 

If a VoIP device is sitting behind a NAT, the private IP address assigned to it 
is not usable for communications with the entities outside the private 
network. The VoIP device must substitute the private IP address information 
with the proper external IP address/port in the mapping chosen by the 
underlying NAT to communicate with a particular public peer address/port. 
TalkSwitch can automatically check for the current public IP address and 
substitute the private IP address with the public address so that VoIP traffic 
is properly routed through the NAT.

What’s the difference between a static IP address and a dynamic 
IP address and what effect does this have on VoIP?
A static IP address is an address that is permanently assigned to a device. 
Typically, a static IP address has to be assigned by the network 
administrator or Internet Service Provider (ISP). 

A dynamic IP address is an address that is temporarily assigned to devices by 
a DHCP or PPP server that maintains and assigns a pool of IP addresses.

When deploying VoIP devices, it’s best to have a static public IP address. 
This prevents destinations from becoming unreachable for periods of time 
when the IP address changes. But since this can be an expensive option, 
TalkSwitch 48-CVA supports the ability to handle dynamic public IP 
addresses for the Internet connection. TalkSwitch automatically checks for 
the current public IP address and substitutes the private IP address with the 
public address, so that VoIP traffic is properly routed through the NAT.

What is a IP Proxy and Registrar?
The basic IP architecture is client/server in nature. The main entities in the 
IP server are the proxy, redirect server and the registrar.

TalkSwitch 48-CVA has the IP server fully integrated for easy deployment 
and maintenance of your VoIP network. If you are deploying a multi-site 
configuration which can comprise of TalkSwitch 48-CVA units, certified 
third-party gateways and certified third-party IP phones, one TalkSwitch 
48-CVA can act as the IP proxy and registrar. The other IP end-points will 
register with this TalkSwitch 48-CVA and all calls will be negotiated through 
this TalkSwitch48-CVA.
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When you first set up your VoIP device (TalkSwitch 48-CVA unit, gateway or 
phone), it will register itself with the TalkSwitch 48-CVA that is configured 
as the IP server so that calls can be directed to your location. 

When you initiate a VoIP call, your device (TalkSwitch 48-CVA unit, gateway 
or phone) will contact the TalkSwitch 48-CVA that is configured as the IP 
server to obtain the contact information for the destination you are trying 
to reach. Once the information is received, the call is established directly 
between your location and the destination. The IP server is no longer 
involved in 
the call.

If the location of the IP proxy and registrar has a dynamic IP address, you 
have to use the dynamic DNS since the IP server location becomes 
unreachable as soon as the IP address changes.

What is Dynamic DNS?
Dynamic DNS is a Domain Name Service used with dynamic IP addresses. DNS 
is used to allow devices to find other devices on the Internet by name rather 
than by IP address. Dynamic DNS allows you to use a Fully Qualified Domain 
Name (FQDN) to locate a device with a dynamic IP address. The FQDN does 
not change. There are companies on the Internet who can provide you with 
a DNS address, even if your IP address changes. Such companies are 
www.dyndns.org, hn.org or www.no-ip.com. Please consult with them how 
to use their service. The basic idea is that you will receive an address like 
myname.homeip.net which points to your IP address (i.e. 209.210.230.140). 
This is important for locations where the IP server resides and where the 
public IP address is dynamic. All other locations will point to this IP server’s 
domain instead of an IP address.

What is the drawback of using dynamic DNS?
When DNS records are updated, they have to be sent all over the world so 
that everyone will be aware of the changes. Basically, one DNS server 
connects to another and swaps information. In many cases, the DNS servers 
are updated very quickly. Updates should not take longer than 15 minutes 
to propagate throughout the DNS system. It is possible that propagation 
could take longer due to unforeseen traffic but it shouldn’t take much more 
than an hour at the most.

How often will my public IP address change?
This depends on the policies of your Internet Service Provider (ISP, the 
company that provides your Internet access). It can be a matter of days, 
weeks or even months before your IP address changes. A power loss or 
reboot to your cable or DSL modem usually results in the assignment of a 
new IP address. 
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TalkSwitch has the technology that helps keep this information up to date 
so that the system can function properly after an IP address change has 
been detected and updated.

What is a port number?
In an IP address like 64.26.209.103:5060, the port number is 5060, the 
number after the colon. 

Port numbers are required so that a computer or device can support multiple 
applications or streams of simultaneous data communication. Each stream or 
application uses a unique port number. You can think of it like mailing a 
letter to a friend in an apartment building at a specific address. You need to 
specify the apartment number as well as the address of the building, so that 
the mail can reach the correct final destination.  
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5.6  VOIP NETWORK ADMINISTRATION FORM

Use this form to keep track of phone numbers assigned to units that are part 
of a TalkSwitch VoIP network.

SIP server location________________________________________________

Equipment at SIP server location:____________________________________

VoIP phone numbers assigned to SIP server location:____________________

Telephone numbers assigned to unit

  

Location name Equipment VoIP phone number(s)

We trust that your TalkSwitch phone system will provide exceptional 
features, performance and value to your business. Should you have any 
further questions, please contact your authorized TalkSwitch reseller. If 
you purchased directly from TalkSwitch, 
visit www.talkswitch.com/support or call 
1.866.393.9960 (North America).

We welcome your feedback, comments and suggestions. Please e-mail us 
at info@talkswitch.com or write us at TalkSwitch, 1545 Carling Avenue, 
Suite 510, Ottawa, ON Canada K1Z 8P9.
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C H A P T E R  6

TROUBLESHOOTING AND 
SUPPORT 

6.1  TROUBLESHOOTING

Solutions to the following problems are described in this chapter:

• Problems that may occur during configuration
• Problems that may occur while using the TalkSwitch features

Some problems might be due to physical connections such as loose cables. 
Before you start to analyze possible configuration issues. See 1.13 Verifying 
the connections on page 28.

6.1.1 Problems that may occur during configuration

I am not able to retrieve settings from TalkSwitch.
• Reboot TalkSwitch.

On the TalkSwitch front panel, turn the power button off and back on.
• If you are connected via Serial port, open the configuration software. 

This will often correct any miscommunication that may have occurred 
between TalkSwitch and your PC.

• Make sure you do not have any communications programs running at the 
same time you are using the TalkSwitch configuration software. These 
can include Palm Pilot, Hot Sync, TalkWorks, digital camera software or 
others. These programs tend to occupy COM ports, making them 
unavailable for other programs.

I am unable to configure TalkSwitch using a touchtone phone. 
1. You cannot configure TalkSwitch using a phone sharing the same line in 

parallel. You have to configure TalkSwitch using one of the extensions 
plugged into the back panel of TalkSwitch. 
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2. You cannot configure TalkSwitch using touchtone keypad commands 
while the TalkSwitch configuration software is open. If the software is 
closed and you hear the prompt “I’m sorry, TalkSwitch is currently being 
configured”, reboot TalkSwitch by turning the power off and then back 
on. Wait until the lights stop flashing and the Data light is on solid. 

• If you are using a local extension, check if the extension has Direct Line 
Access to your telephone lines. If Direct Line Access is enabled, press 
Flash on an analog phone or   on a IP phone to receive an 
internal dial tone. Press  to enter command mode. Enter the correct 
password, if you have password protection.

• From an out-of-office phone, call into TalkSwitch and wait for the
the auto attendant. Dial  or  55 to enter command mode. Enter 
the correct password, if you have password protection. 

6.1.2 Problems that may occur while using the TalkSwitch features

6.1.2.1 The auto attendant

The auto attendant does not play when calls come in.
• Check if the line light on an incoming call is flickering while the phone 

is ringing. If not, replace the phone cord.
• Make sure you have an auto attendant message recorded.
• Check the mode TalkSwitch is currently running. 

Open the configuration software. In the lower right part of the 
About TalkSwitch window, check what it says for Current Mode. 
Select Call Handling -> Telephone Lines.

• On an incoming call during mode: change the mode if necessary.
Set the auto attendant to answer immediately.

The auto attendant message is broken up or very faint.
• Open the configuration software. 

Select Options -> Audio Controls. 
Adjust the Line Controls volume setting. 

• The quality of the microphone in the telephone handset that you used to 
record your auto attendant can affect the quality of your recording. Try 
recording the auto attendant from another extension/telephone.

The auto attendant answers calls before any of the extensions ring.
If TalkSwitch users wish to have their local extensions ring before the auto 
attendant picks up incoming calls, do the following:
• Open the configuration software.

Select Call Handling -> Telephone Lines.
Click the checkbox(es) in the section Extensions to ring on an incoming 
call before the Auto Attendant answers. 
Increase the number of rings. 

* *
#

# *
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The auto attendant is transferring calls to the wrong extension.
• Check if the extension jacks of your devices (phones, faxes) are plugged 

into the corresponding jacks on the TalkSwitch back panel (i.e. extension 
111 is plugged into E1).

The auto attendant answers calls, but does not transfer them to 
the extensions.
• Make sure your extensions are plugged into the extension jacks on the 

back panel of TalkSwitch (instead of your telephone wall jacks).
• Open the configuration software. 

Select Call Handling -> Auto Attendant.
In the At the Auto Attendant, perform the following actions section, check 
if the options that the caller can select are pointing to the correct 
extensions.

6.1.2.2 Music on hold

Callers hear the “One moment please” message and then total silence 
when the auto attendant transfers their call to an extension.
• There is a problem with the music source. Check all connections and 

the power.

Callers hear only silence when put on hold at an extension.
• Make sure you use the Flash or Link button on an analog phone, or the 

Hold button on a IP phone, to put callers on hold. If you use the Hold 
button on an analog phone, callers will be placed on hold at the phone 
itself and not through TalkSwitch.

• You have enabled the music on hold feature, but have not attached an 
audio device to the music jack on TalkSwitch.

• You have enabled play the Play music from file feature but have not 
loaded a .wav music file to TalkSwitch.

6.1.2.3 Call routing with local extensions and home phones 

Callers are disconnected when transferring calls from one extension 
to another.
• If you are using the hook switch rather than the Flash button to put 

callers on hold, you may be holding the hook switch down too long 
and disconnect.

I can’t use my conference/3-way calling feature from the 
phone company.
• You need to make sure you have checked the box indicating that you 

have 3-way calling or transfer and clear on the appropriate lines under 
System Information -> Telephone Lines in the configuration software.
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I’m unable to place intercom calls from a local extension.
• If the local extension has been set up for Direct Line Access to your 

telephone lines, you need to press Flash on an analog phone, or
   on a IP phone, before intercom calling. 

6.1.2.4 Answering and fax machines

The answering machine and/or fax machine picks up calls before they 
can be answered by telephone extensions.
• Check your settings under Call Handling -> Telephone Lines in the 

configuration software. Your fax machine and/or answering machine 
extension may be set to answer calls at the same time as your telephone 
extensions. To fix this problem, remove the fax or answering machine 
extension from the list of extensions to ring on an incoming call. 

Incoming faxes are not automatically detected and routed to the 
fax machine.
• ensure that you selected the correct extension for the field labeled if a 

fax call is detected, under  Call Handling -> Auto Attendant in the 
configuration software. 

• Not all fax machines emit a CNG tone that TalkSwitch can detect and 
route. Therefore, you may consider incorporating an additional method of 
fax routing. This could include the use of a dedicated fax line or a 
distinctive ring number.

• Many fax machines/modems will time-out or disconnect after 25 seconds 
on average if they have not connected with another fax machine/modem. 
If you clicked the checkbox next to After the Auto Attendant has finished 
playing and no selection has been made within, under Call Handling -> 
Auto Attendant, the fax call may time-out before it reaches your fax 
extension. If you have a long auto attendant message, you may want to 
shorten it or use another fax routing option. 

• The level of the auto attendant is too loud and is overpowering the CNG 
tone, affecting the detection. Try lowering the volume level of the 
auto attendant.

6.1.2.5 Other possible local extension problems

I am unable to access TalkSwitch lines with a local extension.
• Check your Direct Line Access settings under System Information -> 

Local Extension in the configuration software. If a local extension has 
not been given Direct Line Access to your telephone lines, you must dial 
9 or 81-88 to access a line.

• Check if Activate Automatic Route Selection is enabled under System 
Information-> Auto Route Selection. ARS can re-direct or block calls

* *
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My PC (internal or external) modem cannot dial out.
• If Direct Line Access to telephone lines is not enabled on the extension 

where your modem is connected, you will have to include a line hunt 
group prefix (9 or 81-88) before the dialing the modem number. 

One of the local extensions (telephones) does not ring.
• Some telephones require more voltage in order to ring. These phones are 

usually the older ‘Bell’ phones with mechanical ringers. These phones 
should not be used as TalkSwitch extensions.

• Make sure the telephone cord you are using between the phone and 
TalkSwitch is working properly. 

• Enure that the ringer is turned on.

Extension(s) ring, but there is no caller.
• This can occur when a caller hangs up after the auto attendant has 

begun to play. In some areas, the telephone company’s disconnect/clear 
signal is weak. The auto attendant may not be able to pick up the 
disconnect signal as soon as a caller hangs up. The auto attendant will 
not receive a response after playing its message and the call will fall 
through to your settings for After the Auto Attendant has finished playing 
and no selection has been made within, under Call Handling -> Auto 
Attendant, 

When I try to access voicemail, I hear a busy tone.
• Check your Direct Line Access settings under System Information -> 

Local Extensions in the configuration software. If a local extension has 
been given Direct Line Access to your telephone lines, you must first 
press Flash on an analog phone, or   on a IP phone, before 
dialing the mailbox. The same applies for dialing other extensions to 
initiate intercom calls.

6.1.2.6 Multiple TalkSwitch units connected to the same LAN

I can’t reach an extension across the LAN.
• Make sure the other unit is connected to the LAN and powered on.
• Pick up a local extension belonging to the other unit. If you hear a dial 

tone, check your LAN connections. On the rear panel, the top LED of 
the three LEDs next to the LAN port should be on. If there is no dial tone,  
make sure the unit is powered on.

The configuration does not show the other TalkSwitch unit(s).
• Check your LAN connections. Are you able to communicate with another 

extension on the other unit?
• Check the unit ID of each unit. If the lights on one or more units are 

flashing, there is a conflict with the unit ID numbers assigned to each 
TalkSwitch unit. Connect a phone to each TalkSwitch unit and lift the 
handset. It will tell you immediately if a unit ID number needs to be 

* *
T R O U B L E S H O O T I N G  A N D  S U P P O R T     1 8 5



assigned. Follow the instructions. You can dial  00  to check the 
unit ID of the unit you are connected to. Click the System Information 
link in the TalkSwitch configuration software.

After recording an auto attendant greeting, I can’t play it back.
• After recording an auto attendant on one of the TalkSwitch units, it will  

copy it to other TalkSwitch units on the LAN. During this process, you 
cannot listen to that particular auto attendant. Try again in a few 
minutes.

Calls are not always reaching my voicemail.
• When the system is in high use, all channels across the LAN might be in 

use, so that calls cannot be transferred to extensions or voicemail. If this 
situation happens frequently, consider optimizing the way the system 
uses the lines under System Information -> Line Hunt Groups  in the 
configuration software.  Click the checkbox next to For all Hunt Groups, 
hunt lines on same unit first. Also, ensure that frequently used 
extensions are connected to units with enough lines out to reduce 
LAN traffic.

Example: You have two TalkSwitch units, six lines and 12 employees. 
The Six lines have the hunt/rollover service from the phone company. 
Suggested setup: Plug the four highest traffic lines into unit 1. Also, 
connect the eight highest phone usage employee extensions to unit 1.  
Connect the remaining lines and extensions to unit 2. Under System 
Information -> Line Hunt Groups in the configuration software, make 
sure you have the For all Hunt Groups, hunt lines on same unit first 
checkbox enabled. This arrangement keeps most of the traffic on unit 1 
and any outbound calls made from any extension will go out on the same 
unit the extension is connected to. This also applies for inbound calls 
that are forwarded to remote extensions. The call will be forwarded out 
on a line belonging to the same unit that the call came in on. The call 
will only be forwarded on the other TalkSwitch unit if no line on that 
first unit is available.

Calls across the LAN are lower in volume.
• Check the line gain levels under Options -> Audio Controls in the 

configuration software. You may need to increase the line gain levels on 
one or more lines to compensate for high loss lines. If these controls are 
set incorrectly and your lines are problematic, you may hear an echo 
when calls are made across the LAN.

# #
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Problems that may occur with VoIP
I hear a re-order tone when I try to dial a VoIP location.
• Confirm the number dialed is actually part of the VoIP group (i.e. 

registered with the same proxy/registrar server as your TalkSwitch CVA, 
IP gateway or IP phone is registered with.

• Check that TalkSwitch has all proper settings in the IP configuration and 
VoIP configuration pages.

• Verify that the number you are dialing is registered with your TS proxy 
registrar. Go to System Information -> VoIP Configuration and click 
the View Registrar Entries button.

• Contact TalkSwitch for help at 888.332.9322.

Callers complain the sound is distorted or choppy.
• Your broadband connection may not have enough upstream bandwidth to 

support many simultaneous VoIP calls. Under Options ->  Audio 
Controls, you may need to disable the G.711 and G.726 codecs and only 
use G.729.

• You may have too much data traffic on your Internet connection at the 
same time you are trying to make voice calls. We suggest that you use a 
router that supports QoS (Quality of Service) for VoIP. 

When I call someone or they call me, voice is only heard in 
one direction.
• The cause of this problem is usually a result of a router being 

misconfigured with respect to port mappings. Ensure all required VoIP 
ports are mapped to your TalkSwitch unit. Also, ensure you use a static 
private IP address when connected to your router as this can also affect 
port mappings from the firewall/router.

• Use a router that supports the UPnP.

For more VoIP information, visit our support section at 
www.talkswitch.com/support.

6.2    SUPPORT 

If you are having problems with the configuration or operation of 
TalkSwitch, please read this section. If you don’t find the solution to your 
problem here, check the FAQ section located in the support area at our 
website at http://www.talkswitch.com/support. Select your TalkSwitch 
model and click Continue.

If you require further assistance, do one of the following: 

1. Contact your TalkSwitch dealer.

2. Contact our customer support department by e-mail: 
support@talkswitch.com.
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3. Call a technical support specialist at TalkSwitch: 
1-866-393-9960 (continental North America) or 613-725-2466 
weekdays between 9:00 a.m. and 8:00 p.m. EST. 

Please have the following information available when you call:

a) Your e-mail address and telephone number.

b) The serial number located on the bottom of TalkSwitch.

c) Your date of purchase.

d) The number of telephone lines that you have connected 
to TalkSwitch.

e) The telephone company services that you are using with TalkSwitch.

f) Your PC’s operating system (e.g. Windows 95, 98, ME, 2000, XP). 
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Appendices

A P P E N D I X  A
A PP E N D I X  A :  FUN C TIO N S  A N D  COM M A N D S  

FUNCTIONS AND COMMANDS 
About functions and commands
The following tables list numbers, functions and commands you can enter. 
The first part lists all the possible analog, IP, remote and ring group 
extensions as well as VoIP numbers and general voice mailbox numbers. 
Following are tables listing functions that can be entered from local and 
outside phones and at the auto attendant. The last table is a list of 
commands you can enter in command mode.

Extension numbers

Other 3-digit numbers

Unit 1 Unit 2 Unit 3 Unit 4

Local analog/IP 
extensions      

111–118            121–128 131–138 141–148

Remote 
extensions                      

210–219 220–229 230–239 240–249

Extension 
Ring Group

300–309 There are 10 ring groups for the entire 
system. 

VoIP location 
numbers

250–299 There are 50 external VoIP numbers.

General voice
mailboxes                     

410–419 420–429 430–439 440–449
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Functions you can access from local extensions

Keys Function performed

Flash/Hold If you are connected to a caller, Flash/Hold puts the 
call on hold and you hear the internal dial tone.

Flash/Hold Pressing Flash/Hold again at the internal dial tone 
retrieves the most recent call on hold. 

Flash/Hold at 
external dial tone

When you are connected to an outside line, pressing 
Flash/Hold switches you to the internal dial tone. 

On a regular phone, press Flash. On an IP phone, press Hold.

 and 
mailbox number 
(local, remote or 
general voicemail) 

Dials into a local, remote or general voice mailbox to 
leave a message.

  and 
mailbox number 
(local, remote or 
general voicemail) 

Accesses voicemail of a local, remote or general 
voice mailbox. You can retrieve messages, change 
greetings, password, etc.

   Accesses the mailbox(es) associated with your 
extension. 

Flash/Hold 4 Completes a transfer and returns to the internal 
dial tone.

On a regular phone, press Flash 4. On an IP phone, press Hold 4 followed by 
Dial, Send or  to complete the transfer.

 0 External PA access to make an announcement through 
the attached external PA system.

Flash/Hold 5 Disconnects the current caller and reconnects to the last 
caller on hold. 
A conference-call initiator can disengage the second 
conferenced party by pressing Flash 5.

Flash/Hold
 500–509

There are 10 parking spots for the entire system.
Press Flash/Hold to place a call on hold and dial 

 500–509 to assign a parking spot (park orbit).

*

* *

* * #

#

*

*
*

1 9 0 T A L K S W I T C H  US E R  GUI D E  •  N OR TH  A M E RI CA



 510 Parks a call automatically in the first available parking 
spot, starting at 500. Press Flash/Hold and  510 to 
place a caller in the next available parking spot (park 
orbit).

 
500–509

Retrieves a parked call. 
Dial from a local extension to pick up a parked call.

*
*

* *

Flash/Hold 6 Conference call for 3 parties.

Press Flash to put the first caller on hold, dial another 
extension or external number and press Flash 6.

 60
 61
 62

Disables Do Not Disturb at the current extension.
Enables Do Not Disturb at the current extension.
Toggles (enables/disables) Do Not Disturb at the 
current extension.

 7 and 
extension

Call pick-up at a specific extension.

Dial from dial tone to pick up a call ringing at 
another extension.

Flash/Hold 7 Press Flash 7 to cycle through queued calls on a 
first in/first out basis.

80 Accesses Same Line Connect when transferring an 
outside caller to another outside number.

9, 81–88 Dial to access an outside line.

On an IP phone, press Dial, Send or  after your entry for the following 
options:

 80 Enable play music source through PA output.

 84 and 
extension

Hands-free intercom call to an extension, automatically 
answered in speaker mode, enabling instant hands-free 
2-way communication (for supported sets). 

 85 and 
extension or
ring group number

Page a phone at an extension or the phones of a 
ring group.

 88 and 
account code

Attach account code to Call Detail Record (CDR) 
for last call.

 9 Call pick-up of any ringing line.

 or  55 Enters command mode. 

*
*
*

*

#

*
*

*

*

*
# *
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Functions you can access from outside phones
The list below shows the digits you can dial after the auto attendant 
answers. 

Keys Function performed

0 Performs the action defined in the auto attendant 
configuration (see 2.4.2 Auto attendant on page 80 
for details).

3-digit local ext. Rings at the local extension (i.e. 111). See Extension 
numbers on page 189.

3-digit 
remote ext.

Rings at the local extension (i.e. 211). See  Extension 
numbers on page 189.

300–309 
Extension Ring 
Groups

Rings all the extensions in the ring groups. There are 10 
ring groups for the entire system.

1, 2, 3, 4 and 5 Performs the action defined in the auto attendant 
configuration (see 2.4.2 Auto attendant on page 80 for 
details).

6 Enters call back configuration (see 2.5 Call Back/Call 
Bridge on page 98 for details).

7 and 
extension

Transfers a caller on hold to another phone system used 
in conjunction with TalkSwitch. As soon as the call 
connects to the other system, it disconnects from 
TalkSwitch.

9 and 81–88 Accesses line hunt groups for call bridge and is protected 
with the administrator password.

80 Accesses the call bridge feature using Same Line Connect 
Requires 3–way calling/conference on the line.

 and 
extension (local, 
remote or general 
voicemail)

Dials into a local, remote or general voice mailbox to 
leave a message. 

  and 
mailbox number 
(local, remote or 
general voicemail)

Accesses voicemail of a local, remote or general 
voice mailbox. You can retrieve messages, change 
greetings, password, etc.
 

*

* *
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A P P E N D I X  B
AP PE ND IX  B :  TA LKSW ITCH  AND TE LEP H ONE COM PANY CA LLING  SERV ICES

TALKSWITCH AND TELEPHONE 
COMPANY CALLING SERVICES
Many of the calling services offered by your local telephone company are 
compatible with and enhanced by TalkSwitch’s capabilities.

Caller ID (Call Display) — Displays the telephone number and name 
associated with an incoming call. 

TalkSwitch is capable of regenerating the caller ID and passing the 
information to its local extensions when incoming calls are transferred by 
the auto attendant. TalkSwitch regenerates the caller ID and passes it only 
to the selected local extension. If a local extension is configured to ring at 
least twice before the auto attendant answers, TalkSwitch will pass the 
caller ID information to that extension. If a call is transferred from one 
extension to another, the caller ID information will also be passed on. 
TalkSwitch can use the caller ID’s time stamp to set its internal clock.

Distinctive Ring — The ability to have more than one telephone number 
that callers can dial to reach the same telephone line. Distinctive ring is also 
referred to as: Ident-A-Ring; Ident-A-Call; Ring Master; Teen Service; Double 
Number; Personal Ringing; Ring Plus; Smart Ring Service; Special Ring; or 
Customized Ringing.

TalkSwitch can detect distinctive ring telephone numbers and use them to 
route incoming calls automatically. TalkSwitch gives you the ability to use 
two distinctive ring telephone numbers on all lines. Distinctive ring 
numbers on TalkSwitch lines also have access to the auto attendant and all 
other TalkSwitch call routing features.
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The TalkSwitch distinctive ring call routing features can be used in a number 
of ways: 

• Routing fax/modem calls
• Routing voice messaging
• Separating home office calls
• Using auto call back 

Each distinctive ring number has a distinctive ring cadence or ring sequence 
that allows you to identify the number that was dialed. 

Voicemail (Call Answer) — A service which gives callers the opportunity to 
leave a message when your phone line is busy or unanswered. TalkSwitch 
can work in conjunction with your telephone company’s voicemail service.

Call Waiting — If you are already on the phone, the call waiting service will 
emit a soft beeping sound to let you know you have another call waiting to 
be answered. 

To talk to the other caller when you hear a call waiting beep, press the Flash 
button twice. To return to the other caller, you will need to press the Flash 
button twice again. This service is not recommended, since TalkSwitch 
cannot answer the second call while the first call is already being routed by 
the auto attendant.

3-Way Calling/Conference — The 3-way calling/conference service allows 
you to add a third party to a call already in progress. 

The 3-way calling/conference service enhances TalkSwitch capabilities 
whether you have one or more telephone lines. Using a 3-way calling/
conference service gives you access to the TalkSwitch call forwarding, call 
back and call bridge features. 

Centrex/Plexar Transfer — The Centrex transfer service is similar in 
function to the 3-way calling/conference service. The primary difference is 
that two external parties can still remain in conversation after you hang up. 
TalkSwitch can disconnect after the transfer if you have this service and 
have enabled the Transfer and clear option under Option -> Miscellaneous  
in the TalkSwitch configuration software. 

Using one telephone line with Centrex transfer service gives you access to 
the TalkSwitch call forwarding, call back and call bridge features.

Hunt or Rollover — When using two or more lines, calls coming in on a 
busy line can be rolled over to an available line in a hunt pattern that you 
can set. There are two types of hunting — sequential and circular. 
Sequential hunting starts at the number dialed and ends in the last number 
in the assigned group. Circular hunting hunts all the lines in the hunting 
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group, regardless of the starting point. (It will only circle once through the 
hunt group). 

TalkSwitch has the same functionality available on all lines and can work in 
conjunction with the hunt and rollover services.

Call Hold and Flash
TalkSwitch detects Flash from regular phones to put calls on hold. A flash 
signal is produced by pressing the Flash or Link button on your telephone 
(Link is another name for Flash). If you do not have these buttons on your 
telephone, you can produce a flash signal by quickly depressing and 
releasing the telephone’s hang-up hook.

Single-Flash — is pressing the Flash or Link button once. You can also 
depress and release the telephone’s hang-up hook once.

Double-Flash — is pressing the Flash or Link button twice. You can also 
depress and release the telephone’s hang-up hook twice. When using your 
telephone’s hang-up hook to initiate a double-flash, do not try to initiate 
the second flash too quickly or you may disconnect your caller. 
Press and release the hang-up hook once, count to 2, then initiate the 
second flash.

When would you use double-flash?
1. If TalkSwitch is connected to any other system/service that uses flash to 

activate its features (e.g. a Key Telephone System, PBX, or telephone line 
with the Centrex service from your phone company).

2. If you are using any of your local telephone company services that are 
activated with flash (e.g. call waiting, 3-way calling/conference, etc.).

What does single and double-flash do?
TalkSwitch and the above-mentioned systems/services use flash to activate 
their calling features. TalkSwitch therefore needs a way to tell which (or 
whose) features you want to access when you press the Flash button. 

Using a single-flash: places the caller on hold. (The flash signal is not passed 
to the CO line, solving problems associated with flash causing a hang-up at 
some CO).

Using a double-flash: the first flash places the caller on hold, and the 
second flash (if pressed within 2 seconds) tells TalkSwitch to pass a flash to 
the CO line to activate the intended CO or PBX feature. 
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A P P E N D I X  C
AP PE ND IX  C :  TA LK SWITCH  AND POWER INTE RR U P TIONS

TALKSWITCH AND POWER 
INTERRUPTIONS

TalkSwitch settings and configurations
In the event of a power failure, your TalkSwitch settings and configurations 
will not be lost.

The TalkSwitch configuration is stored in non-volatile memory. Non-volatile 
memory means that your feature settings (configurations) remain in the 
TalkSwitch memory despite interruptions in the power supply. 

Calling features
In the event of a power failure, TalkSwitch features or capabilities, 
including VoIP will be unavailable except for local extension 114. You can 
make or receive calls on Line 1. When the power is restored, all TalkSwitch 
features and capabilities will be re-established. 

Mode scheduling and power interruptions 
When the power supply to TalkSwitch has been interrupted, TalkSwitch’s 
internal clock will continue to run for up to 12 hours. If you have enabled 
the automatic mode scheduling feature and it has been longer than 12 
hours, TalkSwitch will not function properly until the internal clock is reset 
via a caller ID call or with the TalkSwitch configuration software. When 
power is restored to TalkSwitch, it will check the time and determine the 
mode it should be running according to the configuration and set itself to 
that mode.

To check the current mode of operation:

1. Dial  at a local extension to enter command mode and enter a 
password if required. 

2. Dial 30 . TalkSwitch will report the current mode.

#

#
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A P P E N D I X  D
A PP E N DIX  D:  SA FE T Y  A ND  RE GU LA TO R Y  IN FO R M A TIO N

SAFETY  AND REGULATORY 
INFORMATION

Safety precautions

Before using TalkSwitch, please review and ensure the following safety 
instructions are adhered to:

1. Read, follow and retain instructions — All safety and operating 
instructions should be read, followed and retained for future reference 
before operating the equipment.

2. Heed warnings — All warnings on the equipment and in the operating 
instructions should be adhered to.

3. Temperature — Do not operate in environments where the temperature is 
below 0°C or 32°F. If the product was shipped in cold weather, please let 
the system warm up at room temperature for at least two hours before 
plugging it in to a power outlet.

4. Moisture — Do not place TalkSwitch in a high-humidity environment.

5. Heat — Never place TalkSwitch near heat sources such as radiators, floor 
registers or in direct sunlight. Do not stack units on top of each other.

6. Power supply — The equipment should only be connected to an approved 
power supply of the type described in the operating instructions or 
marked on the equipment. Use only the power adapter supplied with 
TalkSwitch.
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7. Damage requiring service — Do not attempt to service the TalkSwitch 
yourself. Unplug TalkSwitch and refer servicing to a licensed technician 
when:

• The plug or power cord has been damaged.
• TalkSwitch has been exposed to moisture.
• TalkSwitch does not appear to be operating properly or exhibits a 

marked change in performance.

Important Notices

FCC and IC Warnings
This equipment complies with ACTA TIA/EIA/IS-968A and Part 68 of the 
Federal Communications Commission (FCC) rules in the United States. It also 
complies with regulations RSS210 and CS-03 of Industry Canada and Science 
Canada. This equipment also complies with Part 15 of the FCC Rules, as well 
as ICES003 of Industry Canada. Operation is subject to the following two 
conditions: (1) this device may not cause harmful interference, and (2) this 
device must accept any interference received, including interference that 
may cause undesired operation of the device. 

FCC Part 15
This equipment has been tested and found to comply with the limits for a 
“CLASS B” Digital Device pursuant to Part 15 of the FCC rules. These limits 
are designed to provide a reasonable protection against harmful interference 
in a residential installation. This equipment generates, uses and can radiate 
radio frequency energy, and if not installed and used in accordance with 
these instructions, may cause harmful interference to radio com-
munications. However, there is no guarantee that interference will not occur 
in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment to an outlet on a circuit different to that which 

the receiver is connected.
• Consult the dealer or an experienced Radio/TV technician for help.

This CLASS B Digital apparatus meets all requirements of the Canadian 
interference-causing equipment regulations.

Changes or modifications not expressly approved by TalkSwitch could 
void the user’s authority to operate the equipment.
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ACTA TIA/EIA/IS-968A, FCC Part 68 and IC CS-03
Notice: The Industry Canada label identifies certified equipment. This 
certification means that the equipment meets telecommunications network 
protective, operational and safety requirements as prescribed in the 
appropriate Terminal Equipment Technical Requirements document(s). The 
department does not guarantee that the equipment will operate to the 
user’s satisfaction.

Before installing this equipment, users should ensure that it is permissible 
to be connected to the facilities of the local telecommunications company. 
The equipment must also be installed using an acceptable method of 
connection. The customer should be aware that compliance with the above 
conditions may not prevent degradation of service in some situations.

Repairs to certified equipment should be coordinated by a representative 
designated by the supplier. Any repairs or alterations made by the user to 
this equipment, or equipment malfunctions, may give the telecom-
munications company cause to request the user to disconnect the 
equipment.

Users should ensure, for their own protection, that the electrical ground 
connections of the power utility, telephone lines and internal metallic water 
pipe system, if present, are connected together. This precaution may be 
particularly important in rural areas.

A label is located on the underside of the base unit containing both the 
FCC registration number and Ringer Equivalency Number (REN) or the IC 
registration number and Load Number. You must, upon request, provide this 
information to your local telephone company.

The REN is used to determine the quantity of devices that may be connected 
to the telephone line. Excessive RENs on the telephone line may result in 
the devices not ringing in response to an incoming call. In most, but not all 
areas, the sum of RENs should not exceed five (5). To be certain of the 
number of devices that may be connected to a line, as determined by the 
total RENs, contact the local telephone company.

 Caution: Users should not attempt to make such connections themselves,  
 but should contact the appropriate electric inspection authority, or 
 electrician, as appropriate.

This equipment is compatible with inductively-coupled hearing aids.
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Service
If you are experiencing difficulty with your Model: CT-TS001.1 telephone 
equipment, please contact your reseller for repair and/or warranty 
information. See Appendix E: TalkSwitch One-Year Limited Warranty and 
Return Policy for more information.

If the equipment is causing harm to the telephone network, the telephone 
company may request that you disconnect the equipment until the problem 
is corrected.

This equipment cannot be used on public coin telephone services provided 
by the telephone company. Connection to party line service is subject to 
state tariffs.

The FCC requires that you connect your cordless telephone to the nation-
wide telephone network through a modular telephone jack (USOC, RF11C, 
RJ11W, or RJ14).

Your telephone company may discontinue your service if your equipment 
causes harm to the telephone network. They will notify you in advance of 
disconnection, if possible. During notification, you will be informed of your 
right to file a complaint to the FCC.

Occasionally, your telephone company may make changes in its facilities, 
equipment, operation, or procedures that could affect the operation of your 
equipment. If so, you will be given advance notice of the change to give you 
an opportunity to maintain uninterrupted service.
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A P P E N D I X  E
A P PE N D I X  E :  TA L KSW I TCH  O N E -YE A R  WA R R A N TY  A N D  RE TU RN  PO L I C Y

TALKSWITCH ONE-YEAR    
WARRANTY AND RETURN 
POLICY
TalkSwitch, a division of Centrepoint Technologies Inc. (“TalkSwitch”) 
warrants to the original end-user customer (“Customer”) that each new 
TalkSwitch product shall be substantially free from defects in materials and 
workmanship under normal use for a period of one (1) year from the date of 
the original purchase (proof of purchase required). The exclusive remedy 
and entire liability under this warranty will be for repair or replacement on 
a like-for-like basis at TalkSwitch’s option. 

The above warranty shall not apply to product defects resulting from 
(a) improper maintenance or installation; (b) misuse, neglect or accident; 
(c) damage from moisture or corrosive environments; (d) use of the power 
adapter with supply voltages other than that for which it is specified; 
(e) static discharges; (f) high voltage surges; (g) electrostatic discharges; 
(h) operation outside the product’s specification; or (i) failure to follow 
product instructions.

The warranty is void where (a) the serial number has been altered, removed 
or effaced; or (b) the product has been used in an application, country, 
region, locality, or connected to any network, other than those for which 
the product was intended to operate.

Condition: The original end-user customer acknowledges that he or she 
has read the limited One-Year Warranty and Warranty Disclaimers and 
understands the same and agrees to be bound by its terms and 
conditions.
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TalkSwitch shall not have any obligation to repair or replace product until 
the Customer returns defective product to TalkSwitch. Any replacement 
product may be either new or like-new, and may contain remanufactured 
parts, equivalent to new in performance. 

EXCEPT FOR THE EXPRESS WARRANTIES SET FORTH ABOVE, AND TO THE 
EXTENT PERMITTED BY APPLICABLE LAW, THE PRODUCTS AND STORAGE 
MEDIA ARE SUPPLIED ON AN “AS IS” BASIS AND THERE ARE NO WARRANTIES, 
REPRESENTATIONS OR CONDITIONS WHETHER EXPRESSED OR IMPLIED, 
WRITTEN OR ORAL, ARISING BY STATUTE, OPERATION OF LAW, COURSE OF 
DEALING, USAGE OF TRADE OR OTHERWISE, WITH RESPECT TO THE PRODUCT. 
TALKSWITCH SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR 
CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, DURABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT. 

IN NO EVENT SHALL TALKSWITCH BE LIABLE FOR ANY SPECIAL, INCIDENTAL, 
CONSEQUENTIAL, INDIRECT OR SIMILAR DAMAGES, INCLUDING ANY LOST 
PROFITS, LOST DATA, OR OTHER INCIDENTAL OR CONSEQUENTIAL OR PUNITIVE 
DAMAGES, WHETHER BASED ON CONTRACT, TORT (INCLUDING WITHOUT 
LIMITATION, NEGLIGENCE), OR ANY OTHER LEGAL THEORY, WHETHER OR NOT 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR WHETHER SUCH 
DAMAGES ARE FORSEEABLE. IN ANY EVENT, THE TOTAL AGGREGATE 
LIABILITY OF TALKSWITCH FOR DIRECT DAMAGES SHALL NOT EXCEED THE 
PURCHASE PRICE OF THE PRODUCT.

This warranty gives specific rights, and Customer may have other rights 
subject to jurisdiction. To the extent any part of this limited warranty 
statement is inconsistent with such local law, that part shall be deemed 
modified to be consistent with such local law.

DOC Compliance
This digital apparatus does not exceed the Class B limits for radio noise 
emissions for digital apparatus as set out in the Radio Interference 
Regulations of the Canadian Department of Communications.

The FCC Statement is located in Appendix D: Safety Precautions and 
Regulatory Information”.

Warranty Service
To be eligible to obtain warranty service you must retain proof of purchase 
and contact your reseller for warranty details. If you fail to provide proof 
of purchase, your reseller and TalkSwitch, a division of Centrepoint 
Technologies Inc. (“TalkSwitch”) will not be able to provide you with any 
kind of warranty service.
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To obtain warranty service, products must be sent to your reseller or a 
service facility designated by TalkSwitch. The original end-user purchaser 
shall pay all shipping charges, duties and taxes for products sent to 
TalkSwitch for warranty service. TalkSwitch shall pay for return of the 
product to the end-user purchaser.

If purchased from a reseller:

Contact your reseller and obtain a Warranty Return Authorization (WRA) 
number if required. 

If purchased from TalkSwitch: 

Please contact the Technical Support department at TalkSwitch to obtain a 
WRA number — (866) 393-9960 toll free in continental North America or 
(613) 725-2466. Please have your model and serial number available when 
you call.

If the product is being shipped from outside of Canada, the following 
statement must be included on the package: 
Canadian Goods Being Returned to Canada.

Failure to obtain a WRA number and include the necessary information 
will result in the package being refused. 
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A P P E N D I X  F
AP PE ND IX  F :  SPECIF IC ATIONS

SPECIF ICATIONS
VoIP features (models with VoIP trunks only)
• Embedded SIP server and user agents
• Integrated registrar
• Can use external SIP servers as required
• RTP
• G.711µ-law/A-law, G.726 (32 Kbps), G.729a
• G.168 echo cancellation
• VAD, silence suppression
• Adaptive jitter buffer
• Packet loss concealment
• Fax tone detection

System 24-CA 48-CA 48-CVA
Analog trunks 2 4 4

VoIP trunks 0 0 4

Analog extension interfaces 4 8 8

LAN interface 0 RJ-45 Ethernet

USB interface 1 1 1

Serial interface (RS-232, 9-pin) 1 1 1

Memory expansion 1, 3, 4.5 and 9 hour memory cards

Music input Phono jack (1/8" mono) or stored .wav file

PA output Phono jack (1/8" mono) or stored .wav file

Power source 120 VAC, 60 Hz — In/16 VAC, 1.5 A — Out

Power-failure line to 
extension jacks

Extension 4 connects to Line 1
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Regulatory Approvals
ACTA TIA/EIA/IS-968A and FCC Part 68, Industry Canada CS-03,
FCC Part 15B, Industry Canada ICES-003.

Power adapter complies with UL and CSA

Analog extension interface
Trunk type Loop start

Connector type RJ-11, 2-pin

Interface impedance 600 ohms

Loop range 0–600 ohms

Hook flash supported Yes

On-hook voltage 35 volts

Off-hook loop voltage 
source

35 volts

Off-hook loop currant 23 mA to 40 mA

Dial tone level -2.4 dBm

Ringing voltage 90 volts RMS

Ringing frequency 20 Hz – True sine wave

Total ringing load 5 REN

Analog trunks
Connector type RJ-11, 4-pin

Trunk type Loop start

Interface impedance
Configurable, 600 ohms, 600 complex, 900 ohms, 
900 complex

Ringing impedance 3,900 ohms

Ringing sensitively 45 volts RMS @ 20 Hz

REN 0.78

Longitudinal balance 69 dB

Signal level -10 dB

Distinctive ring supported Yes

Caller ID support FSK, all lines

Dimensions (H x W x L)
Metric 51.6 mm x 203.2 mm x 213.4 mm

Imperial 2.03" x 8" x 8.4"

Weight 24-CA 48-CA 48-CVA
Metric 0.64 kg 0.88 kg 0.90 kg

Imperial 1.41 lbs 1.94 lbs 1.98 lbs
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A P PE N D IX  G :  COPYR I GH T A N D L ICE NSI NG N OTI CES

COPYRIGHT AND LICENSING 
NOTICES
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TalkSwitch copyright © 2006 — All Rights reserved.
TalkSwitch is a division of Centrepoint Technologies Inc.
TalkSwitch software is protected under copyright law and international 
treaties. Unauthorized reproduction or distribution of TalkSwitch software, 
or any portion of it, in any form, may result in severe civil and criminal 
penalties, and will be prosecuted to the maximum extent of the law.

TalkSwitch phone systems use the Appello® SIP stack for VoIP 
communications. The Appello® SIP stack was developed by TalkSwitch — a 
division of Centrepoint Technologies Inc.

TalkSwitch and Appello are registered trademarks of Centrepoint 
Technologies Inc.

Elements of TalkSwitch software are protected under additional copyrights 
listed below, and subject to the terms and disclaimers listed below.

A) Copyright © 1998 by the Massachusetts Institute of Technology.
Permission to use, copy, modify, and distribute this software and its 
documentation for any purpose and without fee is hereby granted, provided 
that the above copyright notice appear in all copies and that both that 
copyright notice and this permission notice appear in supporting 
documentation, and that the name of MIT not be used in advertising or 
publicity pertaining to distribution of the software without specific, written 
prior permission. MIT makes no representations about the suitability of this 
software for any purpose. It is provided “as is” without express or implied 
warranty.

B) Copyright © 2000-2003 Intel Corporation. All rights reserved. 
Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met: 



• Redistributions of source code must retain the above copyright notice, 
this list of conditions and the following disclaimer. 

• Redistributions in binary form must reproduce the above copyright 
notice, this list of conditions and the following disclaimer in the 
documentation and/or other materials provided with the distribution. 

• Neither name of Intel Corporation nor the names of its contributors may 
be used to endorse or promote products derived from this software 
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL INTEL OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT 
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

C) Copyright © 2001-2003 Swedish Institute of Computer Science. 
All rights reserved. 

Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, 
this list of conditions and the following disclaimer.

• Redistributions in binary form must reproduce the above copyright 
notice, this list of conditions and the following disclaimer in the 
documentation and/or other materials provided with the distribution.

• The name of the author may not be used to endorse or promote products 
derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE AUTHOR “AS IS” AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT 
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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D) Copyright © 1991-1992, RSA Data Security, Inc. Created 1991. 
All rights reserved.

License to copy and use this software is granted provided that it is identified as 
the “RSA Data Security, Inc. MD5 Message-Digest Algorithm” in all material 
mentioning or referencing this software or this function. License is also granted 
to make and use derivative works provided that such works are identified as 
“derived from the RSA Data Security, Inc. MD5 Message-Digest Algorithm” in all 
material mentioning or referencing the derived work. RSA Data Security, Inc. 
makes no representations concerning either the merchantability of this software 
or the suitability of this software for any particular purpose. It is provided “as is” 
without express or implied warranty of any kind. These notices must be retained 
in any copies of any part of this documentation and/or software.

E) Copyright © 2004 Magnus Damm <damm@opensource.se>
 All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of 
this software and associated documentation files (the ‘Software’), to deal in the 
software without restriction, including without limitation the rights to use, 
copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the 
software, and to permit persons to whom the software is furnished to do so, 
subject to the following conditions:
The above copyright notice and this permission notice shall be included in all 
copies or substantial portions of the software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS 
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN 
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 
SOFTWARE. 

F) Copyright © 1991, 1999 Free Software Foundation, Inc. 
3rd-Party IP Phone configuration library. 
Copyright © 2006 Centrepoint Technologies, Inc.
This library is free software. You can redistribute it and/or modify it under the 
terms of the GNU Lesser General Public License as published by the Free Software 
Foundation, either version 2.1 of the License, or (at your option) any later 
version. This library is distributed in the hope that it will be useful, but 
WITHOUT ANY WARRANTY; without even the implied warranty of 
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser 
General Public License for more details. You should have received a copy of the 
GNU Lesser General Public License along with this library. If not, write to the 
Free Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, 
MA 02111-1307 USA.
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HOME/OFFICE  WIRING GUIDE
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Basic residential phone wiring
Looped wiring
Loop wiring is common in most residential houses. The demarcation point 
(see page 2) breaks the incoming phone lines into ‘loops’ that can run the 
length of the entire house, but are often broken into smaller loops that 
serve different areas of the house.

All houses have at least one phone line, however it is also common to have 
two or more incoming phone lines. Whether you are wiring single, dual or 
multiple lines, you will still be using phone cord with four wires. How each 
phone jack is wired to the loops will determine if the phone jack is on 
Line 1 or Line 2.

This document describes single- and dual-line wiring configurations. Many 
of the processes can also be applied to multi-line wiring.

Residential Building

Loop 2

Loop 1

Incoming 
telephone lines

Demarcation point

Phone jack



Depending on how the jack is wired, the phone can be plugged into Line 1, 
Line 2, or both.

Single-line wiring

For a single incoming phone line, all 
phones in the building will usually be 
wired using the RED and GREEN wires of 
the phone cord. The other two wires, 
BLACK and YELLOW, are not used.

The demarcation point connects the 
incoming RED and GREEN pair to various 
loops within the building. It is probable 
that the building is also wired with a 
BLACK and YELLOW pair, however these 
are not connected to any wall jacks.

Dual-line wiring
Two incoming phone lines are denoted in 
pairs, usually the RED and GREEN are used 
as Line 1, and the BLACK and YELLOW are 
Line 2. All four wires are looped 
throughout the building so that each jack 
has access to Line 1 and Line 2. How each 
jack is connected to the RED, GREEN, 
BLACK, and YELLOW wires determines if it 
is connected to Line 1, Line 2, or both. 

Demarcation Point
The demarcation point is the point of 
interconnection between the telephone 
company facilities and your building.

Location: It is usually a box located inside 
the building, within 15 feet of the 
incoming phone wiring. In newer houses, 
it may be located near the fuse box.

Wiring: The box will contain at least four 
posts used to branch the incoming wiring 
to the internal phone wiring. The RED 
post should have all the RED wires 
attached to it, the GREEN should have all 
the GREEN wires attached etc.

This demarcation point shows two lines (four wires) wired as two loops.
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Home and home office wiring options prior to adding TalkSwitch

All phones are connected together in a single loop (or in multiple loops)

The phones are all wired to Line 1. If you have two or more incoming lines, 
the phones can be wired to Line 1, Line 2 or even both lines for dual line 
phones.

Prior to adding a TalkSwitch, all phones in the home ring in unison when a 
call comes in. Home phones do not have TalkSwitch functionality and rely 
on phone company features for any enhancements.

Choose a wiring method (Option 1 or Option 2 below) that best suits your 
needs.

OPTION 1 — TalkSwitch phones separate from home phones
Advantages
• Easy to set up. May not require any wiring changes when used with one 

incoming line.
• You can still use some of TalkSwitch’s features from the home phones. 

Disadvantages
• Your home phones and office phones are not fully integrated together. 

For example, calls to the office cannot be forwarded to the home phones.
• Home phones don’t have access to voicemail and other TalkSwitch 

features. 
• All phones ring at the same time for incoming calls.

D

Incoming phone lines

Residential building

LEGEND:

D

E
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Connecting to phone lines

Using one phone line
single-line phone cord — 2 pins

Using two phone lines

wall jack to 

single-line phone cords — 2 pins

Using a dual-line phone jack
dual-line phone cord — 4 pins

wall jack to 

LAN

MUSIC PA E1 E2 E3 E4

E5 E6 E7 E8

L2 USB SERIAL POWER

L4L3/L4

L1/L2
PF

Connecting to TalkSwitch rear panel  

from wall jack to TalkSwitch L1/L2
This shows a single or a dual line 

If you have two single lines, you will need to connect to jack L1/L2 and jack L2.

To office extensions, 

using single-line RJ-11 cabling
phones and/or fax machines

wall jack to 
 TalkSwitch L1/L2  TalkSwitch L1/L2 and L2 

TalkSwitch L1/L2

LEGEND:

D

E
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OPTION 2 — TalkSwitch controls incoming lines and phones
Advantages
• Home phone system and office phone system are integrated together.
• Calls to the home can be forwarded to the office and vice versa.
• The home phones have all the call handling capability as the office 

phones including voicemail, call cascade, mode scheduling, call 
forwarding etc.

• Suitable for one or two incoming phones lines.

Disadvantages
• Requires a little more wiring, and additional cabling.

1. Remove the wiring to the house loops.  

2. Disconnect any additional house loops that may also be connected. Only 
one loop wiring is shown for clarity.

3. Tighten the screws connecting the incoming wires to their respective 
posts.

• Use an RJ-11 (single line or dual line) to connect to the TalkSwitch.  Plug 
the RJ-11 into jack L1/L2.

Re-wiring demarcation point

To house loops

Incoming phone lines from 
telephone company

To TalkSwitch incoming line
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1. Add an extension block next to the previous demarcation point.

2. Take the previous house loop wiring and connect them to the four posts 
of the extension block.

3. Use an RJ-11 (single line) to connect from the TalkSwitch.  Plug the 
RJ-11 into a TalkSwitch extension, jack E1 through E8.

D E

111 112 113

114 114

114

Adding extension block

To TalkSwitch
extension

To house loops

LEGEND:

D

E
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2

D E

111 112 113

114 114

114

Connecting to TalkSwitch

LAN

MUSIC PA E1 E2 E3 E4

E5 E6 E7 E8

L2 USB SERIAL POWER

L4L3/L4

L1/L2
PF

Connecting to TalkSwitch From demarcation point,
use a dual-line phone cable from 
the demarcation point to jack L1/L

rear panel

To extension block,
use a single-line phone 
cable from jack E4

Ext 113: To fax machine (optional) from jack E3
Ext 112: To phone from jack E2

Ext 111: To phone from jack E1
To office extensions, 
phones and fax machines

RJ-11 cabling can go up to 100 feet from the TalkSwitch without affecting voice quality. 
You may extend the lines farther although you may suffer voice quality.

Cabling can be run along baseboards, moldings, threaded between walls, and hidden under carpets. 
Keep the cords in corners and along edges to help hide it, and avoid high traffic areas.

LEGEND:

D

E
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1. Use dual-line phone cable to connect from the demarcation point to 
TalkSwitch. You will need to purchase the dual-line phone cable 
(available at most hardware stores) or wire it and crimp it yourself. Do 
not use the supplied RJ-11 cable as it is only a single-line cable.

2. Use the single-line RJ-11 phone cord supplied with TalkSwitch to connect 
from the TalkSwitch extension to the extension block.

3. Connect the office phones to the TalkSwitch using RJ-11 cabling supplied 
with TalkSwitch or the cables supplied with your phone.
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GLOSSAR Y
 Star/asterisk sign
The character at the bottom left of your touchtone telephone number pad.

 Number/pound sign
The character at the bottom right of your touchtone telephone number pad.

3-way calling/conference call
Connecting three parties together for one telephone conversation. 
TalkSwitch offers its own 3-way conference feature the same as the 3-way 
conference service offered by telephone companies. 

Analog (see also digital)
Analog devices (phones, answering machines, etc.) transmit and receive 
sound in waves. The telephone lines in most homes are analog. 

Call back 
If call back is activated, it instructs TalkSwitch to call you back at a preset 
out-of-office telephone number. With call back you can access the 
TalkSwitch long-distance plan while you are away. TalkSwitch offers 
automatic call back and prompted call back.

Call bridge (see DISA)

Call forward
Call forward is used to forward calls to one of the remote extensions.

Caller ID
A service provided by telephone companies, transmitting information about 
calls (caller’s name, telephone number, time of call, etc.). 

Call waiting
A service provided by telephone companies, allowing you to accept a second 

*

#
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incoming call on a telephone line that is already in use. Call waiting allows 
you to toggle from one caller to the other.

Centrex/Plexar
Central office exchange service. The telephone company offers PBX features on 
a ‘pay-per-service’ basis. This service may not be available from all telephone 
companies. Centrx/Plexar call switching happens at a local telephone 
company instead of your company’s premises. 

CNG
A tone emitted by most fax machines to initiate contact with another 
fax machine.

CO 
Central office of a telephone company.

COM port
Communications port. If you connect your TalkSwitch unit to your PC with a 
Serial cable, the COM port communicates with your TalkSwitch. It creates an 
internal virtual pathway to transmit data to and from the Serial port and the 
software. Most PCs have four COM ports. 

Communications software
Software to send and receive data over telephone lines via modems.

Compression
Reduces the data size. It saves data storage space, bandwidth and 
transmission time. 

Conference call
Connecting three or more parties for one phone conversation. They can be 
internal or external TalkSwitch parties or remote callers.

Configuration
The way the system is set up. The configuration software defines the settings 
of the TalkSwitch system. These settings determine what each TalkSwitch 
feature will do and when and how it will do it. 

Connector
The end of a cable that plugs into a port or interface to connect one device 
to another. 

Digit
A whole number from 0 to 9. The numbers on your telephone keypad 
are digits.

Digital (see also analog) 
Digital devices (phones, answering machines, etc.) convert analog waves to 
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digital signals for data storage or transmission over digital lines. The digital 
signal is converted back to analog waves that you can hear.

DISA (call bridge)
Direct Inward System Access. Allows you to make long-distance calls from 
anywhere in the world over your PBX using an access number and an 
authorization code.

Distinctive ring
A service provided by some telephone companies to distinguish two different 
telephone numbers using the same telephone line (i.e. fax machine). 
TalkSwitch can detect one, two and three ring bursts per ringing cycle to 
provide different handling for incoming calls.

Driver
The software that controls a device (printer, disk drive, modem, etc.). The 
driver acts as a translator between the device and the programs that 
use it.

DTMF
Dual-tone Multi-frequency. It is the system used by touchtone telephones. 
DTMF assigns a specific frequency (tone) to each key so that it can be 
identified by a microprocessor.

Dual-line telephone
A telephone allowing you to make and receive calls on two separate 
telephone lines.

Extension 
See Local extension or Remote extension.

FCC
Federal Communications Commission. The FCC is the federal regulatory 
agency for the United States, responsible for the regulation of interstate and 
international communications by radio, television, wire, satellite and cable.

Firmware
Firmware is a combination of software and hardware. Microchips that have 
data or programs recorded on them are called firmware.

Flash button
A button on your telephone. Pressing the Flash button has the same effect 
as pressing the Link button or pressing and releasing the hang-up hook on a 
telephone. All of these actions send a signal to TalkSwitch to put calls on/off 
hold.
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Icon
A small picture representing a program, an action or a feature in the 
configuration software. When you click on an icon, the program, action or 
feature is activated. 

IETF
Internet Engineering Task Force. Develops and promotes Internet standards 
like TCP/IP and SIP protocols. 

Intercom
A dedicated voice service within a specified user environment. TalkSwitch 
offers intercom capabilities between its local extensions.

Interface
Connects two separate entities. A user interface is the part of a program that 
you see on your computer screen and that connects you to the computer.

IP address 
Internet Protocol. The standard protocol used by devices to communicate over 
a computer network. The IP address is a unique number or name that 
identifies the device. 

IP extension
An extension that has its own IP address utilizing the Internet protocol in 
connection with VoIP.

IP phone
See IP extension.

ISDN
Integrated Services Digital Network.

ISP
Internet Service Provider. Facilitates access to the Internet for end-users. Most 
ISPs are telephone companies. Their services include domain name 
registration, web hosting, leased line access, etc.

Keypad 
The push buttons on a telephone.

Keypad commands
Combinations of digits used to configure TalkSwitch from a touchtone 
telephone.

LED
Light Emitting Diode. An device that lights up when electricity is passed 
through. TalkSwitch has five LEDs on its front panel letting you know which 
lines are in use and three on the back panel beside the LAN port. 
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Line 1, 2, 3, or 4
A jack or plug-in on the back panel of TalkSwitch which can accept an RJ-11 
plug from a telephone line or PBX system. You can plug in a single-line 
telephone cable into this jack and it becomes a usable TalkSwitch line.

Link button
The Link button has the same effect as the Flash button or pressing and 
releasing the hang-up hook on most telephones. On some telephones, the 
function of the Link button is internal to the telephone and pressing it has 
no effect on TalkSwitch.

Local extension 
A local extension is any telephone or analog device (answering machine, fax, 
etc.) plugged into one of the extension jacks on the back panel of your 
TalkSwitch.

Modem
Acronym for MODulator-DEModulator. A modem is a device that converts 
digital information from a computer into analog signals for transmission 
over telephone lines and vice-versa. 

Modes
TalkSwitch supports different time and day modes of operation, providing 
different call management depending on the current mode of operation.

Monitor (TalkSwitch monitor)
A feature included with the configuration software. The monitor provides a 
graphical representation of telephone traffic as it flows through the system.

Network
A group of two or more computer systems linked together.

PBX
Private Branch eXchange. A PBX is a private telephone network used within 
an enterprise. The PBX controls access to telephone lines and services. It 
allows many users to share a smaller number of telephone lines using 
extensions and have access to additional call handling benefits (call hold, 
intercom calling, etc.). TalkSwitch is a small PBX. 

Phone load
see Ringing equivalency.

POP3
The post office protocol (POP) is a standard Internet protocol for retrieving 
e-mail from a remote server. Most subscribers to an Internet service provider 
have e-mail accounts using POP3 (3 is the version number).
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Prompt
Recorded instructions played to a caller by TalkSwitch. Prompts are also used 
to provide instructions when you configure TalkSwitch using a telephone 
keypad.

PSTN
Public Switched Telephone Network. Your incoming phone line is on a PSTN.

Registered jacks 
Telephone and data plugs registered with the FCC.

Remote extension
A call forwarding number that can be a telephone number in any location, 
set up as a virtual extension of the TalkSwitch unit. The remote extension is 
assigned an extension number and has a voice mailbox.

REN
Ringer Equivalency Number. A number determined in accordance with the US 
code of federal regulations. It represents the ringer loading effect on a line. 

RJ-11
Registered jack 11 is used to connect single dual-wire telephone lines. It is 
used with telephones, cordless phones, fax machines and modems.

RJ-14
Registered jack 14 usually connects dual-line telephone devices and supports 
four conductors.

RJ-45
Registered jack 45 supports eight conductors and is generally used for 
networking applications. 

RTP
Real-time Transport Protocol. It defines a format for delivering audio and 
video files over the Internet. 

Routing
Determining the path that a message or call has to take over circuits. 
TalkSwitch routes incoming calls according to the configuration. 

Serial communication
A type of electronic communication requiring data bits to be sent one after 
the other, unlike parallel communication. Modems rely on serial 
communication to send data over telephone lines.

Shortcut key
A key combination that causes a specific command to be executed. Shortcut 
keys combine the Ctrl or Alt keys with other keys. (e.g. Ctrl and C is the 
shortcut key to copy selected items). 
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SIP
Session Initiation Protocol. A signaling protocol, developed by the Internet 
engineering task force (IETF). 

SIP server 
A server using the SIP protocol to manage calls between SIP devices.

Serial port
Serial ports are physical plug-ins. They allow two devices to exchange data. 

SMTP
Simple Mail Transfer Protocol. The standard for e-mail transmission across the 
Internet. SMTP is a text-based protocol. 

Terminal adapter
A device that allows analog devices to be used on digital lines (ISDN). 
Terminal adapters are similar to modems.

TX/RX
Transmit and receive data.

UDP
User Datagram Protocol. An Internet protocol which allows applications on a 
computer network to exchange short messages (datagrams).

UPnP
Universal Plug and Play. Allows networked devices to connect seamlessly in 
home and corporate environments using Internet-based communication 
standards. 

USB
Universal Serial Bus. USB connection supports more bandwidth than a Serial 
or parallel connection.

Virtual
The term ‘virtual’ refers to something that is not physically plugged in. 

Voicemail (call answer)
A service provided by TalkSwitch or telephone companies giving callers the 
opportunity to leave a message when your phone is busy or unanswered. 

VoIP
Voice over IP. Sending voice over an Internet connection.

VPN
Virtual Private Network. A communication network used within a company or 
organization to communicate over a public network. VPN message traffic is 
carried on Internet infrastructure using standard protocols.
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A
Administration

system password 35
Announcements

configuring 67, 78
recording 141

Audio controls 107
extensions 107
lines 107

Auto attendant 80
adding and configuring 80
additional features 86
automatic fax detection 85
erasing messages 83
loading messages 83
receiving calls with... 117
receiving calls without... 118
recording messages 82
routing options 84
troubleshooting 182
working with messages 82

Automatic route selection 44
permissions 105

C
Call back/call bridge 98

auto call back 99
prompted call back 102

Call bridge 103
Call cascade 90

examples 97
extension ring groups 95
local extensions 90
remote extensions 93

Call conference 125
SIP extension 131
telephone company service 41

Call detail record (CDR) 147
data analysis 151
enabling 147
retrieving data 148

Call forward 135
screening options 136
to a remote extension 60
to a ring group 63
to remote extension (music on 

hold) 142
Call handling

auto attendant 80
local extension 119
local extensions 90
modes 78
remote extensions 93
telephone lines 87
VoIP numbers 170

Call queue
caller in queue reminder 110
cycling through queued calls 191
queue at ring group 85
queue call (call cascade) 91
queuing and retreiving 123
to a single extension 123
to an extension ring group 124

Call routing
auto attendant routing 

options 84
call cascade 90
troubleshooting 183
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Call transfer
configuring transfer options 108
from a remote extension 60
from an analog extension 120
same line connect 59
screened transfer 121
settings (music on hold) 66
to a remote extension 60
to a ring group 63
troubleshooting 183
unscreened transfer 120

Caller ID
local extensions 55

Carrier codes 46
Configuration software 2

installing 5
IP configuration 37
pull down menus 30
screen navigation 33
system requirements 2
troubleshooting 181
upgrading 5

Connecting devices 15
audio for music on hold 21
fax machine 19
incoming telephone lines 16
local extension phones 16
modem 18
output to public address 21

Connecting incoming lines 16

D
Direct line access

configuring 57
Distinctive ring

fax machine 19

E
Extension ring groups

call cascade 95
call handling option 85
configuring 61
different uses 62
queuing callers to... 124

Extensions
numbering conventions 24

F
Fax machine

automatic detection 19
dedicated fax line 19
distinctive ring 19
troubleshooting 184

H
Hardware unit

back panel connectors 2
connecting fax machines 16
connecting telephones 16
connecting to a PC 5
front panel lights 2
seeting or changing unit id 23

Help and troubleshooting 181–187
auto attendant 182
call routing/transfer/

intercom 183
configuration 181
contacting TalkSwitch 187
fax machines 184
local area network 185
local extensions 184
music on hold 183

Holiday mode 79
Hunt group access

local extensions 58

I
Incoming lines

audio controls 107
call detail record 152
configuration 40
connecting 16
connecting devices/wiring 15
dedicated fax line 19, 50
diagnostics 27
front panel lights 2
keeping track of... 24
line hunt groups 42
modem access to... 134
rear panel jacks 4
troubleshooting 112
using phones connected in 

parallel 133
Intercom

troubleshooting 183
IP configuration 37
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L
Line hunt groups 42
Local area network 157

connecting 9
IP configuration 37
LAN connector 4
networking units 21
optimizing for VoIP 156
optimizing the system 25
router/NAT/firewall 156
special considerations 33
troubleshooting 185
unit IDs 23

Local extensions
activating/configuring 54
adjusting ringing sequence 88
call cascade 90
configuring a SIP extension 55
configuring for analog phone 54
configuring for SIP phone 55
connecting telephones 16
keeping track of... 24
troubleshooting 183, 184

M
Miscellaneous options 110
Modem

connecting 18
Modes 78

holidays 79
Music on hold 63

adjusting volume 66
external audio source 63
internal audio file 65
troubleshooting 183

N
Notification options

configuring 70

R
Remote extensions 58

call cascade 93
configuring 58
forwarding calls to... 60
transferring calls from... 60

T
Telephone company services 41
Telephone lines 40

configuring for modes 87
phone numbers 41

Telephones
multi-line phone 18
selecting phone type 56
single line phone 17
two line phone 17

Toll restriction 44
Transfer options 108

to a local or remote 
extension 108

to a ring group 108
transfer from a home phone 108

U
Uniform call distribution (UCD) 123
Unit ID 189

V
Voicemail 67

dialed notification 68
email notification 71
global settings 74
mailbox options 67
management 76
message waiting light 71

VoIP 155–179
admin form 180
broadband connection 156
configuration screen 162
FAQ 174–179
local area network 157
local IP address 160, 162
optimizing your network 156
public IP address 163
router/NAT/firewall 156
service provider profile 168
setting up a network 159
SIP server 160
TalkSwitch profile 164

VoIP numbers 89, 170
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